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FeatureCAM overview 

FeatureCAM is a CAD/CAM software suite that automates machining 
and minimizes programming times for parts on mills, lathes, and 
wire EDM. Unlike operations-based CAM systems, FeatureCAM 
generates toolpaths based on the features of the part, and 
automatically selects appropriate tools, determines roughing and 
finishing passes, and calculates feeds and speeds. The selections 
made can be based on the built-in machining knowledge that 
Delcam supplies 'out-of-the-box' with FeatureCAM, or from 
experience captured from your company, project or individual users' 
preferences. 

FeatureCAM includes five stand-alone modules: 
 2.5D Milling - 2.5D design and toolpath generation for 2- and 3-

axis mills.

 3D Milling - 3D surface modeling and 3-axis toolpath generation.

 3D Lite - a limited version of 3D milling.

3D Lite lets you mill only one surface per feature, but you 
can create multiple features. The strategies available in 3D 
Lite are Z-level rough, Parallel rough, Parallel finish, Isoline, 
and 2D spiral. 

 Turning - 2-axis design and toolpath generation for 2-axis lathes.

 Turn/Mill - Supports lathes with C and Y-axis milling capabilities.

 Wire EDM - 2- and 4-axis wire EDM toolpath creation.

The following add-on modules are also available: 

 RECOGNITION - 3D surface and solid import and the recognition
of 2.5D features from solid models. Accelerates making 2.5D and
turned parts from solid models.

 Tombstone - Multiple part manufacturing for horizontal or vertical
milling machines with indexers.
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 Solid Modeling - Solid modeling and tools for creating molds from
solid models.

 5-Axis Positioning - Manufacture 2.5D features from 5-axis
orientations.

 Native Import Modules - Native data can be read directly from
SolidWorks, SolidWorks Assemblies, Autodesk Inventor,
SolidEdge, Catia, NX, Pro-Engineer, and Step files.

 Machine Simulation - Modeling and simulation of a CNC machine.

 Advanced Turn/Mill (MTT) - Includes support for Turn/Mill in
addition to support for B-axis (5-axis positioning) and multiple
turret synchronization.

 Network Database and Licensing - Flexible product licensing allows
sharing FeatureCAM licenses across a network.

 5-Axis Simultaneous - Manufacture 3D features while changing
the tool axis.

Why creating toolpaths is so fast 
FeatureCAM has the unique ability to generate toolpaths and create 
NC code to run the machines with a minimum amount of user input. 

Traditional CAM systems are operations-based and require you to 
program every operation, one at a time, to create your part. 
FeatureCAM is feature-based; this means the part is created using 
features that describe that part, from simple holes, to complex 
pockets, to turned grooves. Machinable features contain information 
and rules describing how and where material removal should occur, 
cutting depths, whether to use climb cutting, whether to spot drill or 
center drill, and preferred machining strategies for roughing and 
finishing. This means that after you import or draw the part and 
identify its features, FeatureCAM automatically: 

 Selects the most appropriate tools and operations;

 Recommends machining strategies;

 Calculates speeds and feeds;

 Generates toolpaths and creates the NC code.

  You can customize this built-in 'intelligence' to your own style 
of cutting. 
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Introduction to FeatureCAM 
Introduction 
This module will familiarize you with Delcam FeatureCAM’s history, describe what 
FeatureCAM is and show how it is advantageous over other CAM systems. 

Increased shop productivity is the primary goal of all FeatureCAM products.  Traditional 
CAM systems are operations based and require you to program every operation, one at a 
time, to create your part. All the manufacturing details are left to the machinist. That means 
that you must specify the details for every spot drill, drill, ream and roughing pass of your 
part.  

With FeatureCAM you generate your part using features such as a tapped hole, a boss, or a 
turned groove and the operations are automatically created. FeatureCAM also manages the 
details of the manufacturing process such as tool selection, speed and feed rates, and 
toolpaths. To modify any element of the part program, just change a few settings on a feature 
and a whole new set of operations are generated to reflect your changes.  

Ease of use is another guiding principal of FeatureCAM products. Our system was originally 
developed as a graphical Windows-based program. As a result it does not suffer from an 
outdated DOS look. FeatureCAM programs are full of graphical feedback, step-by-step 
wizards and tutorial-style animations that run directly in the program dialog boxes. Ease of 
use has always been a FeatureCAM advantage and we continue to study ways to make our 
system even easier to learn and use.  

The Image above shows a part that may be quickly programmed in FeatureCAM 
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What is a Feature? 
 
If we look at a part such as that shown on the previous page and consider how we would 
manufacture it we can see that it can be broken down into a series of machining operations. 
For example we would probably want to start by facing off top of the part, then machine 
around the two raised areas down to the next flat level. Outside area of the part would need to 
be roughed out and then the side of the part finished. There are then a series of pockets which 
would need to be rough and finish machined and finally we would drill the holes and add 
chamfers to the part. Each of these areas of the part, Face, Side, Pocket, Hole, Chamfer and 
so on is a Feature of the part.  
 
FeatureCAM defines a part in terms of Features using common shop terms so for instance 
and area that looks like a pocket can be machined using a Pocket Feature. When you define 
an area as a Pocket, FeatureCAM will then automatically decide what operations to use to 
machine that area. All you have to do is say “This is a Pocket” and FeatureCAM will select 
suitable roughing and finishing operations, tooling, speeds and feeds. You are then free to 
modify these default values to suit your particular situation. By automating the generation of 
operations the overall time taken to program a part can be drastically reduced. 
 

 
 
 
The image above shows some of the features of the part. There are many more feature types 
that can be created, the illustration is just to give you an idea of how the part can be broken 
down into its component features for manufacturing purposes. 
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How are Features Created? 
 
There are a number of different ways in which features can be created in FeatureCAM, which 
method you choose will depend upon the data available to you. In broad terms the methods 
are: 
 
From Dimensions 
If you are working from a print then often the quickest way of creating features is to pull the 
dimensions from the print and enter them directly into FeatureCAM. For example you can 
create a rectangular pocket by entering its length, width, depth and location. Additional 
attributes for the feature can also be added such as a draft angle, fillet radius or chamfer. 
 

 
 
From Curves 
If you have a print or a 2D drawing of a part in electronic format you can create curves for 
more irregularly shaped parts and then create the feature from the curve. 
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Automatic Feature Recognition (AFR) 
If you are working from a solid model then FeatureCAM has the capability to analyze the 
part and identify features automatically. Basically you say, “Here is the part, go and program 
it”. FeatureCAM then looks for Pockets, Bosses, Sides, Holes and so on and prepares the 
necessary machining operations, selects the tools and feeds & speeds. This can work very 
well on simple parts but on more complex parts it may require some manual tweaking to get 
the optimal toolpaths. 
 
Interactive Feature Recognition (IFR) 
This also works off a solid model in a similar manner to AFR. The difference is that you tell 
FeatureCAM what type of feature it is that you are looking for, for example “Look only for 
Side features” or “Look for holes with a diameter of less than 0.75in”. This takes a little 
longer than AFR but gives you greater control over how the features are created and often 
results in  a shorter cycle time for machining. 
 

CAM Software Strategies 
There are three main different types of  CAM software strategies for creating toolpaths in 
today’s modern CAM software.  These strategies are Operation based, Processed based and 
Feature Based.  Some of these strategies use Knowledge Based Machining (KBM).  KBM 
is when machining intelligence is built right into the CAM software. KBM is used at various 
levels and degrees in different CAM systems. 
 
Operations-based CAM systems require the user to go through multiple steps to machine 
each part. The user must select which type of operation to use, select the machining boundary 
and the type of toolpath, then manually select tools, feeds and speeds and multiple machining 
options such as stepover distance and the incremental step in Z. These multiple steps must be 
repeated one at a time for every operation on a part, making it a time-consuming process that 
is prone to error. These systems offer little to no KBM. 
Process-based CAM systems attempt to reduce these steps by grouping operations in standard 
processes. KBM is used as the program remembers the used processes and repeats them for 
future operations. However, this method only works when a shop uses the same processes 
over and over for the same types of parts.  
When a process is applied to different types of parts, or parts made of different materials, the 
CNC programmer must still verify that the correct operations were used and that the correct 
tools, stepovers and speeds and feeds were selected because a static machining process does 
not automatically adapt to every part. 
Feature-based CAM systems use a set of interrelated machinable features to describe a 
complete part. The beauty of features is that they not only describe shape, but these also are 
made up of one or more associative operations that describe the preferred method for cutting 
that shape at the NC machine. A predefined set of machining rules and user preferences are 
applied to a part. KBM in these systems streamlines the manufacturing process by building 
the highest level of machining intelligence right into the CAM system. Machinable features 
contain information and rules describing how and where material removal should occur, 
cutting depths, whether to use climb cutting, whether to spot drill or center drill and preferred 
machining strategies for roughing and finishing. The CAM system evaluates the part 
geometry and part material, selects the most appropriate tools and operations, recommends 
machining strategies, calculates feeds and speeds, then automatically generates the NC code. 



FeatureMILL2.5D                                    Introduction to FeatureCAM 

                                                                          
Issue FeatureMILL2.5D 2012                                               5 

Below is a chart showing a comparison of the three different CAM strategies: 
 
Feature Based CAM Operations-Based CAM Process-Based CAM 

1.  Draw or Import Your Part 
2.  Identify Features 
3.  Click Simulation 
 
        You Are Done! 
 
FeatureCAM Automatically: 
 

• Determines Rough and 
Finish Operations 
 

• Selects ALL Tools Sizes 
 

• Calculates Feeds & 
Speeds 
 

• Determines Stepover & 
Z Increments 
 

• Generates Toolpath 
 

• Creates NC Code 

1. Import or draw part. 
2. Select a rough operation. 
3. Select rough boundary. 
4. Select type of toolpath. 
5. Select roughing tool. 
6. Select feeds and speeds. 
7. Select stepover and Z 
steps. 
8. Select a finish operation. 
9. Select finish boundary. 
10. Select type of toolpath. 
11. Select a finishing tool. 
12. Select stepover and Z 
steps. 
13. Select feeds and speeds. 
14. Click simulation. 
15. Create NC code. 

1. Import or draw part. 
2. Identify features. 
3. Select machining processes. 
4. Click simulation. 
5. Create NC code. 
 
???Are You Done? No. 
 
You must analyze and verify:  

• Does the process have 
the correct operations?  

• Does the process use the 
correct size tools?  

• Are the correct feeds and 
speeds used?  

• Does the process have 
the correct stepover and 
Z increments? 

 
Feature-based machining has many advantages such as:  
 Dramatically shorter part programming time. 
 Part revisions do not require reprogramming. 
 NC code is consistent and predictable regardless of the CNC programmer. 
 Tools are optimized and tool changes reduced. 
 Toolpath is automatically optimized for faster machining. 

 
FeatureCAM is a Feature Based programming system with advantages  listed above.  
Additionally FeatureCAM is very easy to use.  A programmer new to FeatureCAM or new to 
programming can quickly learn the product and create G-code with the appropriate tools, 
feeds and speeds. 
 
Below is a list of  key points that makes FC very easy to use. 
 

• User Friendly Interface (Steps & Wizards) 
• Automatic Tool Selection (2D & 3D) 
• Automatic FeatureRECOGNITION 
• Standard Databases (Tools, Materials, Feeds & Speeds) 
• Customizable Post Processors 
• Outstanding Technical Support 
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Built in intelligence 
 
A major advantage of FeatureCAM is users' ability to define their own set of machining 
preferences.  FeatureCAM comes with predefined machining rules programmed into the 
CAM system which are based on a standard set of material properties and standard toolcribs. 
You can then customize these settings for specific materials that you use and the tooling that 
you actually have available in your shop. Once you have these defined, you simply select a 
material for your workpiece and the toolcrib you want to work with and FeatureCAM will 
then make selections of tooling for a feature automatically. If you change the toolcrib or the 
material then FeatureCAM automatically updates all of the toolpaths in the part. This means 
that a part may be programmed for one machine with the tools available there and then 
shifted to another machine simply by changing the toolcrib. Similarly if you wish to cut a test 
part in Aluminum and then cut the final part in Stainless Steel you program the part with 
Aluminum set as the material. Once you have cut the test piece you change the material to be 
Stainless Steel and FeatureCAM will update the toolpaths by changing feeds, speeds, depth 
of cut, stepovers etc. without any further intervention from the operator. 
 
By providing a set of standard machining rules already in place, it's easier for you to 
customize the software to reflect the machining preferences of your shop. 
 
Setting up your own machining preferences and rules in FeatureCAM not only reduces the 
time it takes to generate programs, but it also streamlines production because the approach to 
machining every part is predictable and consistent. Machine operators can rely on the fact 
that each job will be machined in a predictable manner regardless of who did the 
programming. 
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Beginning FeatureCAM 

Introduction 
 
This module will provide the user with an understanding of the basic user interface and 
different stock types.  At the end of the module the user will be able to generate a program for 
a simple part. 
 

 

 

 

User Interface 
 
The user Interface is the entire viewing area of FeatureCAM and is designed to be intuitive, 
easy to use and provides the many functions to assist you in creating programs accurately and 
in the fastest possible time. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Menu Bar    Located at the top.  Like many 
other Windows based software, 
FeatureCAM includes a series of drop down menus.  
These menus are unique to FeatureCAM and 
provide one or more functions used to facilitate the 
constructing, manufacturing, viewing and 
editing of your part program.   

Part View 

   Menus 

    Steps 

Tool Bars 

  Results 

Graphics Window 

Geometry Bar Status Bar 
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Tool Bars   Located in View and Toolbars.  
Tool Bars are usually located at the top but 
may be docked in other locations.  Can consist 
of one or more buttons and are used to create 
objects in the Graphics Window, such 
as the Geometry constructors for 
drawing the shape of your part.   
 
Steps   Located on the left side.  A systematic 
sequence to guide, especially the beginner, as to 
the order of which needs to be completed first, 
second, etc. 
 
 
Part View    Located behind the Steps.  This area 
gives a listing and provides access to the properties of 
the stock, setups, features, turrets, curves, (surfaces and solids 
when available).   
 
Browser     Located on left side “Toolbox” below Steps.  
Your computer must be connected to the internet and the 
Browser provides a direct link to the internet.  Learn about 
the Browser by participating in the various sections with 
downloadable examples on the opening page then Click on 
the links and explore the contents.  

 
Results   Located on the right side.  It contains the 
Operation list.  Whereas the Part View contains all of 
the features, the Operation List contains all of the hits.  
It also provides the details of each operation, including 
a tool list.   The NC code is also here.  All of the 
information residing in this area may be printed.   
 
 
 
 
Graphics Window   Located in the center.  
This is where most of the activity is takes 
place. These activities include: creating stock, 
importing drawings, solid and surface models, 
constructing geometry, chaining with curves, 
creating features, and simulating the tool path 
in 3D or center line of the tool. 
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Geometry Bar   Located near the 
bottom.  This area is constantly 
used and is where the dimension 
boxes are used to locate the 
geometry on your stock material 
in the Graphics Window. 
 
Status Bar   Located at the very 
bottom of FeatureCAM.  It 
displays the plane you are 
working in (XY–XZ-YZ), the 
unit of measure (inch-metric), the 
layer you are working in, the active setup, post processor, the 
tool crib, and how many CPU cores are being utilized.  
 

o The basic interface has three different sections.  On the 
left is the Steps toolbar.  

o The steps toolbar is an outline for the flow of the 
program.  The steps are numbered sequentially in the 
order they should be executed and can be a guide for 
creating your part.   

o For example suppose you have a 2D drawing on your 
desk and would like to create a solid model and a CAM 
program for it.  To do this we would follow the steps 
sequentially:  

1. Specify type of stock and stock dimensions,  
2. Draw Geometry 
3.  Create Curves from Geometry  
4. Create Surfaces (ignored since creating a solid model)  
5. Create Solid from Curves.   
6. Or 7. to create Features  
8. To view toolpaths and  
9. To generate NC Code 

 
o You can access a majority of FeatureCAM’s functions 

through these buttons.  A summary of each steps function follows. 
 
Note: We recommend that if you are just starting out with the program or demonstrating it to 
others that you use the steps toolbox instead of toolbar buttons in other areas of the interface 
to keep the interface simple.  
 
Step 1 - Stock.   The Stock Wizard steps you through entering the shape and dimensions of 
the stock, the stock material, part program zero and the coordinate system for modeling.   
 
Step 2 – Geometry.  Points, arcs, lines and other shapes are used to describe the overall 
shape of parts.  Many different geometry tools are available.  Geometry can also be imported 
from CAD systems. 
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Step 3 – Curves.   Shapes that involve more than a single line or arc are described as curves  
 
Step 4 – Surfaces, opens the surface wizard 
 
Step 5 – Solids, opens the solid wizard 
 
Step 6 – AFR (Automatic Feature Recognition) 
 
Step7 – Features.   Features are common shop terms like pocket, or thread.  They are created 
from curves and dimensions.  These objects describe your part in 3D and are used to generate 
toolpaths.   
 
Step 8 – Toolpaths.  Toolpaths are generated from collections of features.  You can simulate 
them in FeatureCAM using toolpath center lines, 2D shaded or 3D solid shaded simulations.   
 
Step 9 – NC Code.  Machine-specific G-codes are generated from the toolpaths.  Translators 
are provided for many different NC controls and include a program for creating new 
translators.   
 
Customize Manufacturing. FeatureCAM automates the entire part programming process; 
you can customize all of the system settings including feed/speed tables (Stock Properties), 
tooling databases (Tool Manager) or feature settings (Machining Configurations in another 
Module) 

 
Note: In Steps, some steps may not be displayed depending on 
which options you have purchased or have turned on. 
 

o Above the Steps Toolbar is the Part View Tool Box.  This 
contains the names of the objects that are created on the 
screen. Objects that can be contained in this area are stock, 
setups, curves, surfaces, solids and stl. 

o Clicking on the objects in the part view enable different 
functions.  Left-click selects the object in the graphics 
window.  Right-click reveals menu of options available for 
the object. Clicking on a “+” to expand the view will 
reveal objects that are subordinate. 

 
 
 
 
 
 
 
 
 

On the right is the Manufacturing 
Results Window.  The automatically 
generated documentation and part 
programs are shown in this window.   
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Your First part exercise 
 
• From the New Part Document Wizard 

select Milling, then select Inches as 
unit of measure then press the 
Finish button. 

 
Notice the different types of documents 
available.  The different types of documents 
available; depends on the modules that you own 
and are licensed for. 
 

 
 
 
 
 
 
 
• In the stock dimensions dialogue 

Enter 4” for the Width, 4” for the 
Length and 1” for the Thickness then 
press the Finish then OK.  

 
 
 

 
. 
 
 
 
 
 

 
 

 
• From the steps view on the left 

hand side of the screen click the 
Features button. 

• Select Hole and press Next. 
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• In the New Feature Dimensions 
window Enter the hole dimension as 
0.5” in Diameter, 1.0” in Depth, then 
check the Through checkbox and 
press Next. 

 
 
 
 

 
 

 
 
 
• For the X location Enter 3”, the Y 

location enter 3” and the Z location 
enter 0. Press Finish then OK. 

 
 
 
 
 
 
 

 
 
 
 
 
 

 
• From the steps view on the left 

hand side of the screen Click the 
Features button. 

• Select Rectangular Pocket.   
Next. 
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• On the Dimensions tab Enter 2.0” 

for the Width, 2.0” for the Height 
and 0.5” for the Depth then press 
Next 

 
 
 
 
 
 
 

 
. 

 
 
 
 
• On the Location Tab Enter 0.5” for 

the X location, 0.5” for the Y 
location then press Finish and 
OK. 

 
 
 
 
 
 
 
 
• Right-click in the Graphics window then press isometric. 
• From the steps menu Click on the Toolpaths.  Simulation bar flies out, 

unless already out. 
• Using the Simulation Bar; Read the purpose of and Execute each button. 

 
 
 
 
 
 
 
 
 
  

 

 

 

 

3D 

  3D 
Rapid 

Mach Sim 

Stop 

Play 

To End 

Single 

Next 

Clear 

Region 
    of 
Interest 

Load 

Speed Centerline 2D 

Eject 
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o Show centerline: A line drawn of the center of the tip of the tool is displayed. 
o  2D simulation: A two-dimensional simulation showing the regions cut by each 

operation is displayed. The view is changed to the top view automatically. 
o 3D solid simulation: A 3D solid simulation is displayed where the tool is animated 

through all of its moves.  
o Rapid Cut simulation: In this mode a 3D simulation is performed but the tool is not 

animated. Only the final result is displayed. For most parts, the simulation takes only 
a few seconds to complete. Note this type of simulation is only available in 
FeatureMILL3D. 

o Machine Simulation: A 3D solid simulation is displayed where the tool is animated 
through all of its moves along with the machine tool 

o Eject removes the Simulation toolbar from the screen and erases the simulation from 
the graphics window.  

o Stop cancels a simulation.  
o Play starts the selected simulation (Centerline, 2D, 3D or Rapid Cut), or restarts a 

paused simulation.  
o Pause pauses the simulation. The Play button transforms into the play button after it 

is pressed. If the Pause button is pressed during a simulation, it pauses the graphics.  
o Single step moves the simulation ahead one tool move. The keyboard accelerator for 

this button is ALT+F3.  
o Next operation continues to simulate until the next operation. This button is actually a 

fly-out menu. By clicking on the triangle to the right of the button the following 
additional options are revealed 

:  

 

 

 

 

o Next rapid simulates until the next rapid tool move.  

o Next tool change simulates until the next tool change.  

o Next Z level will simulate the next Z of a Z level toolpath. For other toolpaths it will 
play the entire next operation 

o Clear erases any centerline toolpaths on the screen.  

o Region of interest limits the portion of the part that is simulated.  

o Show tool load indicates whether or not to display a graph of the tool load when the 
next 3D Simulation is performed. 

o To adjust the speed of a centerline, 2D or 3D simulation, use the slider on the right-
hand side of the controls. Slide to the right to speed up, and move to the left to slow 
the simulation down. The slider of the simulation toolbar also affects the display for 
Rapid Cut simulation. If the slider is all the way to the right, only the final simulation 
result is displayed. Position the slider bar further to the left to see slower Rapid 
results.  

mk:@MSITStore:C:%5CProgram%20Files%5CFeatureCAM14.3.0.21%5CProgram%5CEZFM.chm::/SIMULATE/Fly_out_toolbars_1.htm
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• Click the show centerline from the simulation toolbar.   
•  Adjust the simulation slider button to the minimal setting by Left-clicking 

and Dragging then click the Play. 
 
 
A centerline display of the 
toolpath is shown where the line 
displayed represents the center of 
the bottom of the tools movement.  
Green lines represent rapid 
movement where black lines show 
feed moves.   Press the Eject. 
 
 
 

 
 

 
 
 
 
 
 
 
 
• Click 3D Simulation and Play. 
 
 
 
 
 
 
• In conjunction with 3D, Click on 

Options and Simulation from the 
menu bar. Check show holder 
displayed on the General Tab and on 
the 2D/3D Shaded Tab Check the 
Pause on gouge and Show pause on 
gouge dialog. Click OK. 
 

This will not only show the holder for the milling 
tool, but reveal any tool striking the stock in rapid 
traverse, or if the holder touches any part of the 
stock. These gouges will show as pink in color, the 
simulation will stop, and a pop up will appear 
telling of a possible gouge. 
   



FeatureMILL 2.5D                                                                                 Beginning FeatureCAM
                         

10 FeatureMILL 2.5D 2012  

 
 
• In the Manufacturing results window on the right hand side of the screen 

Click on the Op. List tab at the bottom of Result Window. 
 
 
 

 
Op List shows each operation listed in 
the order they are to be machined, 
feature name, tool used, Feed and 
Speed data.  Properties may be 
accessed here also (double click on 
each operation). 

 
 
 

 
• Click on the Details tab.  
 

 
You will see an operation summary 
showing the Part name, Setup name, Date, 
Stock Dimensions and Stock Material 
followed by the summary of each 
operation.  This shows the feature name, 
operation name, F/S, Tool used, power, 
stepover and depth of cut.  The Tool List 
button at top provides a list, in detail, all 
tools being used and where they are placed 
on the tool changer. 
 
 
 

 
• Click on the NC code tab. 
  
 
 
NC code is generated during simulation 
and the output is in accordance with the 
post processor for the machine that is 
going to be used to run your part.  The 
Part Program number on the O line and 
the G54, line N50 are automatically 
entered in the code. 
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• Click on File then Save NC. Click the 

radio button save to other directory, 
then Type in “C:\”.  This will save the NC 
code to the C drive.  In the selection 
window Uncheck all check boxes and 
only check NC Program.  Then Press 
OK.  The check boxes will create a text 
document that can be printed. 

 
Now that the NC code is saved it can be downloaded 
to the machine and the part with the simple pocket 
and hole can be machined. 

• Close this document and Save it if you 
want to keep it. 

 
 
 

Stock Types 
Inside of FeatureCAM milling document there are several different stock types.  The stock 
can be defined as a block, round, stock curve or user defined. 

Stock Exercise 
 

• Open a New Milling Document in 
inch.    Finish. 
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The stock wizard dialogue will appear.  By default block will be selected.  You can enter the 
rectangular dimensions of the stock here. 
 
 
 
 
 
 
 
 

 
 
• Click on the Round radio button. 

 
 
 
 
The ID, OD and length of the round stock 
may defined.  Additionally the axis of the 
stock may be defined as needed for 4 axis.. 
 
 
 

 
 
• Click on the N-Sided Radio button. 
When this button is pressed the stock can be 
defined along a specific axis with a multiple 
number of sides such as hex. 
 
 
 
• Enter the stock dimensions as 

shown to the right and press Next. 
 
 
 
 
 
 
 
 
A Hexagonal outline of the stock will 
appear in the display window.  The Axis 
may also be selected like the round stock. 
 
• Press Next. 
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On this page of the stock wizard you 
can select the Material, Unit 
Horsepower, Hardness and Hardness 
Units.  You can also access the existing 
Feed and Speed tables for the material 
or create a new Material 

 
 

 
 
 
 

 
 
 
 
 
 
• From the pull-down 

menu select Aluminum 
then press Next. 
 

 
 

 
 
 
 
 
 
 
 
 
The multi-axis positioning options 
appear. 
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• Press No to Multi-axis 

positioning and press Finish. Do 
not press OK at this time. 

 
• Right Click in the Graphics 

window, off the part, and Select 
an isometric view.  The stock is 
hex shape and FeatureCAM 
simulates that shape in 3D 
simulation and also uses it as the 
stock boundary when 

determining where cuts start. Right Click in the Graphics window and 
select a Top view. Click OK. 

 
 

The Fourth way to create a Stock shape is by 
drawing the shape using geometry and then 
chaining a curve, it is called a Stock Curve.  
(Creating shapes using geometry and curves 
will be covered in a later module and you may 
wait until you finish with them and then return 
to this step and create the Stock Curve although 
the following steps are easy). 
 
Note:  The Stock Curve must lie in the XY Plane. 
In the Top View, this is the XY Plane when the 
UCS (Part Program 0) is in this position (Lower 
Left)  
 
• Click on Stock in the Steps on the left 

side of FeatureCAM. Select Block and enter in the Width as 6.0, Length 
6.0, and Thickness 6.0. Click Finish and OK. Center the stock by holding 
CTRL and L keys simultaneously. 
 

• Draw by Clicking on Geometry from the Steps and from the Geometry 
Constructors use Line/Connected Lines and Draw freehand a shape 
similar to the one above.  Be sure the geometry is connected. 
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• Click on Curves from Steps 

and Click on Closed Curve 
(red check). 

 
 
 
 
 
 

Chain a closed curve on the Geometry by 
Clicking once on any line then Click on the 
Create button at the bottom of the screen. 
The curve (blue) will close all the way around the 
closed Geometry.  The Curve must be closed and in 
the XY Plane. 

o XY Plane is Top View. 
o XZ Plane is Front View. 
o YZ Plane is Left View. 

This Curve now becomes the NEW shape of the Stock 
and is used for Stock Boundary and 3D simulation 
stock solid. 
 
Click on Stock in the Steps and then Finish. 
 
• On the Dimension Tab, of the Stock 

Properties dialog, Click on the Stock Curve button and from this list Check 
the box in front of the curve just created.  OK and Apply, then OK. The 
Stock now changes its shape.  
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User interface exercise 

 
 
 
 
 
 
 
 
 

 
 
 
In this exercise you will become more familiar with the FeatureCAM user interface. 

 
• From the Beginning FeatureCAM Data folder, or the FeatureCAM 2.5D 

Data folder. Double Click on the file Caliper.fm. 
• Click on the Part View on the left hand side of the screen. 
 
 

Observe all the different objects the part 
contains under the part view.  At the top level 
of the part view is the part name.  In the level 
directly below the part name you have stock, 
setup1, setup2, curves, surfaces, and solids. 
 
 

 
 

• Double-click on 
stock in the part view 
for the Stock 
Properties showing 
Length, Width 
Thickness and an 
offset in Z for facing 
stock.    OK. 
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•  From the Part View menu 

Double-click on top. 
 

 
The setups dialogue is displayed.  From 
here an existing setup may be modified or a 
new setup may be created. 
 
• Click on Edit 
Observe that the current setup location is 
highlighted in Red in the graphics window.  The setup location is on the upper left hand 
corner of the stock. The setup, fixture name and part name can be edited from this window. 
 

 
 
 
 
 
 
 
• Enter Fixture ID of 54 then press 
Next. 
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The part program zero window is displayed.  In this window we have the ability to change the 
setup location or the part program zero.  This is where fixture ID 54 is and where the machine 
tool fixture offset 54 zero is. 
 
 
 
 

 
 
 
 
 

• Select the Align to Stock Face 
and press Next. 
 

 
 
 
 

 
A page appears that will enable you to change the setup location.  Currently the setup is 
located in the upper left hand corner. 

 
 
 
 
• Change the setup to the upper right; 

Press the Hand next to UR. 
 
 
 
 
You should see in red in the upper left hand corner 
the previous location of the setup, and highlighted 
in blue is the new location of the setup. 
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• Click Finish. 
 
 

• Select to Keep Features 
in the same location. 
OK and Close. 
 
 
 
 
 
 

• In Part View Click the + 
Plus Sign next to top to expand and reveal all of the Features for Setup1. 
 

Notice how the features in setup1 have been displayed, in the order they were created. 
 
• Double-click on fc1 from the part view or Right Click on feature for 
Properties. 
 

 
 
The feature properties 
from setup1 are 
displayed.  From here 
the face properties 
may be changed.  All 
the feature properties 
may be accessed from 
the part view by 
simply double 
clicking on them.  
 
• Click OK. 
 
 

 
 
 

 
 
Cut, Copy and Paste are Windows functions that are available in FeatureCAM.  There are 
two Setups on this Part and Setup2 needs to be faced off.  You already have a face feature in 
Setup1 so you will copy it from Setup1 and paste it in Setup2. 
 
• In the Part View, Right Click on the Face feature in Setup1 and Click 

Copy.  
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• Click on Setup2 to select which Setup you wish to place it in.  Right Click 
on the same Face feature you copied from and Click Paste.  This adds the 
Face feature to Setup2. 

 
 
 
Now both sides have a Face feature by simply copying and pasting.  You can even copy from 
one Document and Paste into another Document. 
 
 
 
• In Part View Click Setup1 then Right Click in Graphics Window and Click 

Isometric View. 
• In Steps Select Toolpaths and the Simulation toolbar flies out. (unless it is 

already visible)  It may be dragged to several docking areas of your 
choosing. 

• On the Simulation Bar, Click 3D simulation and Click Play. (Setup1) 
• Do NOT cancel 3D Simulation.  Now in Part View Click on Setup2 then 

Right Click in Graphics Window and Click Isometric View and Run the 3D 
Simulation again. (Setup2) 

                          Setup1                                                                                Setup2 

 
 

o When you run the Simulation, the NC G-Code that will go to the machine is 
generated.                                                           

 
o The Post Processor is what determines what the code contains and it must correspond 

to the machine control that it will be loaded into. 
 

o There are many Post Processors that come with FeatureCAM and the correct Post 
must be selected before running the simulation to obtain the proper code.  Post 
processors for Milling are located in C:\Program Files\FeatureCAM\ 
Posts\Mill. 
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• Click on Manufacturing then Post 

Process to open the Post Options 
window. 

 
 
 
 
 
 

 
 
 
• Click on Browse and 

enter the previous path 
given to search for and 
Select your Post.   Open 
and OK.   

 
 
 
• Simulate either 3D or 

Centerline Simulation 
again. 

 
 
 
 

 
 
• From Results Click the NC Code 

tab. 
 
 
 
This is what will be sent to the 
machine control.  It is a text file and 
may be edited but the goal is not to 
edit the Code but to correct the 
Post so as to eliminate any editing. 
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There might be a slight delay to receive the NC Code 
in the results window.  This is because the NC is 
generated once the NC Code tab is pressed. 
 
 
 
 
• From the file menu click on Save NC. 

 
 

• Save the code to the C:\ drive by 
choosing “Save to other directory”. Check 
NC Program only in the selection window 
then press OK.  

 
o If additional boxes are checked a text file will be generated for each that may be 

printed and sent to the shop to facilitate setup.  Check them only as needed because a 
file is saved on your computer every time you save NC if you have boxes checked 
even if you do not need them. 

o Now you can take the Caliper.txt NC code file from the C:\ drive and transfer it to the 
machine to cut setup1 for the part.  The Caliper.txt NC file contains G code for setup1 
only.   

 
 
In the Stock Properties and the Indexing tab, if you check the box “Generate Single Program 
with program stop between setups” then the NC Code will include both setups with a stop 
between setups.  This is so you can run Setup1 then the machine will stop to flip the part then 

you push the machine 
start button again to run 
Setup2.  
 
 
 
 
To open the Stock 
Properties window, 
double click on stock1 in 
the part view window on 
the left side of 
FeatureCAM.  
 
The Part is Complete. 
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Snapping and Geometry 
Introduction 
 
This module will provide an understanding of how different snapping modes work and how 
Geometry is created within FeatureCAM. By the end of the module the user will be able to 
construct geometry and understand how each snapping mode functions. 

User Interface 
 
Geometry constructor commands can be accessed in three different areas of the user 
interface.   
 
• Commands can be accessed by clicking the Geometry icon in the Steps 

view:  
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
• Can be accessed through the File Menu by 

clicking on Construct  
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• Or may be 

accessed by the 
geometry toolbar 
(to show the 
geometry toolbar 
from the File Menu 
click on View then 
Toolbars then 
check the Geometry checkbox and press OK) 
 
 

The geometry toolbar uses flyout menus.  The last item previously selected is displayed as an 
icon in the tool bar.   
 
• Click on the triangle  to reveal the flyout menu.   
 
These flyout menus are used throughout FeatureCAM and are useful for easy access to many 
program functions. 
 

 
 

 
Snapping mode commands can 
be accessed in two different 
areas of the user interface.   
 
• Snapping mode 

commands can be 
accessed through the 
file menu by clicking on 
options then snapping 
modes 
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• Snapping modes may also be accessed through the snapping toolbar(to 
show the snapping toolbar, from the file menu click on view then toolbars 
then check the snap mode checkbox and press OK). 

 
 
 

Snapping 
 
• Open FeatureCAM by double-clicking the FeatureCAM shortcut icon on 

the desktop:  
• Click on Open an existing file in the New Part Document wizard window 

then press Next. 
• Browse to the examples folder and click on “Snapping.fm” then press 

open 
 

The part when open should look similar to the image below: 

 
 
 
• Make sure the snapping toolbar 

is shown. To show this menu 
from the File Menu click on 
View then Toolbars then check 
the Snap Mode checkbox.  
Also make sure Standard and 
Geometry are also checked 
then press OK. 
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The snapping toolbar will appear: 
 

 
 
Looking at each icon from left to right we will give a short summary of each item’s function: 
 

Snap to grid causes the cursor to snap to predefined increments defined under 
Options and Snapping Grids 
 

Snap to Point snaps to a point object 
 

Snap to Endpoint snaps to the ends of finite lines and arcs. Endpoint also applies 
to the corners of the stock and vertices of a solid 
 

Snap to Midpoint snaps to the middle points of finite lines and arcs. 
 

Snap to Section snaps equal intervals of a finite line.  The number of sections is 
controlled by the Sections parameter of the Snapping Grids dialog box.   
 

Snap to Intersection snaps to the intersection of lines, arcs and circles.   
 

Snap to Center snaps to arc and circle centers.  This setting also controls the 
display of circle and arc center points.   
 

Snap to Quadrant snaps to the four points on a circle corresponding to 0°, 90°, 
180° and 270°.   
 

Snap to Object snaps to a point on another object.  This includes lines of surfaces 
and is convenient for snapping points to locations on a surface.   
 

Snap to Tangent snaps the point so that the object you are creating will be tangent 
to the object you snapped to.   
 

Snap to Toolpath will snap to toolpath lines 
 

The Snap Discrimination dialog button displays the Snap Discrimination dialog 
box whenever there is an ambiguous pick. This dialog box will list the possible points 
to snap to and ask you to pick the one you want. 
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Snapping Exercise 
 
The exercise below will review each of the snapping modes on the snapping toolbar from left 
to right.  When complete it will provide a basic overview of each snapping modes function. 
 
• Make sure none of the snapping buttons are depressed  

 

 
 

• Right-click on the Orange circle and 
press Center Selected  
 

 
 
 
 
 
 
  
• Click on the connected line constructor button from the geometry toolbar 

  

 
 

• Draw a square in the center of the circle by clicking once in the upper left, 
then upper right, then lower right, then lower left then upper left. 
 
 

If your hand does not move perfectly it will be 
impossible to do this.  We have a tool that can help 
snap to a Cartesian grid 
 
 
 

• Press Undo  until the line segments 
disappear. This button is at the top of 
FeatureCAM. 
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• Make sure none of the snapping buttons are depressed then press the 
Snap to Grid button 

 
 
You should then notice a faint grid appears 

 
 
 
• Draw a square in the center of the circle by clicking once in the upper left, 

then upper right, then lower right, then lower left then upper left. 
 

 
 

     Click on the Select icon  at the top of FeatureCAM on the Standard 
Toolbar to cancel the line drawing. Use this button at any time to exit 
selection mode. 

 
You should notice that the square created was much easier to create.  This is because the 
cursor snaps to a predefined grid designated under the File Menu under options then 
snapping options.  Snap to grid overrides all other snapping options so it is suggested to 
leave this option off if you need to use any of the other snapping modes. 
 
• Uncheck the snapping grid and check snap to point on the snapping 

toolbar. Select connected line from the geometry toolbar again. 
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• Move the mouse cursor around the screen and try to get it to snap to an 

object on the screen 
 

 
 

Notice that the only object we can get this to snap to is a point.  The only object snap to point 
will snap to is a point. There is a point inside the square you just created, snap to it. 
 
• Uncheck Snap to Point and check snap to endpoint. 

 
 

 
• Locate the teal horizontal line segment located in the upper left hand of the 

screen. If you are still zoomed in, right click your mouse in the graphics 
window, off the part, and select Center All. Select connected line again 
from the Geometry toolbar. 
 

 
• Move the mouse cursor from the left to the right over the line. 

  
 

Observe that only the line segment endpoints are snapped to.  Snap to Endpoint snaps to the 
ends of finite lines and arcs. Endpoint also applies to the corners of the stock and vertices of a 
solid. 
 
• Uncheck Snap to Endpoint and check Snap to Midpoint.  Again position 

the mouse cursor over the teal horizontal line segment.  Hover the mouse 
cursor over the center of the line segment. 
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The cursor should snap to the center of the line segment. 
 
 

• Locate the black arc below the teal horizontal line segment 
 

 
 

• Snap to the center of the line segment 
 

 
 
Snap to Midpoint snaps to the middle points of finite lines and arcs. 
 
• Click on options then snapping grids then change Section to 8. 

 
 
 

• Uncheck snap to midpoint 
then check snap to 
segment 
 

 
 

• Hover the mouse cursor over the teal line segment and move mouse 
cursor slowly from left to right. 
 

 
 

Notice how the line segment snaps to 8 different sections. 
 
• Uncheck snap to segment then check snap to intersection 
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• Locate the violet horizontal and vertical line segments towards the lower 
right hand part of the stock hover the mouse cursor over the intersection. 
 

   
 
Notice it snaps to the intersection of the lines.  This snap mode works for the intersections of 
arcs, lines and circles. 
 
• Uncheck the snap to intersection button and make sure no snap modes 

are enabled.  Observe the center of the large circle on the left hand side of 
the part.  Then toggle the snap to center button then re-examine the 
center of the large circle.   

 
 

What you should notice is that a cross-hair appears at the center of the circle.  This is the snap 
point for the center of the circle 
 

      
 
• Hover the mouse cursor over the cross-hair and notice the cursor snaps to 

that location 
 

 
 

Snap to center snaps to arc and circle centers.  This setting also controls the display of circle 
and arc center points. 
 
• Uncheck snap to center then check snap to quadrant 
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• Locate the large circle and move the mouse cursor around the perimeter of 
the circle.  
 

 
 

The circle will snap in four places.  Snap to quadrant snaps to the four points on a circle 
corresponding to 0°, 90°, 180° and 270°.  
• Uncheck snap to quadrant and check snap to object 

 

  
 

• Hover the mouse over all objects in the viewing window.   

 
 

What you will see is that the cursor snaps to all objects in viewing window.  This snapping 
mode is very useful to snap to any type of object including solids and surfaces. 
• Uncheck snap to object and then check snap to tangent 

 

 
 

• Click on the line from 2 points constructor. 
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• Click once on the large orange circle. 
 

 
• Click next on the small yellow circle on the left. 

 

  
• Click again near the top of the small yellow circle on the left, then click 

near the top of the yellow circle on the right. 
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Observe that Snap to Tangent snaps the point so that the object you are creating will be 
tangent to the object you snapped to. 
 
• Uncheck Snap to Tangent then check Snap to Toolpath 

 

 
 
 
 
 

• Click on the toolpaths icon from the steps menu 
 

The simulation toolbar should appear 
 

 
 

• Click on the play icon from the simulation toolbar 
 

 
 

• Right-click in the viewing window and click isometric 

 
 

Notice the green line representing the toolpath for the drilled hole feature. 
 
• Select a line from 2 points again from the Geometry toolbar  and hover 

the mouse over the toolpath 
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Observe how the cursor snaps to the toolpath at any point along that toolpath 
 
 
 

Line Constructors 
 
We will now give a summary of what each items function on the line constructor flyout 
toolbar followed by an exercise. 
 
• Click on the line constructor flyout menu from the 

geometry toolbar  
 2 Pts: Line created with two endpoints.  
 Connected: Multiple lines created in succession.  

Endpoint of one line becomes start point of next line.  
 Horizontal: Infinite horizontal line created through a 

point.  
 Vertical: Infinite vertical line created through a point.  
 Pt. Angle: Infinite line created through a point at an angle specified in degrees. 

 
 Offset: Line, circle or arc created offset from another.  New lines have the same 

length as original 
 

Line Constructor Exercise 
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• Open Lines_example.fm  
• From the snapping toolbar click on Snap to Circle/center. 

 

  
• From the line constructor flyout menu select Line from 

Two Points. 
 
 
  

 
 
 
• Use a 2 point Line to create a line from 

A to B.  To do this click once on the 
circle center at A then click again at 
point B. 

 
 
• Use a 2 point Line to create a line from A to D. 
 
 
 
 
 
 
  

  
• From the line constructor flyout menu click on 

connected.  
 

 
• Now use a connected line to create a line from B to E to D.  Click once on 

B then click once on E then once on D. 
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• Use the horizontal line to place a line through C.  Click on the horizontal 

line constructor from the flyout menu 
 

 
 
Click once at point C to create a 
horizontal line  
 
 
 
 

• Use the vertical line tool to place a line through C.  Click on the 
vertical line constructor from the flyout menu 
 

 
 
 
 
 
Click once at point C to create a 
vertical line 
 
 

Use the Pt, Angle line to make a 45 deg line through C.  Click on the pt, 
angle line constructor from the flyout menu 
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Click below the Assistance Bar and specify the line angle as 45. 
 

 
 
Then click at point C 
 

 
 

• Use the Pt, Angle line to make a 135 deg line through C.  Click below the 
Assistance Bar and specify the line angle as 135 

 
Then click at point C. 

  
 

• Use the offset command to offset line A-C-E 0.5 inches 
on each side.  Click on the Offset Constructor from the 
flyout menu 

Click once on the Infinite Line through A-C-E 
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Then click once on either side of the line 
 
 
 
 
 
Repeat for the other side of the line 
 
 
  
 
 

 
Use the offset to offset line B-C-D 0.5 
inches on each side.  Do the same as the 
previous step but now offset the infinite line 
B-C-D on both sides 
  

Circle Constructors 
 
Below is a summary of what each item’s function is on the circle constructor flyout menu 
followed by an exercise. 
 
• Click on the Circle Constructor Flyout Menu from the geometry toolbar 

 

 
 
 

Center, Radius: Creates a circle by clicking on the center and specifying the radius 
or dragging the mouse to a radius 
 

Center, Edge:  Creates a circle by clicking once on the center then again on the 
edge 
 

Diameter: Creates a circle with two points with the diameter being the distance 
between the two points 
 

Tangent Two: Circle created by snapping the circle's edge tangent to two objects 
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2 Pts, Radius: Creates a circle by specifying two points and a radius 

 
3 Pts: Creates a circle from three points 

Circle Constructor Exercise 
 

 
• Open circles_example.fm 
• From the snapping toolbar enable snap to point, snap to endpoint, snap 

to centerpoint then snap to intersection 
 

 
 
 

• From the circle constructor flyout menu click on 3 Pts 
 

 
 

• In the upper left hand corner locate the 3 points and 
click once on each point 

 
 

 
• From the circle constructor flyout menu click on 

Center, Radius 
 
Below the assistance bar there is a field for the circle 
radius.  Enter 0.625”. 
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Then click on the corner of the Geometry in the lower left 
 
 

 
• From the circle constructor flyout menu click on 

Tangent Two 
 
 
 
Click once on the line segment in 
the upper left area as shown below 

 
 

 
 
Then Click again on the line segment perpendicular to it 
 
 
 
 
 
 
• From the circle contructor flyout menu click on 

Diameter 
 

 
 
In the square located on the center of the 
part Click once on the left vertical line 
segment 
 

 
 
 

Then Click again on the right vertical line segment 
 
 
 
 
  
 
• From the circle constructor flyout menu click on 

Center, Radius  
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• In the assistance bar below the display window enter a Radius of 0.5” 

  
 
 
  

 
 
 
Click once where the perpendicular and vertical lines 
meet close to the right hand corner: 
 
 

 
 

 
• From the circle constructor flyout menu click on 

Center, Edge  
  
  

 
Snap to the rectangular corner located toward the 
upper right hand of the part and Click once 
 

 
 
 
 
Then Click again at the end of the vertical line 
segment to the right 
 
  
 

• From the circle constructor menu click on 2 Pts, 
Radius  
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• Enter a Radius value below the assistance bar as 0.625”. 

 

 
 
Snap to the corner of the geometry segments shown below and click 

 
Then click again snapping to the opposite corner shown below 
 

 
 
 
When finished the project should look like the image below 
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Fillet Constructors 
 
Below is a summary of each item’s function is on the fillet constructor flyout menu followed 
by an exercise. 
 
• Open fillet_example.fm 
• Click on the fillet constructor flyout menu from the geometry toolbar. 

 
 Corner fillet creates a fillet in a corner originally 

defined by an intersection of lines or arcs. 
 

 Two point fillet creates a fillet in a corner originally 
defined by an intersection of lines or arcs. 
 

 Three points defines a fillet by selecting three 
points, similar to the three point circle.. 
 

 Chamfer creates a chamfer in a corner originally defined by an 
intersection of lines or arcs. 
 

Fillet and Chamfer Constructor Exercise 
 

 
 
 
• From the part view Right-click on stock then Left-click on Hide Stock. 
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• From the Fillet Constructor flyout menu select Corner Fillet 
 

 
• Below the assistance bar enter 0.438” for the Radius. 

 
 

• Move the mouse close to C then Left-click. 

   
• From the Fillet Constructor flyout menu select 2pt 

fillet. 
  
 
 
 

• Below the assistance bar enter 0.375” for the radius value. 
 

 
 

 
• Create a 2 Pt Fillet between A and D shown below by clicking once on the 

vertical line segment I - A then once on the horizontal line segment passing 
through A – D. 
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• Below the assistance bar enter a value of 0.875”. 
 

 
 

• Click once on the line segment between A – G and once on the line 
segment A – E. 

  
 
 

• From the fillet fly out menu Click on 3 Pt Fillet  
 

 
 
 
 
• Click once on the line segment D-F  

 
 
 
 
 
 
 

then again on the line segment F-G 
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• then once more on the line segment E-H 
 

 
 

• From the Fillet Flyout Menu click on the Chamfer 
command 
From the assistance bar enter the width and height of 
0.20” 

 
 

• Move the mouse near the line 
intersection at point B and click 

 
 
 
When this exercise is finished you should see 
results similar to that shown on the right. 
 
 

Arc Constructors 
 
Below is a summary of what each items function is on the arc constructor flyout menu 
followed by an exercise. 
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• Click on the arc constructor flyout menu from the geometry toolbar 
 

 
 

 Arc from three points constructs an arc through a start point, edge 
point, and a finish point. 
 

 Arc from two points, radius constructs an arc through two points with a 
specific radius. 
 

 Arc from center, beginning, end constructs an arc from a center point 
and given beginning and end points. 
 

 This selection constructs an arc with a specific center and radius with 
the starting and ending points determined by angles. 
 
Arc Constructor Exercise 
 

 
 

• Open arcs_example.fm 
• From the snapping toolbar click on snap to point and snap to endpoint 

as the only snapping modes checked 
 

 
 

• Click on the arc from three points constructor from the arc constructor 
flyout menu 
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• In the upper left hand quadrant of the stock click once on A, B then C. 
 

 
 

• Click on 2 Pts, Radius from the arc 
constructor flyout menu  
  

• Below the assistance toolbar enter a radius of 1.25” 
 

 
 

• Click once at point G then again at point H 
 

 
 

• Below the assistance toolbar enter a radius of 2” 

 
 

• Click once at point J then again at Point I 
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Notice that depending on which point is picked first determines the direction of the arc. 
 
 
 
• Click on the arc from Center, Beg, End from the arc constructor flyout 

menu 
 

 
 

• Click once at point E, then at point F and then at point D. 
 
 

 
 

 
 

• Click on the arc from Center, Rad, Beg, End from the arc constructor 
flyout menu 
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• Below the Assistance toolbar enter 2” for the Radius 
 

 
 

Click once at point N next at point K and finally at point M 

 
 
 
 
 
 
When the project is complete it 
should look similar to the image on 
the right. 
 

 

 

 
 

 
 

Dimensioning  
 
Below is a summary of what each item’s function is on the Dimensioning flyout menu 
followed by an exercise. 
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• Click on the dimensioning flyout menu from 
the geometry toolbar 

 
 
 
 
 
 

 Horizontal creates dimension information 
based on the horizontal axis of the part.  

 Vertical creates dimension information based 
on the vertical axis of the part. 
 

 Linear creates dimension information based on the absolute distance 
between two points regardless of the angle of the dimensioned space. 
 

 Radius creates dimension information for the radius of the selected object. 
 

 Diameter creates dimension information for the diameter of the selected 
object. 
 

 Angle creates dimension information for the angle between two selected 
lines. 
 

 Text label creates a text label entered in the dialogue bar 
 

 Annotation places explanatory text, entered in the dialogue with an arrow of 
what is being explained 
 

 Curvature samples the surface and computes the curvature in two 
directions to describe how the surface behaves at the point shown in the 
dialog bar. Unlike the other dimensioning tools, Curvature is a real-time 
rubber-banding effect where you traverse the surface to find the point with the 
smallest curvature radius. Knowing the smallest radius tells you the smallest 
tool to use to manufacture the surface. 
 

 This dialog helps you extract numbers from the graphics window using 
snap modes and pick filters. You can then cut and paste these values into 
other dialogs. 
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Dimensioning Constructor Exercise 

 

• Open dimension_ex.fm 
• Click on options then on viewing.  In the Dimension text size enter 1 

then press OK. 

 
 

• On the snapping toolbar check snap to center and snap to object only. 
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• From the Dimensioning flyout menu on the geometry toolbar select 
Horizontal Distance 

 
 

• Click once on the vertical line segment, close to A, then click again on the 
vertical line segment at B then click once again above the horizontal line 
segment between A and B 

 
• From the dimensioning flyout menu click on Vertical distance 

 
• Click once on the horizontal line segment between A and B , click once 

on the horizontal line segment E – F then click again to the right of the 
vertical line segment B-F 

 
 

• From the Dimensioning Flyout menu Click on linear distance 
 

 



FeatureMILL2.5D                                                                                 Snapping and Geometry 

     FeatureMILL2.5D 2012                                        33 

• Click once at the circle center of circle G , click again at the arc center 
between D and E, then click again between the two previous points 

 
• From the dimensioning flyout menu click Radius 

 
 

• Click once on the Arc at D – E then Click again slightly above the arc 

 
• From the dimensioning menu click on Diameter 
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• Click once on the circle located at G then click again to the left of circle G 
 

 
• From the Dimension flyout menu select Angle. 

 

 
 

• Click once on line segment F–G then click once on line segment C-G then 
Click again somewhere between the two 
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• From the dimensioning flyout menu click on Text Label. 
 

 
 

• Below the assistance bar enter the text “Watch SF closely!” 
 
 

 
 

 
 

• Click once above the stock outline 

 
 

• From the dimensioning flyout menu select Annotation 
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• Click once at point B then click again towards the upper right hand corner 
of the stock outline 

 
• Click again towards the upper right hand of the stock 

 

• Below the assistance bar enter the text “Surface Finish = 12” then press 
the Create button. 
 

 
 
 
 
When the project is finished you should have results similar to those shown below. 
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Clipping 
 
Below is a summary of what each item’s function is on the clipping flyout menu followed by 
an exercise. 
 
• Click on the clipping  flyout menu from the geometry toolbar 

 
 

 

 
 
 
 
 
 
 
 
 
 
 
Clip: Clip removes a region of a line, arc, circle or curve. A region is defined as a portion of an object 

between two intersection points. 
 

Trim/Extend: changes the length of a line or an arc. Trim/extend can be used to lengthen or shorten lines and 
arcs as follows: 
 

Infinite: changes the length of a line or an arc. 
 
 
Clipping Exercise 
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The purpose of this exercise is to become familiar with the clipping, trim/extend and infinite 
geometry modification functions.  These functions will be shown once then try to make the 
file clipping example look similar to the image above 
 
• Open clipping_example.fm 
• From the snapping toolbar check snap to grid and snap to point only. 

 
 

 
• From the geometry toolbar Click on Clip. 

 

 
 

• Locate the horizontal line segment at A then click on it once 

 
 

• Locate the vertical line segment at B then click once 

 
 

• From the geometry toolbar click on Trim/Extend 
 

 
 

• Locate the Horizontal line segment to the left of C and Click once 
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Then Click again toward the vertical line and point across from C. 

  
 

• Locate the horizontal line segment at D and Click once. 

 
 
Then Click again between and the vertical line 
 

               
 

• From the snapping toolbar Click on Infinite.   

 
 

• Locate the Point near the vertical line segment at point E and Click once 
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• Locate the horizontal line segment at point F and Click once 
 

 
 

When finished, you should have results similar to the image below: 
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Curve Creation 
Introduction 
 
This module will provide an understanding of what curves are and how to create them within 
FeatureCAM. By the end of the module the user will be able to construct both open and 
closed curves and import curves from other objects. 

What is a Curve? 
 
Curves are paths in 2D or 3D space.  You can create them in FeatureCAM or import them 
from a CAD system.  Curves can be open or closed. You can create curves from lines and 
arcs, from other curves, from points, from CAM dimensions, from Windows fonts, or from 
surfaces. 
 

 

Chaining 
 
Lines, circles and arcs typically represent the shape of a part. To use a sequence of lines and 
arcs as the shape of a feature, you must chain them into a curve.  To make a feature from 
more than a single line, arc or circle, you must connect the geometry into a curve. Chaining is 
the primary way of creating curves by connecting pieces of geometry.  In many cases you do 
not need to trim away pieces of geometry. Chaining will automatically prefer smooth, 
tangent-continuous paths since these paths are more conducive to manufacturing. 
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Closed Curves 

Closed Curves have start and end points in the same location, and at least one other point (not 
in that location) included in the curve. The closed curve clearly defines an area as the interior 
of the curve and completely separates this area from the exterior of the curve. Any 
ambiguities, such as overlapping curve links or intersecting curve links, cause failures and 
unpredictable results in the machining routines in FeatureCAM.  To chain open curves the 
closed curve command may be used or by simply double-clicking the closed geometry using 
the pick pieces command. 

 

Open Curves 

Open curves have end points that do not meet. You can only use open curves in Side and 
Groove features. To chain open curves we use the pick pieces command. The image below 
shows two open curves on a part.  
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User Interface curve chaining 
 
Curve chaining commands can be accessed from three different areas of the user interface: 
 
Curve chaining commands may be accessed through the 
Geometry toolbar 

 
 
 
 
 
May be accessed from the File menu by clicking on Construct -> Curve -> Chaining 
 
  
  
 
 
  
 
 
 
 
 
 
 
 
 
 
 
Or may be accessed by clicking on Curves from the Steps Toolbox 
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Curve Wizard 
 
Curve constructor commands can be accessed in four different areas of the user interface: 
 
Curve constructor commands are available through the Steps menu: 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
They may also 
be accessed 
through the File 
menu by 
clicking on 
Construct and 
Curve: 
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May be accessed through the curve toolbar (to show the curve toolbar, from the file menu 
click on View then Toolbars then check the Curves and Surfaces checkbox and press OK) 
 
 
 
 
 
 
Or may be accessed at the bottom of the Geometry toolbar(not all functions available here) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Chaining Open and Closed Curves  

  
 
• Open FeatureCAM by double-clicking the FeatureCAM shortcut icon on 

the desktop:  
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• Click on Open an existing file in the New Part Document wizard window 
then press Next. 
• Select Curve_Chaining.fm then press the Open button. 
 
 
 
 
When the file is open it should look similar to the image below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
• From the Geometry toolbar select the Chain 
Menu flyout then click on Closed Curve 
 
 
• Click once on the circle at “A” then press the Create button below the 
graphics window.   
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• Do the same for the circles located at B, C and D. 
 
 
 
 
 
• From the Part View menu click on the + next to the word Curves.  Four 
curves should be listed.  These four curves are the curves that were created in  
the previous step. 
 
• Click on the cross shape centered on “A” then press the Create button 
below the graphics window 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Do the same for the cross shapes located at B, C and D 
 
• Click on the large square with a corner radius centered around “A” then 
press the Create button below the graphics window 
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• Do the same for the large squares located at B, C and D. 
 
 
 
• From the Geometry toolbar select the Chain Menu 
flyout then click on Pick Pieces 
 
 
• Click once on the horizontal line segment located at “E” 
  

  
 
 
 
 
 
 
 
 
 
 
 
Then click once on the vertical line segment at “I” 
  
  
 
 

 
 
 
 
 
 
 
 
 
Then click once at the vertical line segment located next to “J” 
 
 
 
 



FeatureMILL2.5D                                                                                                Curve Creation 

      FeatureMILL2.5D 2012                                                    9 

 
 
 
 
 
 
 
 
 
 
 
Then click on the vertical line segment located at “K” 

  
  
 
 
 
 
 
 
 
 
 
 
 
Then click on the horizontal line segment located next to “F” then press 
the Create button below the graphics window. 
  
 

• Following steps similar to those shown above create a zigzag curve 
between “G” and “H”. 
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In this exercise curves have been made from Geometry.  These curves can be useful for 
creating features, surfaces and solids. 
 
 
 
 
 
 
 
 

Curve Constructors 
 
Curve constructors are used to create/modify curves using different methods. In this section 
there will be a short description of how each function works followed by an exercise.  
 
• From the  file menu click on Construct then on Curve. Let’s review these. 
 

 
 
 
There are four Different methods for creating curves: From Curve, Other methods, From 
Surface and Chaining: 

Curve from Curve 
 
• From the file menu click on Construct then Curve then From Curve 
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The curve from curve menu has functions that create new curves based on existing curves. 
 

  Curve Join connects a collection of curves, arcs or lines into a single 
curve. 

  Curve Start/Reverse changes direction and starting point of the curve 

  Curve Offset offsets a curve in the direction you pick by the amount 
you set. 

  Project to UCS projects flat curve or 3D curve to current UCS 
 

  Extract Font Curve extracts curve segment from a font curve 
 

 Smooth/Reduce Curve reduces the amount of data in a curve and 
smoothes out any bumps within a user specified tolerance. 

 

  Unwrap unwraps a curve that has been wrapped around a cylinder 
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Curve from Curve Exercise #1  
 

 
 
• From the file menu select File then Open 
• Select the file named 
Curve_From_Curve1.fm then press Open 
 
• Click the “+” in the part view next to 
curves 

 
You will see that in this file there are four curves. 
 
 
 
 
 
 
 
 
• From the file menu click on 
Construct then Curve, From 
Curve and Join. 
 
A dialogue window for Join curve 
appears. 
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• Click on the selection arrow (black arrow with the red wavy line) icon .  
Click once on the curve next to A, click again on the curve next to B and 
click again on the curve next to C then press OK/Finish. 

 
 
 
Observe the list of curves 
in the Part  View.  A new 
curve has been added 
from joining the curves. 
 
 
 
 
 
 
 
 
 
• From the file menu 

click on Construct then Curve, From Curve and select Curve 
Start/Reverse. 
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By default the first curve should be highlighted.  Notice there is an arrow at the end of the 
curve that shows the direction of this curve. 
 
 
 
 
• From the pull down 
menu select crv2.  
Crv2 should highlight 
then press preview 
 

 
 
 
 
 
 
 
 
 
 
 

The blue arrow shows the new reversed direction of the curve. 
 

• Press OK/Finish. 
 
Reversing of curves is useful for cutting simple grooves for milling.  Simple groove toolpaths 
plunge at the start of the curve and end at the end of the curve. 
 
• From the file menu click on Construct then Curve then From Curve and 
select Curve Start/Reverse.  From the pull-down menu select crv4 then 
activate the radio button Set start point. 
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This will highlight the red egg-shape centered around point D.  Notice that the direction of 
the curve is clockwise and the start point is on the left hand side of the egg.  If we were to 
apply this curve to a simple groove feature the tool would plunge on the left hand side and 
continue clockwise around the profile. 
 

• Click the Pick new start point icon , then click on the right hand side 
of the egg then click the Preview button.  

 
 
A profile of the new curve direction and start point preview is shown. 
 
• Press OK/Finish. 
• In the Part View locate and click on the curve that was joined from the 3 

separate curves at the beginning of the exercise. 
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• From the file menu click on Construct then Curve then From Curve then 
Offset. 
• Enter an Offset value of 0.5, select Left then click Preview and Apply. 
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• Using the same curve select an Offset of 0.5, select Right then Preview. 
 

 
 
Observe the area circled in red.  This is a self-intersection that could be bad for cutting as an 
offset profile. 
 
• Click on the checkbox that is labeled Eliminate self-intersections then 
press Preview. 
 

 
 
Notice that there is no longer a self intersection. 
 
• Press OK 
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Curve from Curve Exercise #2 

 
 
• From the file menu select File then Open 
• Select the file named Curve_From_Curve2.fm then press Open 
• Right-click in the viewing window and press rotate. 
  
• Rotate the part to observe the curve. 
 
Notice that the curve is 3 dimensional.  Most features from curves do not allow you to use a 
3D curve for a feature.  The only feature that will accept a curve that is not in the plane of the 
current setup UCS is a simple groove. 
 
• From the file menu click on Construct then Curve, select From Curve 
then select Project to UCS and then press OK. 

 
 
A curve is created by projecting the existing curve profile in Z to the current UCS.  This 
curve can now be used to create 2.5D features from a curve such as pockets and bosses. 
 
• Click on the curve that was just created then from the file menu click on 
Construct then Curve then From Curve then select Smooth/Reduce Curve 
then press Preview. 
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The Smooth/Reduce dialogue appears.  When the preview button is pressed the Data 
reduction% field is populated.  In this example the data reduction is about 50%.  The new 
curve contains 50% less data but also has the ability to deviate from the original curve within 
tolerance. 
 
• Press OK and the new curve is created 
 
 

Curve from Curve Exercise #3 

 
• From the file menu select File then Open. 
• Select the file named Curve_From_Curve3.fm then press Open. 
• From the file menu click on View->Show->Show STOCK Axis. 
 
The part that has been opened is a 4th axis part to be indexed about the stock x axis. 
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• Right-click in the graphics window and press Rotate.  

 
 
• Rotate the part by moving the mouse to observe the curve 
 
Notice that the curve is 3 dimensional as in the previous example.  The only feature that 
would be able to use this curve would be a simple groove.  So the curve needs to be 
unwrapped so it lies in a plane aligned with the current UCS.   
 
• Click on the curve so that it is highlighted then click on Construct >Curve-
>From curve-> then select Unwrap. 
• In the Unwrap Curve dialog press the Preview button. 
 

 
 
Notice that when the preview button  is pressed the curve is unwrapped around the stock axis. 
 
• Press OK 
 
Now the curve can be used to create a 2.5D feature since it is aligned with the current UCS. 
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Curve from Surface 
 
• From the file menu click on Construct->Curve->From Surface 

 
 
The Curve From Surface menu has functions that create new curves from 
surfaces. 
 

 Boundary extracts the curve from a surface's boundary 
 

 Trimmed Edge extracts the trimmed edges of a surface 
 

 Intersection extracts curves from a surface-surface intersection 
 

 Isoline extracts surface row or column isolines 
 

 Project onto Surface project existing curve onto a surface 
 

 Surface Edges extracts selected surface edges 
 

 Surface Projection extracts curves from all vertical walls 
 

 Revolved Surface Boundary extracts a revolved profile about the 
part’s index axis 
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Curve From Surface Example #1 
 
• From the file menu select File then Open 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Select the file named Curve_From_Surface1.fm then press Open 
• From the file menu click on: 
 

Construct->Curve->From Surface->Boundary 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Select Srf1 from the pulldown menu select First Row then press Apply. 
 
In the Part View window under Curves a new curve appears.  This curve is created from the 
first row of srf1 boundary 
 
• Press OK 
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• From the file menu click on:  
 
                      Construct->Curve->From Surface->Trimmed Edge. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The trimmed edge dialog appears that gives the ability to extract trimming curves used to 
trim the surface. 

• Click the Pick curve on surface icon with the red wavy line  
• Click one of the edges of the green diamond on srf1 then press OK. 
 

 
 
A curve is extracted from the trimmed surface 
 
• From the file menu click on:  
                      
            Construct->Curve->From Surface->Intersection 
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The surface intersection dialog appears that enables a curve to be 
constructed where the surfaces intersect.  

 
• Locate the aqua blue and orange surfaces in the lower left hand corner.  
For Surface 1 select srf2 (aqua blue surface)  from the pull-down menu.  
Click on the Pick surface icon  and click once on the orange surface. 
 
• Press the Preview button. 
 

 
 
Observe that  a curve is highlighted in blue in the lower left hand corner where the two 
surfaces intersect.  This is the curve that will be created when OK or Apply are pressed. 
 
• Press OK 
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• From the file menu click on:  
                  Construct->Curve->From Surface->Isoline 
• Select srf1 as the surface and in the count field enter 3 

 

Notice the preview of the surface isolines running along surface rows in the current view. 
 
• Then press OK/Finish. 
• From the file menu click on:  

Construct->Curve->From Surface->Project onto Surface. 
• In the Project Onto Surface dialog select srf1 for the Surface and select 
curve32 for the Curve. 
• Press the Preview button. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Curve32 (DELCAM) is projected in the Negative Z direction.  The resulting curve could be 
useful for engraving text on a surface using a simple groove. 
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• Press OK/Finish. 

 
• From the file menu click on:  
Construct->Curve->From Surface->Surface Edges. 
 
• Click on the Pick curve on surface icon. 
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• Pick the lower  surface edges  on the purple shape in the upper right 
hand corner until all edges are selected.  Be sure to pick the surface edges 
consecutively.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• When all edges are pick press the red X next to  the minimized surface 
edges window 
 
• Press OK/Finish. 
 
The curve constructor from surfaces surface edges is a very useful tool for extracting curves 
from surfaces or from the faces of a solid. 
 
From the file menu click on Construct->Curve->From Surface-> then 
Surface Projection. 
 
The first dialog that appears gives you the ability to specify the draft angles and elevation 
relative to the UCS where the curve is to be created. 
 
• In the Surface Projection dialog enter 1 for the Wall Angle and 0 for the 
Elevation then press Next. 
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• In the following window select All surfaces then press Next 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A preview of the geometry to chain in the viewing window appears highlighted in green. 
 
 

• Check the radio button Remove after chaining then press Finish. 
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• Chain the geometry into a Closed Curve then press Create. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The curves created from this exercise should look similar to the results shown below: 
 

 
 
• To see the curves click on View->Hide->Hide All.  Then click on View-

>Show->Show All Curves. 
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Curve From Surface Example #2 

 
 
• From the file menu select File then Open 
• Select the file named Curve_From_Surface2.fm then press Open 
• From the file menu click on: 
            Construct->Curve->From Surface->Revolved Surface Boundary. 
• Select the radio button that is labeled Solid method then Preview. 
 

 
 
 
• Click OK/Finish. 
• Hide all solids to see the curve that has been created. 
• Close the file without saving. 
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Curve From Other Methods 
 
• From the file menu click on Construct->Curve->Other Methods 
 

 
 
Curve from other methods gives you the ability to create curves using other types of 
constructors. 
 

 Function creates user-defined mathematical relationships to generate a 
graphical figure. 

 Cams creates the geometric profile of various reciprocating cams or 
Cylindrical cams. 

 Spline/Interpolation creates a continuous smooth curve between points. 

 Text creates text curves from any TrueType installed for windows. 

 Ellipse curve tool creates an elliptically-shaped curve in the plane of the 
current UCS. 

 The Rectangle curve tool creates a rectangular shaped curve in the 
plane of current UCS. 

 The Gear curve tool creates a 2D gear profile. 
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Other methods Example #1 functions 
 
The Functions method of creating a curve allows the user to define a 2D or 3D curve in terms 
of a mathematical function. In this example we will create a helix. 
 

 
 
• From the file menu click on New. 
• Select a milling setup with inches then press OK. 
• From the file menu click  Construct>Curve>Other Methods>Functions. 
• From the Function pulldown select r=F(a), z = G(a) 

 
 

 
 
 
 
 
 
 
 
 
 
 

 
In this example a Helix will be constructed.  The helix will have 4 revolutions with a constant 
radius of 1 and a pitch of 1.   F is the function for the radius of the curve and G is the 
Function for the pitch.  The letter “a” represents angle.   
 
• Change the parameter F to 1 since there is a constant radius of 1” 
•  In the G field enter a/360.  This means that every 360 degrees the helix 
will rise 1 inch. If you would like to rise a half inch every 360 degrees change 
the parameter to (a/360)*.5 
• Select Degree. 
• Enter 0 for Start. 
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• In the End field enter 360*4.  This means the helix will go around 4 times. 
• Change the Increment to 5.  This is how course or rough the helix will be.  
Changing the value to a large value will make the helix faceted. 
• Press Preview and press OK.  
 

 
 
 

Other methods example #2 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• From the file menu click on new 
• Select a milling setup with inches 
then press Finish. 
• Enter the stock dimensions as 4” x 5”  
x 1” then press Finish. 
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• From the file menu click on Construct->Curve->Other Methods>Text 
• In the Text field type in DELCAM then press the Preview button.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A preview of the text Delcam is shown with the default machining font. 
 
• Click on the Font button 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The available fonts are shown in the left hand window.  All windows fonts are listed in this 
window as well as 5 machining fonts installed with FeatureCAM.  All of these fonts start 
with “Machine Tool...”.  These fonts are unique because they are single line engraving fonts 
that are useful for engraving. 
 
• From the available Font list select Machine Tool Gothic and press OK 
 
*Note: it is suggested to not change the size of the font in the Font window as 
undesirable results could occur.  The value for all the machining fonts should be set to 
72. If changes are needed to the size of the text, use the scaling option. 
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• In the Engraving text dialog change the Location to (0.75, 0.75, 0).  
Change the Angle to 30 and change the Scaling to 0.8 then press OK. 
 

 
 
• From the file menu click on:  
                                       Construct->Curve->Other Methods>Rectangle. 
• In the Rectangle dimension dialog enter the values highlighted and press 
OK/Finish. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
Results now should look similar to the image on 
the right: 
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• From the file menu click on Construct->Curve->Other Methods>Ellipse 
• In the Ellipse dialog change the values of the fields highlighted below 
then press OK/Finish. 
 

 
 
The resulting curves can be used 
for engraving by creating a simple 
groove. 
 

 

Other methods example #3 
 

 
 
• From the file menu select File then Open 
• Select the file named Curve_From_Other_Methods3.fm then press Open 
• Enable Snap to Point from Snap Mode toolbar 
 

 
 
• From the file menu click on:  
                        Construct->Curve->Other Methods>Spline/Interpolation 
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• Below the assistance bar press the Options button so that Closed       
interpolation is activated. 
 

 
 
• Click on each point sequentially then press the create button below the 
assistance bar. 

 

 
 
When finished the resulting curve should look similar to the curve below. 
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Basic 2.5D Features 
Introduction 
 
This Module will provide an understanding of  what a feature is, the feature types available 
and how to create various types of 2.5D features. 
 

What is a Feature? 
 
Features are the intelligent core entities that a machinist would use to make a certain shape in 
the material they are cutting.  Shapes such as a hole, boss, slot, etc…Features are used to 
make toolpaths in FeatureCAM to make these shapes.  Features may consist of several 
operations to create the final result or shape. 
 

 
 
Features may consist several operations including: spot drill, center drill, drill, pre-drill, tap, 
roughing, semi-finish and finish passes. 
 
A 2.5D Feature is a Feature that in a single plane, primarily the XY plane.  A more complex 
Feature that will be introduced in later modules is a 3D Feature that cuts in X, Y and Z axis 
simultaneously. 
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User Interface 
 
All features created inside of FeatureCAM are initially created using the New Feature 
Wizard.  The New Feature Wizard can be accessed in several different areas of the user 
interface. 
 
 

• Accessed through the 
Advanced Toolbar. 
 
 
 

• Accessed through the 
Steps Toolbar.  

 
 

• Accessed through the File Menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 

 
 
• Or the New Feature Wizard may be accessed 

through the Steps Menu. 
 
 
 
 
 
 

The new Feature Wizard is broken into four sections: 
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From Dimensions:  Feature From Dimensions specific dimensions for the hole, 
rectangular pocket, face, etc... may be entered.  No curve is required to create the 
feature boundary.  
 
From Curve: Feature From Curve defines the feature boundaries by using curves. 
 
From Feature: Feature from Feature allows the user to create a group of features, a 
pattern of features, a feature from existing toolpath or a user defined feature. 
 
From Surface: Feature from Surface is used to create surface milling features by 
either selecting part surfaces or faces. 
 

Feature Representation 
 

• From the desktop double-
click on the FeatureCAM 
shortcut icon.  

 
 
 
 
• From the New Part 

Document Wizard select 
New File then press Next. 
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• Select Milling then 
inches and press 
Finish. 
 
 

 
 
 
 
 
 

 
 
 
 
 
 

• On the Dimensions page 
press Finish. 
 

 
 
 
 
 
 

 
 
 
 
 
 
 

• On the 
Stock 
Properties 
page press 
OK. 
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• Right click in the graphics window and click on Isometric. 

 
 
• From the Steps Toolbox click on Features. 

  
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• Select Hole and press Finish. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
  
  
 

• In the Hole Feature Properties window press OK. 
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• In the Toolbox Window click on Part View. 

 

 
 

Notice that the hole feature created is represented in three different sections of the user 
interface: the feature shown in a tree structure under the part view on the left, a graphical 
representation of the feature in the viewing outlined in pink and the feature listed with its 
associated operations on the operation list. 

 
• Double-click on the hole in the Part View.  The Hole Feature 

Properties window should appear.  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
It should 
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be noted that the feature properties can be accessed by double clicking on each representation 
of the feature: in the Part View in the Graphics Window or the Operations List. 
 

Features from Dimensions 
 
Features from Dimensions consist of Hole, Rectangular Pocket, Slot, Step Bore, Thread 
Milling and Face. 
 

 
 

Holes 
There are six different types of hole features in FeatureCAM.  Plain, Counter bore, Counter 
drill, Counter sink, Tapped, Counter drilled tapped.  Each hole type consists of different 
operations to create the resulting feature.  Below is a graphical representation of the available 
holes in FeatureCAM 
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Feature From Dimensions Exercise #1 
 

• From the file menu click on Open. 
• Select holes.fm then press Open. 

 
The opened file should look similar to the image below: 

 
• Click on Construct then New Feature. 

 
 

 
 

 
• In the New Feature 

Wizard select Hole 
then press Next. 
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• On the new feature dimensions page select Plain Hole, enter a 

Depth of 1.0 and a Diameter of 0.25 then press Next. 

 
 
 
 

 
• Click on the Pick location button.  
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• Click once on point A (values should be identical to those listed 

below once point A is clicked) then press Finish and OK. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 

 
A 
plain hole is created at point A.  The next step is to create the 5 different types of remaining 
holes at B, C, D, E and F. 
 

• At point B create a Counter 
Bore Hole with the 
dimensions shown. 
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• At point C create a Counter 

Sink Hole. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• At point D Counter Drilled 
Hole. 
 
 

 
 
 
 
 
 
 
 
 
 

 
• At point E create a Tapped 

Hole 
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• At point F create a Counter 
Drilled and Tapped Hole. 
 
 

 
 
 
 

 
 

 
 
When this exercise is finished you should 
have results similar to the image below: 
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Feature From Dimensions Exercise #2 
 

 
• From the file menu click on Open. 
• Select hole patterns.fm then press Open. 

 
The opened file should look similar to the image below: 
 

 
• Left click and drag a bounding box to enclose all six points so they are 

highlighted. 
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• With the six points still highlighted click on Construct then New 
Feature. 
 

 
 

The New Feature wizard should appear notice that hole is automatically selected and that 
Make a pattern from this feature is automatically checked. 

 

 
 

By selecting these points and then entering the New Feature Wizard FeatureCAM knows to 
create a pattern of holes.  

• Press Next. Select a Plain Hole. 
• Press Finish 
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The Pattern Properties appear and a Point List for the pattern appears.  The order in which 
the holes are drilled depends on the order the points listed in the table. 
 

• Press the Sorting button  
• Press X-ascending then press OK then Apply. 

 

 
 

Observe the graphics window.  Notice that the order in which the holes are drilled has been 
changed.  
 

 
• Press OK 
• From the file menu click on Edit then 

Select circles 
 
 
 

A filter dialog will appear for selecting circles of a specific diameter and tolerance.   
 
For the Radius value enter 0.250 and enter 0.0001 for the Tolerance then press OK 
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The circles on the upper half of the part drawing should highlight red. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• With the six circles still highlighted click on Construct then New 

Feature. 
  

 
 
 
 

 
• Select Hole and check Make a pattern from this feature. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 



FeatureMILL2.5D                                                                                        Basic 2.5D Features 

      FeatureMILL2.5D 2012                                                    17 

 
 
• Press Next. 

 
The hole Diameter field is automatically populated because the circle diameter was 
previously selected. 

 
 

• Press Finish then OK and results should look similar to those shown 
below. 
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Feature From Dimensions Exercise #3  

 
 
This exercise will familiarize the user with creating pockets and slots from dimensions.   
 

• From the desktop double click on the FeatureCAM shortcut icon   
• From the New Part Document Wizard select New File, press Next. 
• Select Milling then inches and press Finish. 
• On the dimension page enter 4 for the Width, 6 for the Length and 1 

for the Thickness then press Finish and OK. 
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• Open the New Feature wizard 

from the Steps Toolbox.  
Select Face then Finish. 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

• Press on the Features 
icon to open a New 
Feature from the Steps 
Toolbox.  Select 
Rectangular Pocket then 
press Next. 

  
 
 
 
 
 
 
 
 
• Enter the dimensions of the 

pocket as shown.  3 for the 
Width, 1.5 for the Length and 
0.625 for the Depth.  The 
Corner Radius should be set to 
0.25 with a Bottom Radius of 
0.25.  Once the dimensions 
have been entered press Next. 
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• On the location tab select the 

XYZ radio button and enter a 
location of (.5, .5, 0) then press 
Finish. 

 
 
 
 
 

 
 
 
 
  
 

• Open the New Feature 
wizard from Steps.   

• Select Rectangular 
Pocket then press Next. 

 
 
 
 
 
 
 
 
 
 
 
• Enter the dimensions of the 

pocket as shown below.  3 for the 
Width, 1.5 for the Length and 
0.625 for the Depth.  The Corner 
Radius should be set to 0.25 with 
a Bottom Radius of 0.25.  Once 
the dimensions have been 
entered press Next. 
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• On the location page select the 
XYZ radio button and enter a 
location of (4, .5, 0) then press 
Finish. 

  
  
 
  
 
• Press on the Features icon to 

open the New Feature wizard 
from the Steps Toolbox.  Select 
Slot then press Next. 
 

 
 
 

• Enter the slot dimensions as 
shown below.  Enter a Length of 
5.0, a Width of 1.0, Depth of 0.75 
,a Bottom Radius of 0.125 and 
an angle of 90 degrees then 
press Next. 
 
 

 
 
 

 
 
 
 
 
 
• On the location page select the XYZ 

radio button and enter a location of 
(3, -0.5, 0) then press Finish. 
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When this exercise is complete you should get feature results similar to the image shown 
below:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Right click in the graphics window and select Isometric. 
• From the Steps click the Toolpaths icon, then run a 3D simulation. 
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Feature From Dimensions Exercise #4 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• From the FeatureCAM file menu click on File then Open. 
• Select the file named “ThreadmillStepbore.fm” then press Open. 
 

Examine the features in setup 1 (Part View).  Notice that a face feature and rectangular 
pocket have already been created. 
 

• Press on the New Feature Wizard icon from the Steps Toolbar. 
• Select Step Bore then press Next. 
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• Enter the values as shown for 
each of the steps, press Set 
then press Next. 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

• Press the XYZ radio button 
then enter the location 
dimensions as (0,0,-0.5) then 
press Finish and OK. 

 
 
 
 
 
 

 
 
 
 

• From the Steps Toolbox 
press the Toolpaths icon 
then run a 3D simulation. 

 
 
 

Results should look similar to the image 
to the right: 
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• Eject the simulation. 
• Press the New Feature Wizard icon from the steps toolbar. 
• Select Thread Milling then press Next.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
• Select Get the thread dimensions from a standard thread. 
 
 
 
 
 
• Select ID then from the 

Designation pull-down menu 
select 1.1250-12 UNF then 
press Next. 
 
 

 
 
 

• In the Thread Length field 
enter 1 then press Next. 
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• Pick the XYZ radio button then 
enter a Z location of -0.5 then 
press Finish and OK. 
 

 
 
 
 
 
 
 
 
 
 

 
• Press the New Feature Wizard icon from the steps menu. 
• Select Thread Milling then press Next.  
 
 
 
 
 
• Select Get the thread 

dimensions from a 
standard thread. 
 
 
 
 
 
 

 
 
 
 

• Select OD then from the 
Designation Pull-down menu 
select 3.0000-4 UNC then press 
Next. 
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• In the Thread Length field enter 

1.5 then press Next. Select the 
XYZ radio button enter all 0’s in 
the X, Y, and Z fields. 
 

• Finish and OK. 
 

 
 
 
 
 
• Run a 3D simulation. 
 

You should have results similar to the image below: 
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Features from Curves Exercise #1 
 

 
 

• Open the file named ChamferFillet.fm. 
 

Examine the features in setup 1.  Notice that a face feature has already been created. 
 

• Press on the New Feature Wizard icon from the steps menu. 
• Select Boss and press Next. 
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• Use the Pick curve or geometry arrow to select the curve in blue that 
goes around the outer profile of the part.  The curve name should be 
curve1 then press Next 

 
 
 
 
 
 
 
• For the Offset from curve Z 

location value enter 0.25, then 
press Next. 
 

 
 
 

 
 
 

• On the New Feature -
Dimensions page enter a 
Height of 1.5 then press 
Finish and OK. 
 
 
 

 
 
 



FeatureMILL2.5D                                                                                        Basic 2.5D Features 
 

30 FeatureMILL2.5D 2012   

 
 
 
 
 
• Open the New Feature Wizard 

select Chamfer then press 
Next. 
 

 
 
 
 
 
 
 
• Use the selection arrow to select the curve in blue that goes around the 

outer profile of the part.  The curve name should be curve1 then press 
Next twice. 

 
 
 
 
 
• For the Offset from curve Z 

location value enter 0.25, then 
press Next. 
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• Select 2D Chamfer. 

 
• For the Depth and Width 

dimensions for the chamfer enter 
0.25 then press Finish and OK. 
 
 

 
 
 
 
 
 
• Run a 3D simulation. 

 
You should see results similar to the image below 

 
• Press the Eject button on the simulation toolbar to clear simulation 

results 
• Enter the New Feature and select a Pocket then Press Next. 

 
 
 
 
 
• Use the Pick curve or geometry 

arrow to select the curve in blue 
that goes around the outer profile 
of the pocket in the solid.  The 
curve name should be curve2 
then press Next.  
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• For the Offset from curve Z 

location value enter 0.25 then 
press Next. 
 

 

 
 
 
• On the Dimensions page enter 

the Depth of 1.0 then press 
Finish and OK. 
 

 
 
 

• Click on the New Feature 
Wizard icon select Round then 
press Next. 

 
 

 
 

 
 
• Use the selection arrow to select 

the curve in blue that goes around 



FeatureMILL2.5D                                                                                        Basic 2.5D Features 

      FeatureMILL2.5D 2012                                                    33 

the outer profile of the pocket.  The curve name should be curve2 then 
press Next twice. 
 
 
 

• For the Offset from curve Z 
location enter 0.25 then press 
Finish and OK. 
 
 
 
 
 
 
 
 
 
 

• Run a 3D simulation of the part. 
 

 
Results for the 3D simulation should be similar to the image shown below. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Features From Curves Exercise #2 
 
 
 
 

• Open SideWheel.fm. 
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• Open the New Feature 
Wizard. 

 
• Select Side then press Next. 

 
• Left click and drag a 

bounding box so all curves 
are selected in red then press 
the green plus sign to add all 
selected curves to the list then 
press Next three times. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• On the Dimensions page enter the Depth of 1.0 then press Finish. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 



FeatureMILL2.5D                                                                                        Basic 2.5D Features 

      FeatureMILL2.5D 2012                                                    35 

 
• Run a 3D simulation. 

 
The simulation results should look similar to those shown below 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Feature from Feature Exercise #1  
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• From the file menu click on File then Open and select the file named 
PatternGroup.fm then press Open 

 
Examine the features in setup 1.  Currently there is a single hole and a rectangular pocket.  
Say for example you would like to create a pattern of the hole/ rectangular pocket 
combination.  You could create a pattern of a hole, then a pattern of the pocket or you could 
group the hole and the pocket together and create a pattern of the group that would be more 
effective. 
 

• Open the New Feature Wizard in the From Feature group select 
Group then press Next. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

• Add the hole and rectangular 
pocket to Group Members 
then press Finish. 
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• Open the New Feature 

Wizard select pattern and 
press Next. 
 
 
 
 
 
 
 
 
 

 
 

 
 

• Select the newly created group 
then press Next. 

 
 
 
 
 
 
 
 
 
 
 

 
 
• Select Rectangular then press Next. 
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• Enter 2 for both the number of Rows and Columns and enter 2 for the 
Row Spacing and Column Spacing, then press Finish. 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

• From the simulation toolbar select 3D simulation then press Play. 
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Feature from Feature Exercise #2 

 
 

• From the file menu select File then Open select ToolpathEdit.fm in the 
examples folder then press Open. 
 

Notice there is only a single face feature in this example located at Z=0 
 

• Run a Centerline simulation of the current toolpath.  To do this press 
the centerline simulation button on the toolbar then press the play 

button 

 
 

On this facing toolpath there are four undesirable areas where we would like to change the 
toolpath.  For the toolpath representation there are both feed moves and rapid moves.  Black 
toolpath segments represent the feed moves while the green segments represent rapid moves.  
Currently circled in red are feed moves for the stepover between facing passes.  Since the 
stepover of the facing tool is off the stock it is safe for us to change these to rapid moves. 
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• Press Eject on the simulation toolbar 
 

 
 
 
• Open the New Feature Wizard 

and select Toolpath in the 
From Feature section then 
press Next. 
 

 
 

 
 
 

 
 
 
 
 
 

• Press the Operation radio 
button select face1, finish then 
press Next. 
 

 
 
 
 
 

 
 
 
 
 
• Select the first Y 

feed move from the 
list, then press the 
Edit segment 
button. 
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• Check the Rapid checkbox then press OK. 

 
 
 
 
 
 
 
 
 
• Locate the remaining y stepover feed moves and change them to Rapid 

also then press Finish. 
 

Observe the Features in the part view.  Now there should be a Facing Feature and a toolpath 
feature.  The toolpath feature is simply a copy of the original features toolpaths with the 
edited move. 
 

• Uncheck face 1 in the part view (so there are not two facing operations) 
• Press Play on the Centerline simulation and observe the toolpath. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Now notice that the stepover moves have been converted to rapid moves that will reduce the 
cutting time of the part. 
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Feature from Feature Exercise #3 
 
Often when creating NC programs it may be desirable to insert G code between operations or 
to add comments.  In this example we will explore the “User Defined Feature” that will give 
us the ability to add code or comments to their program. 
 

• Click on File then Open and select CodeComment.fm then press 
Open. 
 

In the file the should be a hole and rectangular pocket feature.  Observe the operation list.  
There is a Spotdrill->Drill->Rough Pass 1-> and Finish.  Between the rough pass 1 the finish 
pass we want to put in an optional stop (M01) so the roughing chips can be cleared out for the 
finish pass. 
 

• Click on Options then Add-Ins. 
 

• Click on the Browse button. 
 

 
 

•  Browse to the Code-Comment operation.bas in the examples folder 
then press OK and OK again. 
 

 
 
 
 
  
• Open the New Feature Wizard 

and select User then press 
Next.  
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• Select Insert Code/Comments (Milling) then press Next. 

 

 
 

• Click on Line 1 Code and in the New Value field type in “M01” then 
press the Set button.  Click on the word comment below Line 1 and in 
the New Value field type in optional stop then press set then press 
Finish. 
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In the operations list in the results window notice there is a new operation called code/text.  
This is the code comment operation that was just created 
 

 
 

• Left click and drag the code/text feature so that it occurs right after 
rough pass 1 (a warning message may appear depending on your 
configuration press OK if it appears) 
 

 
 
Now an M01 should appear in the G-Code. 
 
Note: Some posts may not be configured for this functionality to ensure G-Code is properly 
output check to see that there is {N<SEQ> }{<UDF-TEXT> }{( <UDF-COMMENT> 
)}<EOB> in Formats/Move/UDF Text. 
 
UDF’s (User Defined Features) are not only available for inserting text into the G-code but 
can also be configured to create your own customized features.  To discover the capabilities 
of FeatureCAM’s UDFs contact your local salesperson or support representative. 
 
 
 



2.5D Milling                                                                                           2.5D Advanced Milling  
                                                               

                                                                          
      2.5D Advanced Milling 2012                                                               1 

2.5D Advanced Milling 
 

Introduction 

In 2.5D Milling there are more advanced features than milling and drilling, such as 4axis, 
multiple fixtures, cross section, multiple islands, bosses and side features, etc.  The user will 
learn how tapered walls and other shapes can be machined to emulate 3D milling surfaces 
using a ball end mill, but are still 2.5D features.   

Multiple Curves in One Feature 
 
Boss and Side features begin cutting the feature at the stock boundary.  If your part contains 
more than one boss you must select all of the feature curves for the bosses in one feature.  If 
they are separate features, each will start cutting at the stock boundary thereby removing all 
of the material instead of leaving the individual shapes of each boss.  Side features are the 
same.  A pocket with one or more islands (a shape that the tool cuts around and leaves that 
shape inside the boundary of the pocket) has an island button to select the curves for the 
island, or islands, and then the tool will cut both the pocket shape and the island.  

      Multiple Bosses  
 
 
• Open a new Milling 

document, select Inches. 
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• Establish the stock size and Block shape (4 x 4 x 2) or use Sample:  
        Boss-Side-Pocket.fm. 
 
 

 
         

 
 

• Draw the circles for the multiple Bosses (.500 radius Circles as a triangle 
as illustrated).  These are the multiple shapes you intend to leave on the 
top of the stock after machining.   

 
 
Shape curves do not have to be round but they cannot touch, be inside each other or be higher 
than the stock, they will have a common bottom depth although they can be at different 
heights.  If they are different heights draft angles may not be selected, chamfers will have to 
be separate chamfer features but bottom radiuses will be common to all.  
 
 
 
 
 

• Select New Feature>Boss from 
     Curve. 
• ALL curves must be included in 
     this one feature      
• Enter the height to be 0.500. 
 

 
• Click Finish 

and run a 3D 
simulation.  

 
 

 

 

 



2.5D Milling                                                                                           2.5D Advanced Milling  
                                                               

                                                                          
      2.5D Advanced Milling 2012                                                               3 

Pocket with Islands 

 
• Open a new Milling 

document and select Inches. 
Establish the block stock size 
(4 x 4 x 2) alternatively you 
may open the Sample: Boss-
Side-Pocket.fm. 
 

• Draw geometry to create a 
triangular pocket shape with 
.500 radius corners, roughly 
as shown.  
                    

• Chain a closed curve from 
the triangular shape.  Add two 
.250 radius circles, roughly as 
shown, inside the pocket.   
 
 

The islands can be any shape and have a common depth. They can have tops at different 
heights, but may not be above the top of the pocket.  If they are different heights, draft angles 
may not be selected. Also, in the case of different heights, chamfers need to be applied to the 
pocket, and each island, as separate chamfer operations. If you add bottom radiuses they will 
be common to all.  
 
 
 

• Click on New 
Feature > Pocket 
From Curve >select 
the triangular curve 
(.500 depth) Finish, 
then on the Pocket 
Properties page, 
Dimensions tab, 
select Islands and 
include the two circles 
whose shape will be 
left in the pocket after 
machining.   
                 
• Click OK and Apply. 
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                              All island curves or circles must be included in the feature. 
 

 
 
 
 
 

• Click OK and 3D simulation. 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

      Multiple side features 
 

• Open a new Milling document and 
select Inches. Establish the stock 
size and block shape (4 x 4 x 2) or 
you may open the Sample: Boss-
Side-Pocket.fm. 

•  Draw a “U” shape with a 2.000 
opening and .250 corner radiuses, 
roughly as shown, and chain it as 
an open curve. Add a .250 radius 
half circle, centered in the 
opening, and clip the left side.   
Click New feature > Side From 
Curve and select both the “U” shaped curve and the half circle. 
 
  

Side features can cut on either side of the curve so it is important that the machining side tab 
in the properties is checked to make sure the arrow (which indicates the side to be cut for 
each shape) is pointing toward the other side curve. The arrows do not have to point at each 
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other but they must point at the other side feature.  Although there is no island, so to speak, in 
a side feature, multiple sides will have the same effect. 

 
• Click Finish. 

 
 

• Set the depth at .250 and 
run a 3D Simulation. 

 

 

 

 

Multiple Plunge Point Curve 
 
When machining a part, it is usually more desirable to plunge the tool to depth off of the 
material, wherever possible.  For example, a part with four bosses that needs to have the 
stock removed all the way to the center.  A Boss feature is designed to plunge off the part, but 
somewhere in the tool path it may also plunge into the material to reduce the travel distance. 
However, center cutting end mills, though designed to cut to the center, may find this 
difficult. Because of this, Featurecam defaults to using 50% of feed rate when plunging. 
 
In the Boss feature, under the Milling tab, there is a selection called Plunge Points. 
 
• Open the Plunge Point Curve.fm file.  

Hide all Curves and Geometry.  Double 
click on one of the Bosses in the 
graphics window to open the Boss 
Properties. 
    

• Click on the Rough operation and the 
Milling tab. Select Plunge Point and 
Unset. Now run a 3D simulation.   
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Using a 1.5 diameter end mill, notice how the tool plunges once in the 
middle of the Stock. We can use a curve to force the tool to plunge in 
certain locations instead of the stock. 

 
 

• To create this type of curve, 
pick Point from the geometry 
toolbar. Place multiple point 
locations in the graphics 
window at locations where you 
desire the tool to plunge, as 
shown to the right.  These 
multiple points force the tool to 
plunge only at these four 
locations, not in the stock. 

 
 

 
 
 
• Connect the dots with geometry 

using Connected Lines and then 
chain as an open curve. 

 
 
Note: When you create the curve, be sure to 
notice exactly how it is named.  For 
example: curve1. 
 
 
 
 

 
 
• Open the Boss 

Properties> 
rough>Milling 
tab, and select 
Plunge Points 
then in the New 
Value field type in 
the exact name 
of your curve. 
Example: 
“curve1”. 
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• Click Set, Apply, and OK. 
 
 
 
 
• Run a 3D simulation and notice 

that the rough tool feeds to the 
center, but does not plunge in the 
center.  

 
Note: The curve you create for use in Plunge 
Points must have sharp corners at the desired 
plunge point locations. As seen in the 
exercise, the easiest way to create such a 
curve is to use Connected Lines. 
 
 
 
 
 

Cross Section (X section); Side, Pocket and Boss 
Features. 
When creating Boss, Pocket and Side features there is an option of selecting X section. This 
allows you to apply a shape, other than an angle, to the walls. FeatureCAM will even select a 
ball end mill where necessary. Surface or solid models are NOT required, although the end 
result is similar to a 3D finished surface.  

     Cross Section (X section)  
• Create a new document, Milling, 

and Inches. Select Block and use 
Stock Dimensions (6 x 6 x 6). 
Alternately, you may open the file: 
Cross X Section.fm  

 
• Create a Pocket by drawing a 2.0 

radius circle, centered on top, XY 
plane of the stock.  Click New 
Feature>Pocket From Curve, a 1.0 
Depth and Finish. 

 
• For use in Cross (X Section), draw a 

2.0 radius circle, using Center, 
Radius from the Geometry toolbar. 
Enter X=-2.0 and Y=0, Z=0. Using 
geometry, draw a horizontal and 
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vertical line through the center of this new circle. These lines will be 
used for trimming. Trim the geometry until you have the lower right 
quadrant of the circle remaining as shown to the right.  

 
This arc could be used as the wall shape of the pocket. 

Rules for an X-Section Curve 
 

• When using geometry for your 
cross section shape it does not 
have to be round. It can be other 
shapes as well. 

 
• Once you start drawing away from 

XYZ=0 you may not draw back 
toward the start point in the X or Y 
direction. This would create an 
undercut. 

 
• A straight line in the X or Y is ok 

as long as the end point continues 
away from XY=0. It must also 
remain planar (Z elevation must 
stay at Z = 0).   

 
• By drawing the shape, starting in the illustrated position (XYZ=0), it will 

attach to the top of the pocket and form the pocket walls identical to the 
X-section curve.  

 
• A Boss X-Section is the same, but if there are multiple bosses, and the 

bosses are NOT the same height, X Section can NOT be used.  

 

 

 

 

• Open the file Cross (X) 
Section.fm. You should only see 
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this line and circle, as shown to the right. 
 
  
 
 
• Create a point located at X=3, Y=-3, Z=0.  

 
Using the Geometry toolbar and the Arc menu, create a 3 inch radius arc 

from 2 points, Radius. Click once at XYZ=0 
and click a second time at the point location 
(point that was just created). This will create a 3 
inch arc as illustrated below. 
  
• Click New Feature > Side From Curve. 
 
• Click the line across the middle of the stock 

and add it to the Curves list (depth is not 
important). Finish. 

 
 
 
 
 
 
 
 
 
 
 

• Click the X-Section button and add the arc.  Change the machining side if 
necessary from the Side Control tab.  
 
 

• Run a 3D simulation. 
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Note: It may be necessary to add a short straight extension on the bottom 
end of the X section curve so as to carry the ball end mill flush with the 
stock face.    

          
 

                                             
                                                                     

    2.5D Plunge Milling 
Open a new Milling document. Set the stock as Block, Enter 10 inches for 
Length and Width, and 4” for Thickness. Finish and OK. 
 
Now we will need to create two curves in our new milling document. 
 
With the UCS and Setup on the Top and Lower Left of the part create a 
point at (X.5, Y0, Z0), and a second point at (X9.5, Y0, Z0). Draw a 4.5 inch 
radius, from Geometry by selecting arc from 2 points, Radius and attach 
to the two points.  
 
Important: select the point we created first, then the second point to 
create the arc properly. Chain the arc as an open curve. 

 
This curve is the finish curve, the finished shape, or profile that you desire.   

 
• Open the Curve Wizard. Select 

Curve from curve, Offset. Next. 
 

• Set the Offset value to .500, and to 
the Left. This represents the radius 
of the tool (1.000 dia.) to be used for 
plunging. Finish. 

 
You can add to the offset value, any 
finish allowance if you desire, for an 
additional finish pass. You can do 
this to remove the scallops left by the 
plunge mill tool stepover.   
 
The new curve (the offset curve) is 
going to be the center of the plunge milling cutter and the milling cutter 
will follow this curve.   
 

Note: The Curves created can have any number in their name.    
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In order to get the tool to plunge on the curve in an equal stepover amount we have to use 
SCL Code to achieve this. The following instructions will introduce you to this concept.  
 
• Hold the Control key and Right Click your mouse on the Status Bar at 

the bottom of the FeatureCAM user interface and check the option to 
Enable SCL dialog. 

 
 

 
• Click on Edit  > SCL Code > Check the  All Defines checkbox. 
 
• Copy the bolded code below (minus quotations): 

 
“curve1 = crvsamples( curve2, 0.1, 0.001 )” and paste into the Edit 
SCL Code top  field. 
 

Note: If you fail to check All Defines first you will have to close and reopen 
SCL.  Also know YOUR curve numbers before doing SCL. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

What does this Code Mean? 
 

• Curve 1 in the code is finish curve number, change to whatever YOUR 
finish curve name is. 
 

• Curve 2 in the code is offset curve number (toolpath), change to whatever 
YOUR curve (offset curve) name is. 

 
• 0.1 is stepover for plunges (You may change). 
 
• .001 is tolerance for following Curve 2 (You may change). 
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Click Evaluate and then Close.  
 
 

Important: You may have noticed when you clicked evaluation that the finish curve moved 
to the toolpath curve and became the same size, both curves are now in the second or offset 
position, it kept the original curve number from the first position and that is the curve number 
that must be selected, it may already be in the curve selection window when you click the 
curve button. 

 
                                                                                           

• Create New Feature > Hole and Make 
a pattern from this feature (Points 
Pattern). Next. 
 

• Set Depth 2.0, check Through, and 
Diameter 1.0.   Next. 

 
• Select Points list pattern in the setup 

XY plane. Click Finish 
 

 

 
 
 
 
• Click on the 

Curves… button in 
the Pattern 
Properties dialog 
and select the 
curve you offset 
earlier.  

 
• OK and Apply.        
 

 
 
 
 
         
 
             
                                
• Uncheck Spot Drill 

in the Strategy tab. 
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• Change the tool (matching the offset curve radius) to the appropriate 

milling cutter: Tool Group, pick End Mill, then for Diameter select 1.00 
inch.       
 

 
 
 

• In the Strategy tab of the Hole Feature Properties, check “Combine with 
similar holes into a canned cycle”.  
 

• Apply and OK. 
Note: The canned cycle setting helps reduces the retract distance. It 
will now retract to the plunge clearance value on each plunge cut. 

Grooving     
 
The Groove Feature provides the ability to 
apply grooves to the face with a flat or ball end 
mill, to the side using a side cutting milling 
tool or to perform engraving using a flat end 
mill, ball end mill or a Bevel/pointed tool. 
 
• Create a New File. Stock 

dimensions (6” X 6”, Length and 
Width X 2” Thick). Finish and OK. 
 

• Create a Point (X 1.0, Y 0.0, and Z 
0.0) and another Point at (5.0, 0, 0). 
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• Create an Arc from Radius, 2 Pts.  
Enter a 2 inch radius and select the first point you created, then the 
second. 
 

• Create a New Feature > Groove > From Curve and select the circle. Next 
3 times. 

 
• In the Dimensions dialog, enter the Width .25, Depth 0.2, and check 

Face and Simple (Engrave). Finish and OK. FeatureCAM picks a tool the 
same diameter as the groove width and plunges to the bottom, cuts around 
the circle once, then retracts.  

 
Note: There may be more passes, depending on depth, but there is no 
radial movement of the tool. The walls are cut to size.  

In a Face Simple (Engrave) groove the cutting tool is the same width as the groove and 
makes one pass.  When Simple (Engrave) is unchecked a tool smaller than the width of the 
groove is used, and makes a rough and finish pass. This method is usually used when 
tolerance and finish are more critical.        

           Simple checked                            Simple unchecked 
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An Inside/Outside groove may be created on the outside of the part, or the inside of 
vertical walls using a side-cutting  tool. When the tool is the same width as the groove, 
one rough and one finish pass is made. A single finish pass may also be used. 
 
When the tool is smaller than the width of the groove, the first pass places the center of 
the tool width on the curve, next makes a pass using the top of the cutter to cut the top of the 
groove and next pass using the bottom of the cutter to cut the bottom of the groove, this 
method is usually used when width tolerance and finish is critical.  The geometry and curve 
for the groove must be on vertical walls, outside or inside and the curve may be at the top or 
bottom (radially), remember the opening of the groove is facing out (or in) so when it says 
curve at bottom it means radially of the tool (check box) because that is the depth of the 
groove now and the depth is not measured in the Z direction. 
 
 
 
 
 
                                               

Inside/Outside groove 
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4th Axis Indexing and Wrapping: 

Introduction 
 
In 2.5D milling, 4th axis indexing is standard, and can be accessed when opening a new 
document. The stock wizard allows you to choose 4th Axis, as multi-axis positioning. It can 
be accessed any time in the stock properties under the indexing tab. Your machine must 
have four axis capabilities, and a rotary table, or indexer. Also a 4th axis post processor must 
be loaded in FeatureCAM.   
The part can be indexed around the X,Y or Z axis. The desired axis you wish to index around 
must be selected in the stock wizard (illustrated) while selecting the shape and size of your 
stock.    
 

• The Stock Axis is different from UCS or Setup Axes. It corresponds to 
machine zero, along with the axis of rotation for an indexer or rotary table. 
 
•  The Stock Axis is not normally displayed but to view the stock axis 
click View and select Show/stock axis from the Show menu.  It is 
displayed as two vectors (blue). One shows the axis of rotation (X or Y) 
and the other indicates the orientation of a 0 deg rotation (pointing at the 
spindle). You must align your part center of rotation to the rotation 
axis of the STOCK AXIS. 
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If the Stock Axis is not centered, any features that you will be adding to the part will be out 
of place.   When a block stock is being used the UCS and Stock Axis are many times together 
but not always centered.  
 
 
 
 
 

The Stock axis CANNOT be moved, the stock must be positioned around 
it. 
 
 

• Click on Options then Addins.   
 

• Check the box in front of the Macro called “Center Indexed 
Stock.bas” and a little tool bar appears, usually by the Part View. 

 
• Drag the toolbar to dock it to an 

area next to the one of the other 
toolbars. Click this new button.  

 
• This macro will move and center 

the stock with the Stock Axis.    
 
   
 
 
When a new document is opened, and round is selected, 
the UCS and Stock Axis will be merged and centered on 
the stock.  Now the features can be placed around the 
indexing axis.  The UCS may be moved for Feature creation, if desired.    

       
                           

Stock Axis 

Stock Axis is 
Light Blue in 

color. 
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Caution:  When indexing a part that is not round, FeatureCAM calculates the corners of 
the Stock rotation and retracts a little extra to clear the corners of the stock.  DO NOT use 
Retract to plunge clearance whenever there is a corner present on the part that will rotate 
under the tool, when indexed.  An example of this is when there is a circular bolt pattern on 
more than one face of a block stock. In this case you will index to another face using the 
same tool. After drilling the last hole there must be a retraction to the Z Rapid Plane to clear 
the corners. If Retract to plunge clearance is set the part will hit and break the drill, or worse. 
                 
Once you have completed the prior steps, you may begin creating and placing 
features on your part.  All 2.5D, and 3D, features may be programmed on an 
indexed part. FeatureCAM can index from face to face and cut features, or 
machine a continuously wrapping feature.  Geometry, curves and features are 
applied in the same manner as in any 2.5D part programs. They are placed in 
relationship to the UCS the same way as non-indexed parts.  
 
Wherever the UCS is located, for example the center of the part, the feature 
may be created at Z 0, but must be moved up to the desired Z elevation to 
place it in the proper location.     
 
Features MAY NOT be transformed/rotated/copied around an INDEXING 
AXIS but geometry and curves can. You may also create patterns around 
an indexing axis. On block stock, the part is indexed to the desired face, and 
the features are applied to each face.   
 
 
On the indexing tab you may choose Tool Dominant or Setup Dominant.  Tool Dominant 
does all of the machining on every feature that uses that particular tool before it changes the 
tool, more indexing, less tool changes.  Tool dominant can have just one setup for all of the 
part features.   
Setup Dominant requires a separate setup for each face to be programmed and it completes 
all features for each setup before indexing to the next setup, more tool changes, less 
indexing.  
                
 
                         

• Open a New Document 
and, using one Setup, 
create a Stock (Block) with 
the dimensions, 6 inch 
Length,Width and 
Thickness. Place the UCS 
in the Lower Left corner, 
and material as Aluminum. 
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• Click on the Indexing tab and select 
4th axis positioning, Index Around the 
Stock X axis and Tool Dominant. OK. 
 
 

 
 
 

• Create a New Feature, select hole 
from dimension and Make a pattern 
from this feature.  Next. 

 
 
 
 

• Enter Plain Hole, Diameter and Depth of 1.0 and check Through. 
Click Next 

 
 
 
 
 
• Pick Radial in the Setup XY plane.  
 

 
 

 

• Diameter 4, Number 6, Spacing 
Angle 60, Angle 0.  This creates 
a pattern on one face and will be 
used to create the same pattern 
on the other 3 faces, a pattern 
within a pattern. Next 
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• Location X 3.0, Y3.0, Z 0. Finish  
 
 

 
 
 
 
 
 
 
 
 

                                 
 
 
 
 
 

 
      
 
 

 
• Create a New Feature.  Pattern. Next. 

 
• Use the  pattern just created. Next 

 
 
 
 
 

 

 
 
 

• Select Radial Around the index axis.  
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• Number 4, Spacing Angle 90.  
 

• Finish. 
 
 This places the (6) hole pattern on 
four faces positioned the same as the original pattern.     

           
When you choose to put a different feature on each face this is not a pattern around the 
indexing axis. There are several ways to accomplish this.  
 
Note: Remember you CAN’T transform/rotate/copy features around the indexing axis.   
 
An alternate way is to create a Setup on each face.  For example, on the 6 inch cube stock 
place a Setup on lower left corner of the stock on each face to match Setup1.  When creating 
a new Setup you want the X axis to point in the same direction on ALL setups. If you need to, 
rotate the Setup around the Z axis so the X is pointing the same direction as the Stock Axis 
X. 
 
Let’s create 4 setups, top, front, bottom and back of the part. 
  
 

• Open a New File with the 
Stock dimensions 6” X 6” x 6”, 
and align the UCS and Setup 
on the Top and Lower Left of 
the part. 
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• Click the Setups icon on the Advanced Toolbar.  
 
 
• Click New and Next. 
 
 
 
 
 
• Select Align to Stock  

Face.   
 
• Next. 
 
 
 
 
 
 
 
• Select Front for the 
Stock Face and the little 
hand at LL (lower left). 
 
• Next 

 
 
 
 
 
 
 
 
 
 
 
 
 

Note: If necessary use Z Rotate to align X with Stock Axis X.  
 

• Finish.   
• Repeat the steps for two other faces on the Back and Bottom of the 

part. 
You can now create the feature, or features, as you would normally, (UCS – XY plane) on 
each face.  
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Hint: Keep Setup1 in the isometric view as you create each Setup.  All faces relate to the first 
Setup as to which is Top, Front, Bottom and Back.  This helps to keep the orientation straight 
in your mind. Also, remember that you must have a 
Setup on each face to use Setup Dominant. 
 

 
• Before creating the feature, select the 
Setup first (Setup2 – Front Face) in Part 
View window that belongs to the face that 
you want to apply the feature to. 
 
• Select the Top view, then create the 
features for that setup.  
   
• Select next setup, top view, until all 
features are on all faces.                           

 
 
 
 
Another way is using one setup and creating new features, from dimensions, on multiple the 
faces. There is the ability to specify the Location around the part when Radial about the X 
axis is chosen on the Location dialog.  
 
• Create a New Feature, select Hole 

from dimensions, Plain Hole, 
Diameter and Depth 1.0.  Next.  
 

• On the location page check Radial 
about X axis.   

 
The Radius value is the top of the 
feature. It is measured from the center of 
the Stock Axis in the Z direction and will 
place the top of the feature at the 
specified radius which would be the stock 
face.   
 

• Enter 3 for the Radius, Angle 270. 
 

This places the top of the feature to the desired face around the Indexing Axis.   
 

• Enter 3 in the X Location. 
 

This will position the feature on the face measured from the UCS in the X 
direction. 
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• Enter 0 for the Y shift.   
 

This will position the feature on the face in the Y direction, in this case no shift.  
 
•  Finish. 

             
Another way is when creating new features from a curve using one setup. You need to view 
the XZ plane (Front), so geometry and curves created on the front face can be transformed to 
the back side using the Y direction. This also applies to curves created in the XY plane, top of 
the part that can then be transformed to the bottom using the Z direction.  Once the geometry 
and curves are in place the New Feature can be created and you need only to select the curve 
on any face and FeatureCAM knowing the position around the indexing axis to machine the 
part. 
 
 
 
 
 
 
 
 
 
 
Another way, using one setup, is to create ALL geometry and curves in the XY plane and 
Transform/rotate them around the center point and X axis.  Each feature needs to be 
rotated to the correct face, individually, then create the new features from curves.  
 
Remember you CAN’T rotate FEATURES around an index axis but you can rotate 
geometry and curves).  
                                    
 
 
 
 
 
 
 
 
 
 
 
 
The last way using one setup is when you create a hole pattern in the XY plane (for example 
a bolt circle) and then you need to place it on one other face. In this case, you don’t use a 
pattern from a pattern, because you only need it on one other face, and you can’t 
Transform/Rotate features around the indexing axis.  
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• Open a New File and create 6” X 6” X 
6” Block of Stock.    
 

• New Feature. Hole from dimension 
and Make a Pattern from this 
Feature. Next. 
 

• Create a Plain hole, Diameter and 
Depth 1.0.  Next. 

 
•   Radial in the XY plane. Next.  

 
 
 
 
 
 
 
• Diameter 4, Number 6, Spacing 

Angle 60.  Next.  
 
 
 
 
 
 

 
• In the Location window select Radial about the X axis, Y Shift 0, Radius 

3.0, Angle 270, X Location 3.0.   Finish. 
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Round Stock 
The Stock Axis is in the center of the part and so is the Setup. However, the Setup and UCS 
may be moved for programming purposes.  The same rules apply to round parts as those of 
the block stock parts.  Features CAN’T be Transformed/rotate/copied around the Stock 
Axis.  One setup is commonly used, but other setups may be added if needed.  You may also 
wrap pocket and groove features, including engraving, around the Stock Axis. 
 
To wrap a pocket you must first create the pocket, and if the UCS is at the center of the part, 
you must translate the feature in the Z direction to put the top of the feature at the outer radius 
of the stock.  
 
On a round part the feature can be applied as normal and then wrapped which is selected 
from within the feature.  The “Wrap feature around X axis” check box becomes visible on the 
dimension tab when 4th axis is turned on.  If it is not visible usually two things happen, either 
4th axis is turned off (stock, indexing tab) or the feature was created at the center of the part 
and you failed to move it up to the desired radius on the part, it cannot wrap around the 
center. 
 

Wrapping a Groove 
 
• Open a New Milling 

Document, Inch, Round 
Stock, X axis, OD 12.0, 
Length 12.0 and ID 0. 

 
• On the Indexing Tab select 

4th  
 

• Axis Positioning, and Index 
around the STOCK X Axis. 
 

•  Click on View from the top Menu 
bar. Show > Show Stock Axis.   

 
The Stock Axis and the Setup/UCS are 
together in the center of the part.  
 
The stock and length of the stock are 
aligned with the X axis.  Alternatively, 
open the 4axis wrapping.fm example. 
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Note: When wrapping a groove you must first create the geometry for the grooving feature, 
and it must lie in the XY Plane. 
 
Wrapping a groove is like wrapping a label around a soup can.  The values entered as 
indicated below will start the groove with the center of the tool being on X 0.0 and end on X 
0.0 with no movement in the X direction.  The Y is Pi*12 determines the length of the 
geometry and the part will rotate 360 degrees.  The Z 6.0 puts the top of the groove on the 
outside radius of the stock.  The geometry is the path for the groove but does not create the 
groove.   
 
• From Geometry draw a line from 2 points to the dimensions below.  

Disregard length and angle. 
 

 
 
XYZ 1 sets the start point of the groove tool at the top or radius of the stock centered on the 
end where the Setup X 0.0 is located. Y 0.0 means it starts on 0 in the Y direction. Z 6.0 
means it starts at a 6.0 elevation in the Z direction above the center on the 6 inch radius of the 
stock.  

 
XYZ 2 is the end of the groove geometry and also determines whether it travels in the X and 
how many times it wraps around. X 0.0 - Means the tool will not travel in the X direction.  If 
there is a different value in X then the tool will move to that distance in the X direction as the 
part rotates. Y pi*12 - Means the part will rotate once around the part.  Notice that the value 
is pi*12, this means pi times the diameter which is the circumference of the 12 inch diameter 
stock and FeatureCAM understands what pi means and its value and the *(asterisk) is 
multiplication. Z 6.0 - Means the tool ends at the same Z elevation as when it started. 

• Select New Feature, Groove From Curve and select the line.   
 
• Groove Width .250, Depth .200, Simple (Engrave) and Face. Finish. 

 
• Double click the groove feature in the Part View window. Check the 
“Wrap feature around the X axis”box at the bottom of the dimensions 
tab. Click OK and run a 3D simulation. 
 
The tool plunges to depth, rotates 360 degrees, retracts, and finishes. 
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• Right click on the groove feature in the Part View 

and pick Hide 
Selected. 

 
• Select the Line just 

created to change the 
dimensions. 

 
• Change only the end point (XYZ2) in the X to 

12.0, click Modify, run a 3D simulation.  
 

Now the tool plunges to depth, part rotates once 
around but travels the full length of the part, retract and finished. 

 
 
• Select the Line again. 

 
• Change the end point (XYZ2) Y to 4*pi*12, 

Modify, and run a 3D simulation. 
 

Now the tool plunges to depth, part rotates 4 (4 x 
360 degrees) times around the full length, 
retracts and finished. 

 
 

 
• Select the Line once more. 

 
• Change only the end point (XYZ2) X to 0 and Y to 270/360*pi*12, run a 3D 

simulation. 
 

Now the tool plunges to depth, part rotates 
270 degrees or ¾ of the way around, 
retracts and is finished. 
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Wrapping a Pocket 
 
The Pocket may be created by drawing, or importing geometry, or from dimensions as you 
would normally create this feature. It can be created at the center of the stock and given a 
value in the Location Z direction, while creating the feature so as to place the top of the 
feature on the radius of the stock. 
 
The feature, when completed, may be Transformed/Translated in the Z direction to locate the 
top at the radius of the stock. 
 
The UCS can be translated in the Z direction, to the radius of the stock, and then the feature 
can be created. The feature remains at 0. in the Z Location. 
 
Remember, if the 4th axis is not checked, on the Stock properties Indexing tab, or the 
feature is located down on the center of the part, the “Wrap feature around the indexing 
axis” on the dimension tab will not be visible. 

 
• Open a New Milling Document, Inch, Stock as Round, and X axis. 
 
•  Set the Diameter 12.0, Length 12.0, ID 0. 

 
• Next twice, 4th Axis Positioning, and Index around the Stock X axis. 
 
• Next twice. Rename the Setup, if you choose. Next. 

 
• Use the current location for alignment. Finish and OK. 

 
 
 
• Create a New Feature, Rectangular Pocket from Dimensions.   
 
•  Next. 
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• Enter Length 3.0, Width 5.0, Corner Radius .250, Depth .250. 
 
• Next. 

 
 

• In the Location window enter X4, Y-
2.5, Z6. Finish. 
 

This centers the pocket and places the top of the feature at the outside radius 
of the stock.    

 
• Double click the rectangular pocket feature in the Part View window. On 
the Dimension tab check the box “Wrap Feature around X axis”.  
 
Note: If it’s not visible, either the 4th axis is off, or the feature is at the 
center of the stock. 
 

• Click Apply and OK.  Run a 3D simulation. 
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Wrapping a drilled hole pattern 
 
• Open a New Milling Document, Inch, Stock as Round, X axis. 

 
• Enter Diameter 12.0, Length 12.0, ID 0. Next twice. 

 
•  4th axis Positioning, and Around STOCK X axis. Next. Set it to Tool 

Dominant. Next twice, Use current location.   Finish.  
 

 
 
 
 
• Create a New Feature, Hole 

From Dimensions and Make a 
pattern from this feature.   Next.  
 
 
 
 

• Plain Hole, Diameter 1.0, Depth 
1.0.  
 

• Next. 
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• Radial in the setup XY plane.   
 
• Next. 
 
 
• Diameter 10.0, Number 9, Spacing 

Angle 40, Angle 0.  Next.  
 
 
 

 
 
  
 
• Set the Locations at X 6.0, Y 0, Z 

6.0. 
 

• Finish.  
 
 
 
 
 
 

 
 

• Double click the hole 
feature under the Pattern 
from the Part View window 
and check “Wrap Feature 
around X axis” OK. 
 

• Run a 3D simulation.  
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The wrapping keeps the point of the drill lined up with the centerline of the part. 

Wrapped Engraving 
 
Engraving around a cylinder can be accomplished, by first creating the text, and then 
applying a grooving feature to the text curve. 
 
 
 

• Open a New Milling 
Document. Inch, Round 
Stock, X axis. 
 

• Diameter 12.0, Length 
12.0, ID 0.  
 

• Next twice. 
 

•  4th axis Positioning, 
and Around STOCK X 
axis. 
 
 
 

•  Click on View from the Menu bar at the top. Show, Show STOCK 
Axis to make sure the Stock Axis and the Setup are aligned and 
centered on the part. 
 

 
Change to a Top view, Select 
Construct, Curve, Curve 
Wizard. 
 
 
 
• Select Other Methods and 

Text. Next.  
 
 
 
 

 
• In the Text field type DELCAM, click the Font button, select Machine Tool 

San Serif from the list, and Size 72.   OK. 
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• Select Linear, Location of X 3, Y0, Z 6, Angle -90 and Justification 
Center. Finish. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This will move the text to the outside radius of the 
Stock. It will also rotate and center it to the proper 
alignment position.  
 
 
 
 

 
 
• Create a New Feature, 

Groove From Curve.  
 
• Next. 
 
• Select the text curve (all 

letters are one curve).  
 
• Next twice.  
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• Enter Width .0625, Depth .02, 
Simple (Engrave), and Face. 
 

• Finish.  
 
 
 
 
 
 
 

 
 
 
 
 
• Double click the groove from 

the Part View window. 
 
• On the Dimension Tab, check 

“Wrap feature around X 
axis”. Apply and OK. 

 
 
 
 
 

 
 

 
• Run 3D simulation.   
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Form Tools 
Introduction   
 
In this module the user will learn how to create Form Tools for milling with end mills and 
side cutting milling cutters and also for drilling.   These tools may be used in Milling and 
Turn/MILL.  At the end of the module the user will be able to draw the geometry for the 
shape of the tool and chain a curve to that shape for FeatureCAM to use to create a new tool 
in the tool crib and save it in a Tool Group called Form Tools that can be recalled anytime. 
 
 
 

 
 
 
 
 
 
 
 
 

 
 
 

Create a Dovetail Milling Form Tool 
 
• Open a New Milling Document, inch or 

Dovetail Form Tool.fm for reference. 
• Create Stock size 6x6x6, any material, 

no 4th axis.  Viewing from the top, 
Locate the UCS in Lower Left Hand 
corner of stock.   

•  Right Click in graphics window and 
View from the front.  The XZ plane. 

 
 
 
 
It is very important that the STOCK AXIS is 
located at XYZ 0.  If this is omitted, the curve will 
not be accessible when creating the form tool.  
 
• To view the STOCK AXIS Click View in top toolbar>Show>Show STOCK 

AXIS. 
Another set of arrows (blue) will show up in the graphics window merged with the UCS. 
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The Z0 will be the bottom of the Dovetail tool.  The X0 is the 
center of the tool and only half (radius) of the tool will be created 
(+ side of X).  The finish curve will be an open curve. 
 
 
• Using the Geometry constructors Draw this shape 

and chain an open curve. (no centerline) 
 
 

 
 
 
 
 
 

 
• Click on Manufacturing on top toolbar and Select Tool Manager. 

 
• Select “From Crib” 

Tools. 
• ”Tool Group” End 

Mill. 
• “Current Crib” 

Tools. 
• “Sort by” Diameter. 
• “Show only” 

Diameter. 
• “= 2” Press Enter.  

This takes you to 
the 2 inch diameter 
end mills.    OK. 

• Double Click on a 
2 inch tool in the 
current list. 

 
 
 
 
The 2” inch diameter end mill was 
chosen because our Dovetail tool is 2 
inches.  
 
When you specify the shape of a tool 
with a curve, many of the dimensions 
normally entered for a tool are no 
longer used, but the diameter 
dimension is still critical for milling 

UCS = XYZ 0 and STOCK AXIS 0 
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operations. The diameter is still used for calculating stepovers and generating the paths. 
 
 
 
• Change the Name to “Dovetail 

2.0 x 45” 
• Check “Use curve to describe 

tool shape” and Click on the 
curve in the drop down list.    
OK. 

 
 
 
Remember if the curve is not in the 
drop down then you either do not have 
the STOCK AXIS at the XYZ0 or the 
curve does not start at XYZ0.  

 
The New Tool shape appears in the window.  Be sure to make any necessary changes such as 
“Cutting type”, “Material”, etc. 
 
This only creates the tool; you must now create geometry and a groove feature. 

 
 
 

 
• Viewing from the top, draw 

a line across the center of 
stock.  Extend the line 1.100 
inches beyond each side of 
the stock so the tool will 
plunge off the material and 
retract when it’s clear at the 
end of the cut. 

 

 
 
 
 
• Click on New Feature and Select 

“Groove from curve”, Select geometry 
line and Enter Width 2 inches.  Simple 
(engrave).  Depth of .75.    Finish and 
edit properties. 
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• Click on slot 

operation and 
Tools tab and 
from Tool 
Group Select 
Form Tools.  
Check the box 
in front of 
Dovetail.    OK. 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
 

• Run 3D Simulation 
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Create a Side Milling Form Tool 
 

• Open a New Milling Document, inch or Side 
Milling Form Tool.fm for reference. 

• Create Stock size 6x6x6, any material, no 4th 
axis.  Viewing from the top, Locate the UCS in 
Lower Left Hand corner of stock.   

•  Right Click in graphics window and View 
from the front.  The XZ plane. 

• Using the Geometry constructors Draw this 
shape and chain an open curve. (no 
centerline)   

 
 
 

 
• Viewing from the front 

draw a line from 2 points at 
X0, Y0, Z -.4375 across the 
front face for the groove. 

• Repeat the Groove from 
curve feature but instead 
select Inside/Outside with a 
Depth of .125 and a Width 
of .625.   Finish. 

• Click on Rough operation 
and Tool tab.  From the list 
of Side Mills Select a 
KEYSEAT cutter then Click 

on the new tool button . 
• Change the name to Side 

Milling Form Tool 2.25D x 
(2).125r. 

• Change Diameter to 2.250.  
Change the Cutter width to .625.  
Check “Use curve to describe tool 
shape” and Click on this new 
curve in the drop down list as 
before.    OK. 

• Click on Finish and Tool tab and 
Tool Group Form Tools.  Check 
the same tool as for the rougher.   
OK and Run 3D Simulation. 

 
The Tool makes a Rough and Finish pass. 

UCS = XYZ 0 and STOCK AXIS 0 
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Create a Drilling Form Tool 
 

• Open a New Milling Document, inch or Drilling Form Tool.fm for 
reference. 

• Create Stock size 6x6x6, any material, no 4th axis.  Viewing from the top, 
Locate the UCS in Lower Left Hand corner of stock.   

• Right Click in graphics window and View from the front.  The XZ plane. 
• Using the Geometry constructors Draw shape from the dimensions shown 

on the next page and chain an open curve. (no centerline)   
• Click on New Feature Wizard and Select Hole from Dimensions.    Next. 
• Select Plain Hole.  2.0 Diameter.  2.25 Depth.  No Chamfer.  Uncheck 

Through.    Next.  
• Enter X3, Y0, Z0 for Location.    Next.  
• Uncheck Spot Drill.    Next and Next. 
• Default Tool Select “I want to Search for another tool or make new one”.    

Next. 
• Tool Group Select Twist Drill and Diameter 2.0.  Click “Create New Tool 

button”  and Change Cutter Length to 3.0, Overall Length to 5.0 and 
Exposed Length to 4.0.  Check “Use curve to describe tool shape” then 
Select the curve.  Re-Name “Drill Form Tool 2.0” and Apply. 

• Check Create New Tool when asked in Rename Tool popup.    OK and 
accept as override.  Finish. 

• Run 3D Simulation.  You can see the cross section. 
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Multiple Fixture Documents 
Introduction 
 
FeatureCAM allows the user to program multiple parts or multiple instances of the same part 
within a single part called a Multiple Fixture (mf) document.  These documents are for 
milling parts that have already been created and saved in individual fm files.  The parts can 
be arranged relative to a single Setup, or they can each have their own individual fixture 
positions.  They can also be machined from a single stock model or from individual stock 
pieces. 
 
Since complete parts are loaded into Multiple Fixture documents, they cannot be edited 
within the Multiple Fixture environment.  They must be changed in the fm files and then 
manually reloaded into the mf file. 
 
This chapter will describe the process for loading parts into Multiple Fixture documents. 

Getting Started 
In order to begin programming a part, the Multiple Fixture option must be selected from the 
New Part Document wizard. 
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Multiple Fixture Interface 
The user interface for Multiple Fixtures is slightly different from the typical fm file.  You will 
notice that many functions are dimmed or completely unavailable.  Again, this is because the 
purpose of the Multiple Fixture document is to collect and arrange multiple parts into a single 
file – it is not for creating features of any type or making changes to existing parts.  So, any 
functions related to creating toolpath will not be available. 

Steps 
The Steps mode of the Toolbox is open by default (Part View is not available at any time), 
and it is quite simple.  The only entries that are unique to the mf file are Fixture ID and Parts.  
The rest of the options operate exactly as they do in any other FeatureCAM file. 

Fixture ID 
The Fixture ID step allows the user to define and locate established fixture locations.  Those 
locations can later be used to anchor single or multiple parts. 

Parts 
The Parts step is the Wizard that is used to build and edit the part layout.  It allows the user to 
add, delete, and edit all of the part configurations in the file.  Remember, the parts themselves 
cannot be edited in the Multiple Fixture environment.  We will discuss making changes later 
on in this chapter. 
 
The following examples will examine how Multiple Fixture files can be programmed: 

Example 1 - Multiple Parts as Separate Blocks 
For this example, we will use the Caliper part that is found in the FeatureCAM Examples 
folder.  This part has two setups – a top setup and a bottom setup.  We will use this to create a 
row of tops and a row of bottoms.  This will depict a scenario where you have parts that you 
are rotating through fixtures on the machine.  For each cycle, you will be adding a set of 
material blanks and removing a set of complete parts. 
 
The first step for creating a Multiple Fixture file is to add parts that you want to machine to 
the Parts List. 
 
• Make sure the 

Parts step is 
active, and select 
Parts List from the 
buttons along the 
right edge of the 
dialog box 
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• When the 

Part Files 
window 
opens, click 
Browse and 
navigate to 
the Data 
folder 

• Open 
Caliper.fm.  
 

• Click OK and 
Add 

 
 
As stated earlier, the 
Caliper part has two setups, 
and we will be machining 
both in this example.  First, 
we will start with a row of 
Top setup parts. 
  
• Click the top setup 
 
Notice that there is also a 
field where you can name 
the Multiple Fixture file.  
This is the name that will 
appear in the NC code, if 
desired. 
 
 
The next screen allows the 
user to select a starting 
offset for the parts.  Since 
we will be cutting our parts 
from separate fixture offsets 
in this example, this dialog 
will determine the beginning 
offset, and other offsets will 
be added incrementally as 
we add parts. 
 
• Accept 54 as the 

initial offset by 
clicking Next 
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The next screen in the wizard defines how this part will be arranged.  The XYZ location is 
the position of the first setup, and the other boxes determine the number and spacing of the 
repeats.  Since these are repeats, a value of 3 will give us 4 instances.  FeatureCAM fills in 
the spacing automatically by adding a set distance to the part’s stock size, but this can be 
overridden to any value the user wants.  Note: When using separate blocks of stock, the 
spacing is for simulation purposes only.  The actual offset positions will have to be 
determined at the machine and entered into the control registers. 
 
• Fill out the 

Configuration 
dialog box as 
shown 

• Click Next 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Select 

Individual 
Blocks and 
click Next 
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At this point, we have completed the layout of the first set of parts.  The Preview dialog 
appears.  You can drag this window aside to inspect the part placement. If you want to make 
any changes, click Back to revisit the wizard screens. 
 
• Click Finish 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once you have clicked Finish, the Multiple Fixture screen reappears showing you all of the 
parts and offsets in the file. 
 
The parts in the Multiple Fixture file can be machined two different ways: 

Tool Dominant – Each tool cuts all of the part instances before changing to the next 
tool. 
Part Dominant – Each part is cut completely before proceeding to the next part.  
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• Click OK to exit the Multiple Fixtures window 
• Run a simulation

 
 
Next, we will add another set of parts to the file. 
 
• Clear the Simulation Results 
• Click on the Parts step to reopen the Multiple Fixtures window 
• Click Add 
 
This time, we will add some Bottom setups to our layout. 
 
• Select the 

CALIPER/bottom 
setup 

• Click Next 
 
 
 
 
 
 
 
 
 
 
 
 
Notice how the Fixture IDs have picked up where we left off at G58.  Of course, this can be 
overridden, but we will keep the default value 
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• Click Next 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
On the configuration screen we have an opportunity to locate our next setup and determine 
the repeats and the spacing of the new part. 
 
• Enter X0, Y6, 

Z0 as the 
position of the 
next setup 

• Enter 3 X 
Repeats with 
a spacing of 8 
inches 

• Click Next 
 
• On the Layout 

screen, select 
Individual 
Blocks 

 
• Click Next 
 
• Examine the Preview and click Finish 

 
Again, we see the summary of our efforts detailed on the Multiple Fixture screen.  The setup 
IDs are based on the available registers in the post processor. 
 
• Click OK to exit 
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• Run a Simulation

 
 
 
• Close the part 
 
 
 

Example 2 - Multiple Parts out of a Single Block of Material 
In this exercise, we will create an array of parts that are cut out of a single block of material. 
 
• Open a new Multiple Fixture file 
• In the Multiple Fixture window (Parts Step) click on the Parts List button 
• Browse to the Caliper.fm part in the Data folder 
• Click OK to accept the Caliper and return to the Multiple Fixtures window 
• Click Add 
• Choose CALIPER/top from the available setups and click Next 
 
Since we are going to machine all of these parts from a single block of material, there will 
only be one fixture offset used. 
 
• Accept the default Fixture ID by clicking Next 
 
We are going to lay out two rows of parts in this example.  To do this, we will enter values 
for both the X and Y repeats.  In this situation, spacing will also be critical since we must 
allow room for the tooling to move between parts without gouging. 
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• Fill out the 
Configuration 
screen exactly 
as shown 

• Click Next 
 
 
 
 
 
 
 
 
 
 
• Select Single 

Block on the 
Layout page 

 
When you chose a 
single block, 
FeatureCAM gives 
you an opportunity to 
nest the parts by 
inverting alternating 
instances of the part. 
 
• Check the 

Nested box 
and click Next 

  
 
Now, the stock size 
must be determined.  
The user has a choice 
to enter the stock size 
manually or let 
FeatureCAM 
automatically 
calculate the required 
stock size. 
 
• Click Auto to 

let 
FeatureCAM 
calculate the 
stock size 
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• Click Next to advance to the Preview page 
• Click Finish to exit the wizard 
• Click OK to close the Multiple Fixtures window and view the results 

 
As you can see from the results, the spacing of our nesting is incorrect.  This was visible from 
the preview page, but this will demonstrate how Multiple Fixture layouts can be edited after 
the fact. 
 

.  
 
• Click on Parts in the Steps window to reopen the Multiple Fixtures window 
• Highlight the setup and click Edit 
 
The Edit function will open the properties of our layout and give us access to all of its 
parameters. 
 
• Click on the 

Layout tab 
• Change the 

spacing of 
the nest as 
shown 

• Click OK to 
exit 

• Run a 
simulation to 
see the 
results 
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• Close the part 

 

Example 3 - Multiple Parts Located on Predefined Fixture IDs 
The next example will demonstrate how to create predefined Fixture IDs and locate parts on 
them.  Keep in mind that the locations for the setups do not automatically translate to the 
machine tool.  Each fixture ID location must be determined at the machine and entered into 
the control. 
 
• Open a new Multiple Fixture file 
• Click the Fixtures button in the Multiple Fixtures box (Note: This is the 

same as clicking Fixtures in the Steps view) 
 
 
• Click the 

Add button 
to begin 
defining a 
new fixture 
location 
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• Accept 54 as 

the first fixture 
location by 
clicking Next 
 
 
 
 
 
 
 
 
 
 

• Accept 0,0,0 as 
the location for 
offset 54 by 
clicking Finish 

 
 
 
 
 
 
 
 
 
 
 
Below, you see that Fixture ID 54 has now been defined and is ready to be used.  Before we 
start adding parts to this file, we will create a second setup location. 
 
• Click Add to 

create 
another 
Fixture ID 
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• Accept 55 as the next Fixture ID by clicking Next 
 

• Enter the 
location of this 
Fixture ID as 
shown and click 
Finish 

 
 
 
 
 
 
 
 
 

 
• Click OK to exit the Fixture Offset Locations screen and return to the 

Multiple Fixtures window 
• Click on the Parts List button an Browse to the Caliper.fm file in the Data 

folder 
• Click OK 
• Click Add 
• On the Setup screen, select the CALIPER/top setup and click Next 
 
Now that we have predefined fixture locations, we are given the opportunity to select them as 
locations for out parts. 
 
• On the Fixtures 

screen, select 
Add the new 
setups to a 
predefined 
fixture and 
verify that 54 is 
selected 

• Click Next 
 
 
 
 
 
 
 
Notice on the Configurations screen that you still have the opportunity to offset the part 
origin from the Fixture ID, and you are able to create both X and Y repeats from that 
location. 
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• Accept the default offset (0,0,0) and make sure the there are 0 X repeats 

and 0 Y repeats 
• Click Next 
• Click Finish to accept the single part located at Fixture ID 54 and return to 

the Multiple Fixtures window 
 
For the next step, we will bring an entirely different part to locate at Fixture ID 55. 
 
• Click Parts List 
• Click Browse 
• Select the plate.fm file located in the Data folder and click Open 
• Click OK to return to the Multiple Fixtures window 
• Click Add 
 
• Select 

plate/WORLD 
from the 
Part/Setup list 

• Click Next 
 
 
 
 
 
 
 
 
 
 
 
 
• On the Fixtures screen, select Add the new setups to a predefined 

fixture and select 55 from the drop-down list 
• Click Next 
 
• Accept the default offset (0,0,0) and make sure the there are 0 X repeats 

and 0 Y repeats 
• Click Next 
 
• Click Finish to accept the single part located at Fixture ID 54 and return to 

the Multiple Fixtures window 
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• Click OK and run a simulation 
 

 
 
• Keep this part open for the next section!!! 
 
 

Example 4 – Making Changes 
As mentioned earlier, there are very few changes that can be made to files programmed in a 
Multiple Fixture document.  As we have seen, layouts can be modified by accessing the Parts 
step, but many of the other functions normally available in an fm file are dimmed.  This final 
example will show how modified parts are handled in a Multiple Fixture file. 
 
For this example, we will modify the plate.fm file. 
 
• Making sure not to close the mf file, click File > Open, and open the 

plate.fm file located in the Data folder 
 
We will make a very simple change and see how the mf document is affected. 
 
• Turn off the pocket feature by unchecking the 

pp1_pocket feature in the Part View 
• Save and Close the file 
• Once back in the mf document, run a simulation 
 
Nothing has appeared to have changed, has it?  There is one more 
step that must be performed in order for the part to be updated in the 
Multiple Fixture document. 
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• Clear the simulation 
• Click on the Parts step in the Steps view to open the Multiple Fixtures 

window 
• Click the 

Parts List 
button 

• Highlight 
the 
plate.fm 
file and 
click the 
Reload 
button 

 
 
 
 
 
• Click OK to return to the Multiple Fixtures window 
• Click OK to exit 
• Run a simulation 

 
 

This is the procedure that will be required every time a change is made to how the individual 
part is machined.  None of the parameters controlling Attributes, Tooling, etc. can be edited 
from the Multiple Fixture document, so the original part file must be opened, edited, and 
reloaded into the mf file. 
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FeatureRECOGNITION for 
Milling 

Introduction 
This Module will provide an introduction to FeatureCAM’s Feature Recognition capabilities.  
When this module is complete you will know how to perform Automatic Feature 
Recognition, Interactive Feature Recognition and Feature Re-recognition. 
 

 

 

 

 

 

 

What is a Feature? 
Features are the intelligent core entities that a machinist would use to make a certain shape in 
the material they are cutting.  Shapes such as a hole, boss, slot, etc…Features are used to 
make toolpaths in FeatureCAM to create these shapes.  Features may consist of several 
operations to create the final result or shape.  These may consist of several operations 
including; spot drill, center drill, drill, pre-drill, tap, roughing, semi-finish and finish passes. 
FeatureCAM takes, for example, a tapped hole and combines the operations like the center 
drill, drill and tap and automatically selects the necessary tooling, feeds, speeds, etc. 

What is Feature Recognition. Why is it necessary? 
 
Feature Recognition is the ability to extract manufacturing features and associated operations 
from an existing Solid or Surface model.  Geometry, curves, and dimensional input are not 
required as this information is automatically extracted out of the design model. 
 
Feature Recognition is necessary for several reasons, the first being that the CAD data 
available is just a collection of surfaces and faces.  The CAD data (surfaces and faces) needs 
to be interpreted by the CAM software so useful features and subsequent operations may be  
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collected from this data to manufacture a part.  For example holes in a solid are just cylinders 
and a pocket in a solid is just a collection of faces. 
 
The second reason Feature Recognition is necessary is that in modern manufacturing a 
majority of the design software used for part design is solid or surface based.  The valuable 
information contained in the model file has already been entered by the CAD engineer, why 
should the machinist re-enter information that is already available in the model?  A review of 
the manual process is listed below, which can show the process to be quite lengthy: 
 

1. Create Geometry 
2. Create Curves 
3. Select Feature Type 
4. Select Curve 
5. Specify Depth 
6. Enter manufacturing information 
7. Obtain wireframe visual display 
8. Obtain F/S, tools, toolpaths and NC code 

 
The third reason FeatureRECOGNITION is necessary is that re-entering the model data by 
the machinist is error prone as the model information needs to be completely re-entered. 

How does FeatureRECOGNITION Work? 
 
There are two different types of FR: Automatic Feature Recognition (AFR) and Interactive 
Feature Recognition (IFR).  Both tools search the CAD data (cylinders, surfaces, and faces) 
and matches them to FeatureCAM’s features so manufacturing operations may be generated.  
These two techniques use different algorithms for identifying features.  Descriptions of the 
algorithms used will be described below. 
 

Requirements for FR 
 
In order to use Feature Recognition a surface or Solid Model is required.  There is a wide 
variety of Import formats supported: 
 

• Iges, Acis, Parasolid, SolidWorks, Inventor, SolidEdge 
• Optional import plugins: Catia V4 & V5, Step, Unigraphics and ProE 

 
There are several ways that the model can be imported directly into FeatureCAM: 

• Click on File then Open. 
• Click on File then Import. 
• Locate the file, left click on the file to import, hold the left mouse 

button down then drag and drop the file into FeatureCAM’s Graphics 
Window from any folder where the model resides (except a zip folder). 
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Import Wizard 
 
When you import a file, FeatureCAM steps you through its import wizard.  The import 
wizard pops up automatically and assists you in importing the file into FeatureCAM.  This 
wizard helps to: 

1. Import the file into FeatureCAM 
2. Size the stock 
3. Orient the stock 
4. Position the part program zero 
5. Set up a milling part for indexing 
6. For some solid file formats, it even helps you recognize and suppress some part 

features 
 

AFR Example #1 
 
• Click on File then 

Open.  Under Files of 
type at the bottom of 
the screen select 
ParaSolid (*.x_t, *.x_b).  
Find the file in the 
FeatureRECOGNITION 
Data folder named 
ex02ex02.x_t then 
press the open button. 
 
 
 

 
 
 
• If asked, select Scale the imported 

geometry into the document’s 
units. 

  
• Select Milling Setup and select the 

Unit of Measure to be Inch then press 
OK.  
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• Select the button “Use the wizard to 

establish the initial setup location 
and stock size” then check the 
“Launch AFR after finish” checkbox.    
Next 
 
 
 

To aid in aligning the model, when the model is 
first brought into the Graphics Window, right 
click and view Top or Isometric and Shade the 
model so you can see how it is positioned in the 
window. (Shade-upper tool bar-button with two 

little red barrels)  
 
 

 
 
Because the CAD model may have been saved 
in a position that is not aligned with your Z and 
X axis, FeatureCAM in the “Pick Initial setup 
Z Direction” form provides five tools to assist 
in aligning the model to your document in the Z 
direction, which in turn aligns to the machine 
spindle, table and axis. 
 
• 1) Pick two 

points to define Z 
direction.  Click 
on arrow then 
click twice on a 
vertical surface 
edge starting low, 
then the second 
click above will 
point to the spindle. 

 
• 2) Align Z perpendicular to a horizontal surface.  Click on any known face 

that is flat and horizontal that you wish to be perpendicular to the spindle. 
 

• 3) Align with center of a revolved surface such as a hole by selecting the 
arrow and clicking on the round surface. 

 
• 4&5) can be used even when geometry alone is imported by clicking on 

the defined geometry.     Next.  
 



FeatureCAM 2012                                                             FeatureRECOGNITION for Milling 
                                                               

                                                                          
FeatureRECOGNITION for Milling 2012                                    5 

“Pick Initial Setup X Orientation” 
offers assistance to align the setups X 
direction.  The instructions below does 
not rotate the part, you must do a top 
or isometric view for the model to 
move. 
 
1)  Pick two points to define X direction 
works the same as the Z, except the 
edge you click on will be parallel to the 
table. 
 
2)  Rotate X direction 90 degrees 
around Z axis will rotate the model 90 
degrees for each click, three times will 

rotate 270 degrees.     Next.  
 

Stock type gives you the choice of Block, Round or N-Sided such as hex stock. 
 
 
• On the Stock Dimensions 

page check the radio button, 
“Compute stock size from the 
dimensions of the part”.  Enter 
0 in all dimension boxes.  
Additional stock may be added 
on all sides.    Next. 

 
 
 
 
 
 
 

 
     

• On the “Pick Initial Setup XYZ 
Location” form (Part program 0) select 
LL (lower left from top view).  You can 
also use the pick arrow and click on a 
location, use the center of a revolved 
surface or enter the XYZ location 
measured from the UCS.    Next.                                                                                                                                                                                                                                                                                                                                                                                  
 

• No 4 axis Indexing.    Finish. 
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Because the “Launch 
AFR after finish” box 
was checked on the 
initial Import form, the 
Automatic Feature 
Recognition pops up. 
  
It identifies the solid just 
imported. 
 
• Click the Verify 

button to assure 
you have a good 
Solid Model.  
(AFR does not work with Surface Models)  

 
• Click the Options button.   

o Create a facing feature. 
o Combine like holes into a 

pattern. 
o When checked, Bottom 

radius suppression will 
recognize bottom radiuses 
and when unchecked it 
skips them and leaves 
material there instead. 

o Maximum Hole diameter 
value is the largest hole 
AFR will create with a drill, 
anything larger uses an 
endmill.  

 
(Disregard 3D for now) 
 

• Click OK for Options.    Next.   
• Setups can recognize multiple setups.    Next. 
• Select features will allow you to accept all or pick and 

choose.    Finish. 
• Run the 3D simulation.  

  
 

ALL features, tooling, feeds, speeds, coolant, depth of cut and 
stepovers, etc, have been created for the entire part in this setup and 
looks like the finished part illustrated. 
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• Click on File then Save as and name the file ex02ex02.fm 
 

Types of FR Available 
 
There are four types of FR available: 

1. Fully automatic – “AFR” as in the previous example,  
2. IFR Automatic by feature type,  
3. IFR using surfaces or faces 
4. IFR chaining.   

 
Each of these is a different tool used increase the programming options available to you.  
Each technique has its own benefits and disadvantages.  
 

AFR    (Automatic Feature Recognition) 
• Open the file saved previously ex02ex02.fm. 
• In the Part View right-click on and delete the 

single face feature and all of the holes in 
setup1. 
 

 
 
The reason all the face features and holes are deleted is so 
we can easily see all the side features that AFR created to 
cut the part.  In order to completely cut the part (excluding 
face feature and holes) AFR uses side features.  For 
Bosses, pockets and sides, AFR always uses side 
features. 
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• On the top tool bar, if the model is not already shaded, shade the part 

by clicking on the shading icon (two little red barrels).  
• Right-click in the Graphics Window and select isometric. 

 
 
 
 
 
 
 
 

• Click on each of 
the side features in 
part view one by 
one 
 
 
 
 
 
 
 
 
 
 

 
o Notice that it creates a set of features that will completely cut the solid, but it may 

create more features than you might create if you have modeled the features yourself. 
 

o The way AFR works is that it examines the model and looks for any flats on the part.  
It creates features by dividing the model into horizontal slices at these flats and 
automatically determines side control.  Any features (excluding holes) remaining will 
be cut using surface milling. 

 
o The advantage of this method is that a part may be programmed quickly as it requires 

minimal user input.  This method could be useful for quickly programming 
prototypes, or to help users new to programming in FeatureCAM.  It can also be used 
by experienced users to create curves or to help get a better idea on how to cut the 
part. 

 
o The disadvantage of this method is that the most efficient toolpath may not be created 

and the features created may not be exactly the way the programmer is used to cutting 
the part. 

 
o One last note is that a solid is required to run AFR.  The reason for this is so that AFR 

is able to properly recognize side control and will cut on the correct side of the part. 
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AFR Example #2 
 

• Browse to the 
FeatureRECOGNITION Data 
folder, locate the file named 
EndPlate.x_t then left-click 
and drag into FeatureCAM. 

 
• Select Milling Setup and 

Inch Units then press OK. 
 
• Select the top radio button 

then check “Launch AFR 
after finish” then follow the 
same import procedure as 
the previous part. 

 
 

 
• On the AFR Options page 

the Maximum hole diameter 
is set at 1 inch so the through 
hole in the part will be 
machined with an endmill.  If 
you also check the Create 3D 
feature check box 
FeatureCAM will apply a ball 
endmill to the chamfers. (FR 
does not do chamfers and you 
must be licensed for 3D 
surface milling). Do NOT 
select 3D now.  Click OK. 
 

• Run the 3D simulation. 
 

The chamfers on this model are standard 2.5D features and first require a curve, three in all.  
A curve can easily be created by projecting (ALL surfaces) geometry in the Z direction, this 
will include the shape required and will be located at the proper Z elevation you choose. 
During this process a curve can quickly be chained on only the geometry you need then all 
geometry is automatically deleted when curve chaining is complete leaving only the curve 
required for the feature.  Multiple curves may be created by clicking the create button after 
each curve.  If all curves are created at the same elevation in Z, any curve when selected may 
be transformed to the correct elevation. 



FeatureCAM 2012                                                            FeatureRECOGNITION for Milling 
                         

10 FeatureRECOGNITION for Milling 2012  

 
 
 
 
 
 

• Click on Curves from 
the Steps Toolbox, Click 
“Chain projections of 
vertical surfaces into 
curves using mouse 
clicks”. 

  
 
 
 
 
 
 
• The wall angle can be acquired by clicking on the Blue Words “Wall 

Angle” and then click twice on an isoline along the vertical edge of a 
surface as illustrated.   
 
 

• Click on the “Blue Word” Elevation and then click once on any surface or 
edge that is the Z Elevation or height you desire.  Chamfer curves must be 
at the top of the chamfer.    Next.  
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• Select “All 
Surfaces” and 
check the box 
“Remove 
hidden lines 
on solids”. 
Next. 

 
 
 
 
 
 
 
 
 
 
 

• Select “Remove 
after Chaining”. 

     Finish. 
 
The cursor now changes to 
the mode for chaining 
curves.  Chain the desired 
geometry for the shape 
and elevation required for 
the chamfer curve.  
Geometry is deleted when 
the select arrow is clicked 
canceling curve chaining.  
A Chamfer Feature can 
now be created for each 
curve. 
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• To determine the size of the chamfer from the model, view from the front 

then use Interrogation.  The Interrogation button may be obtained by 
clicking on View>Toolbars>Command tab>Geometry.  Left click on the 
little icon with the yellow question mark then drag it and place in the tool 
bar docking area. 

 
 
 
 
• With Distance, Z, and 

UCS selected use the 
arrow button and click 
on the top edge of the 
surface and the 
bottom edge to 
measure the distance 
in Z, this dimension is 
used for the height in 
the chamfer feature. 

 
 
 
 
• To determine the width, view from the top and using Distance, 2D, and 

UCS click on each end of any isoline on the chamfer faces as shown for 
the width of the chamfer.  If they are equal you of course have a 45 degree 
angle but if they are not remember this is a formed chamfer with a tapered 
tool and your tool crib may not have that angle tool, it will have to be 
created and purchased or ground to the taper.  
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• Create a 2.5D chamfer, no Recognition and use the .0394 dimensions for 
both the height and width for each of the three chamfers. 
 

 

AFR Example #3    (Feature Re-recognition) 
 
 

• From the file menu click on File 
then Open.  From the files of type 
pull down menu select ParaSolids 
(*.x_t,*.x_b).  Select the file named 
“Original file - before.x_t” then 
press the Open button. 
 

• In the New Part Document window 
select milling setup, inches then 
press OK. 
 
 

• On the Import Results screen 
select the top radio button and 
check the Launch AFR after finish 
checkbox then press Next four 
times. 
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• On the Stock Dimensions 
page check Compute stock 
size from the size of the 
part then press Finish.  
 
 
 
 
 
 
 
• On the Automatic 

Feature Recognition press Next then 
Finish. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
Feature recognition completes 
the part by identifying all the 
features in the setup. 
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The next step is to 
import the similar 
solid model that has 
been revised into 
the same document 
as the first and 
perform  Feature 
Re-Recognition. 
 
• From the file 

menu click on 
File then 
Import.  
Select the file 
named 
“Original file - after.x_t” then press Open. 

 
Upon closer examination there should be a noticeable difference between the two solids.   
Some holes are removed and in a different location, as well as the depth and dimensions of 
the side and pocket features recognized using AFR. 
 

 
• On the Import Results window 

select the top radio button, 
Uncheck Launch AFR after 
finish and Check “Use the 
same alignment as last 
import”.  

          Finish.       
          They merge together. 
 
 
 
 
 
 
 

 
• In the Part View on the left hand side 

under Solids click the plus sign to 
expand if necessary then toggle between 
each solid that is highlighted.  When the 
solid name is clicked in the part view the 
solid will be highlighted in red. 
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• Click on Construct from above then select Re-Recognition Wizard at the 

bottom of the menu. 
 

 
 

 
 

 
 
 

 
 
• From the solid pull down 

menu select the second, last 
imported, solid in the list then 
press Next twice. 
 

The Re-Recognition wizard will show 
what has changed.  This is very useful 
so the programmer is not required to 
completely reprogram the part upon 
design changes. 
 
 

 
 
 
 
 
Note: This method is only 
effective for features that 
have been programmed 
using AFR or IFR.  
Features created using 
curves will not be Re-
Recognized upon changes 
to the model. 
 
• Press Finish then 

run a 3D simulation. 
 



FeatureCAM 2012                                                             FeatureRECOGNITION for Milling 
                                                               

                                                                          
FeatureRECOGNITION for Milling 2012                                    17 

• Open or drag and drop EndPlate.x_t into a new milling document, inch.  
Repeat the Import Wizard process including “Launch AFR after finish”. 
Click Next four times.  

 
• Compute stock size from the size of the part then Finish. This will 

establish the Stock and Setup the same as before and then execute AFR 
but first in AFR Options, Uncheck 3D.  This completes the initial Setup.  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Import or drag the model EndPlate Changes.x_t located in the 
FeatureRECOGNITION folder and click YES to Import into the same 
document. 
   

• Uncheck “Launch AFR after finish”.  Check “Use same alignment as last 
import”.  Next.     
 

• Select “Accept the imported data as is and exit the Wizard”.  Finish. 
The revised model, EndPlate Changes.x_t is merged with the first.  

 
 
Note: The “Use same 
alignment as last import” 
button will disappear. This 
is expected. 
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• Click Construct 

and Click on the 
Re-Recognition  
Wizard and drop the 
menu down and 
select the second 
model. 
 
 
 
 
 
 
 

• Click Options. Check 
“Create 3D feature” and 
Select “Multiple feature”.  
This will apply the 3D tool 
path to the three chamfers 
and a new 3D (only if 
licensed) addition in the 
revised model. The three 
chamfers can be Unchecked 
in the Part View under Setup 
1 to execute only the new 3D 
surface features.     
 
 
 

 
 
 
 
 
Notice the numerous 
changes in the holes, 
pocket depths, islands 
and even 3D. 
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• Run a 3D 
simulation. 

 
 
 
 
 
 
 
 
 

IFR      (Interactive Feature Recognition) 
 

o IFR has three types of strategies available IFR Automatic by feature type, IFR using 
surfaces or faces and IFR chaining. 

 
o IFR Automatic examines the model for a particular feature such as a side, pocket, 

face, slot, hole and boss.  Side, pocket and boss features are not created using AFR 
side features but separate side, pocket and boss entities. 

 
o IFR using surfaces or faces extracts information about the highlighted entities 

extracting depth and feature contour. 
 

o The IFR using chaining method takes a horizontal slice of the model then the slice 
profile may be chained into a curve. 

 
o Depending on the geometry of the feature to be extracted one technique may be more 

advantageous than others.  Usually when programming a part using a solid model a 
combination of these techniques is used. 

IFR Example #1 
• Click on File then Open.  

Under Files of type at 
the bottom of the screen 
select ParaSolids 
(*.x_t, *.x_b).  Find the 
file named 
ex02ex02.x_t then 
press the Open button.  
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• Select Milling Setup and 
select the Unit of Measure to 
be Inch then press OK.  
  
 
 
 

 
 
 
 
 
 
 

On the Import Results page select the 
top radio button and Uncheck “Launch 
AFR after finish” then press Next four 
times. 
 
 
 
 
 

 
 

• On the Stock Dimensions page 
check the lower radio button 
Compute stock size from the 
size of the part.  Finish. 

 
 
 
 
 
 
 
• Start the New Feature Wizard 

select Face then check “Extract 
with FeatureRECOGNITION”. 
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• Left click on the top most horizontal face of the part then click the green 

“+” to add it to the list.  Then press the Finish button.   
• In the Properties, Click the finish operation and Milling Tab and change 

the Zig-zag Angle to 90. 
 

 
 
 
 
 
Open the New Feature wizard and 
select Side and check Extract with 
FeatureRECOGNITION. Next. 
 

 
 

• Select side surfaces.  Next. 
 
 
 
 

 
 

 
• Using the arrow, select this vertical face and press the green + to enter. 

 Next. 
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Observe the arrow, it points to the side that is cut.  Reverse if pointing to the wrong side 
of the curve by using the button on the right of the machining side window.  
• Next. 

 
 
 

• Because the side selected for the feature descends into the pockets you 
must Click on the Bottom arrow and Click on the horizontal face to control 
the depth.  Both the Top and Bottom can be controlled here.    Next.  

 
 
 

 
 
 
 
 
 

 
• Select Boss with Recognition from New Feature.  Next.  
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• Select “Use horizontal surface”.    
Next. 
 
 
 
 
 
 
 

 
• Rotate the part and select 

the bottom horizontal face for 
the shape and one vertical 
face to determine top and 
bottom and Click the green + 
to enter.  

     Finish. 
 

 
• Select New Feature Wizard and Select Side with Recognition.    Next.  
• Automatic, then select only the side feature that goes through.  Finish. 
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• In New Feature select Pocket and 
Extract         with 
FeatureRECOGNITION.    Next. 
 
 
 
 
 
 
 
 
 
 

 
 
• Select Automatic recognition. 
          Next.                   
 
FeatureCAM using IFR Automatic 
recognition will identify all pocket features. 
 
• Press the “Select All” button to 

select all identified features and 
then unselect the two similar 
small pockets which the top of 
these features are too high, these 
two should be at a lower Z 
elevation.  This happened 

because a face in the pockets goes higher than the tops of the pockets.  
Unselect the round also.   

• All selected pockets turn red when 
selected and all you need to do to 
unselect them is to click on each 
and they will become blue again 
and are not included.   
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• Repeat the Automatic pocket process again with New Feature except 

Check “Force same Z height”, Click on the Blue word Elevation then Click 
on the horizontal surface to set the height (Top) of all three remaining 
pockets.  Click on the three remaining pockets turning only those red.   

 

 
 

 
 
 
 
 
 
 
 

• Open the New Feature wizard and 
select Hole and check Extract with 
FeatureRECOGNITION. Next. 
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• Select the Recognize and 

construct multiple holes radio 
button and check the Exclude 
holes with a diameter greater 
than checkbox and enter a value 
of 1 inch. Next. 

 

 
 

 
 

 
 
 
 
 
 
 
 
 

• Select All.  Finish.   
• Run 3D simulation 
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IFR Example #2 
 
• From the file menu open 2.5D 

pocket with open groove.fm 
from the examples folder and 
shade it. 
 
 

• New Feature Wizard and select 
Side from Curve and check 
Extract with 
FeatureRECOGNITION.    Next. 
 
 
 

  
 
 
 
 

• Select “Use horizontal 
section” and “Elevation” of 0 
(top).    Next. 

 
 

 
 

• Use “Slice location” arrow and 
Click on the edge of the first 

horizontal surface to establish the bottom of the feature.    Next. 
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The cursor is now in the Mode to create curves and you can readily see the outline of the two 
side features that will require open curves. 
 
• Chain both Open geometry shapes separately.  Click on Create at the 

bottom in the geometry dialog area after each curve is complete.  Be 
certain not to go around the outside of the part with the curve, both should 
be open curves and end at the openings on each side.  This geometry will 
be deleted and only the curves will remain.     Next. 

 
Remember these are TWO open curves in One side feature and both Machining Side arrows 
must point inside and each must point at the opposite curve.  This will machine everything in 
between. 

 
 
 
 
  
 
 
 
 
 
 
 
 
 

 
 
 

• Repeat the same steps except use the bottom of the previous feature as 
the “Elevation” (top) of the next Horizontal Section and the first face 
stepping down as the second “Slice location” (bottom). 

 
 

 

Chain this 
geometry 
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The third and final feature is a pocket. 
 
• Open New Feature wizard, select Pocket and Extract with 

FeatureRECOGNITION.    Next. 
• Select Use horizontal surfaces.    Next. 
• Select the bottom horizontal face of the pocket.    Next. 

 
 

 
 

• Using the Top arrow select the top edge of the pocket.    Finish and 3D 
simulation. 
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IFR Example #3 (4 Axis) 
 
All previous FeatureRECOGNITION examples have been stationary 3 Axis parts but 
FeatureCAM gives extraordinary results on solid models mounted on a 4 Axis indexer or 
rotary table.  The part you will create is a special boring tool with pockets that will use 
carbide indexable inserts when finished.  You will begin by importing TWO solid models.  
One is the Part and the other represents the Stock.  The Stock material would logically be 
turned on a lathe to the size and shape of the finished holder and that is the state of the Stock 
when it comes to the mill for these secondary features.  
 
    

 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Open a new milling document in inch.  Click on File then Import and 
select from the Data folder model 2.5D Cutter horizontal slide-PART.x_t.   

• In the Import Results Select “Use the wizard to establish the initial setup 
location and stock size” and select an Isometric View by right clicking in 
the graphics window.  Uncheck “Launch AFR after finish.     Next.  
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The part centerline must be aligned with the rotary table in the X Axis and perpendicular to 
the spindle. 
 
• Shade the part. Select the Arrow to “Align Z perpendicular to a 

horizontal surface” and Click on the horizontal face then Top view.  If 
your selected surface is upside down Click on the “Reverse Z” button and 
Top view again.    Next.  
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The center line is now perpendicular to the spindle 
but the part must be rotated around the Z Axis 
to align with the X Axis. 
 
 
 
 
 
 
 
 
 
 
 
 

 
• Click three times on the “Rotate X direction 90 degrees around Z Axis 

and Top View again.    Pockets to the left as shown below.    Next. 
 
 

 

 
 
 
 
 
 
 
 
 
• In Stock Type, Click Round, X 

Axis. 
Next.  
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• View from Left View to check if 

stock is on center.    Next. 
 
 
 
 
 
 
 
 
 
 
 
 

• From Stock Dimensions Click on the 
“Blue” letters “OD” and then click on 
the largest OD of the model then type the Length 7.000 dimension in the 
box and Preview.    Next. 

 

 
 
 
 
 
 
 
 
• From the “Pick Initial Setup XYZ Location” Click on the Left Hand to set 

the XYZ Zero Location.    Next. 
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• In “Is Part Indexed?” Select 4th Axis Positioning and Index around the 
STOCK X Axis.    Finish. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

When using 4th Axis the Part must be aligned with the “STOCK AXIS”.  This is the 
Center of the Indexing and equally important is the Reference for ALL features created or 
recognized to be placed around.   
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• To view the “STOCK AXIS” Click on View, upper menu bar and Select 
Show then Show Stock Axis.  You will see another set of arrows merge 
with the UCS (light blue in color).  The Z points up in the Z direction 
toward the spindle and is “0” degrees, the starting point of indexing angles.  
The X is parallel to the X Axis and will index around this axis   
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 

 
 

 
• Repeat the Import process for the STOCK model 2.5D Cutter horizontal 

slide-STOCK.x_t.  Import the STOCK into the same document that the 
PART is in, the STOCK model initially appears as below. Click Yes. 

• In the Import Results select the top radio button to Use the Wizard and 
check “Use the same alignment as last import”. 
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When Finish is clicked the STOCK model will align to the PART model in the same 
relationship as when they were exported from Cad but will not be merged, see below.  For 
the two models to merge together at this point they must be created in the Cad system 
aligned and merged together although they can be Imported into FeatureCAM together or 
separately.  You may be able to control how models are created in house but models from 
customers can be created in various positions. 
 
The two models now need to be merged and that means you will have to Transform the 
STOCK model by Rotating and Translating it to the PART model 

 
Having a STOCK model in addition to the PART model is very helpful in as much as the 
STOCK model actually represents the state of the stock material presented to the 4 Axis 
operations plus FeatureCAM now uses the STOCK model as the STOCK boundary instead of 
bar stock. 
 
• To finish the alignment or the merging of these two parts, change to a 

Right View and shade the part. 
• Using Curves from the Steps Toolbox then curve wizard select Curve 

from Surface and Trimmed Edges.    Next.  
• Using the Surface arrow select the End Face on the STOCK model.  The 

face will show select color.  Around the outside edge a curve is created and 
that is what the purpose for doing this is, you will need this curve.  Finish. 
 

 
 
 
 
 
 
 
 

End Face 
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• Click on the curve you just created and then click on Construct from top 

menu bar, Select Curve and from the sub menu select “To Geometry”.  
This changes the curve into geometry but keeps the curve.   
 

The Geometry circle gives you an exact center point of the model and can be used as an 
anchor to click on whereas the curve didn’t provide this.  These two tools are very helpful 
throughout FeatureCAM when working with curves and models.  You are simply extracting 
engineering information from the model.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Now change to Isometric View then place your cursor on the STOCK 

model, Right Click and Select Solid.  You will need to see the circle 
center and the red select color covers it.  Click the shade button if you need 
to unshade (2 little red barrels on top tool bar) and this will reveal the circle 
but the select color must remain on the model in order to open Transform, 
so be sure not to click on the graphics window or you will un-select and 
have to do it over again.   You must always select first or the Transform 
button will not be accessible (grayed out). 
 
 
 
 
 
 
 
 
 
 
 
 

Circle Center 

Circle Center 
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• Click on the Transform button (little arrow with pigtail next to the Select 
arrow) on upper tool bar.  Select Translate and use the From: arrow click 
on the circle center.  Enter 0 in all three boxes next to the To: and Click 
preview and you will see the STOCK model shift to the UCS at the end of 
the PART model.    OK. 
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• Select the STOCK model as before and return to Transform and Select 
Rotate.  Angle of 180 and Select Center Point and Z Axis and Enter 0 in 
both boxes.  The STOCK model will rotate and merge with the PART 
model. Preview and OK. If unshaded, shade the part. 
 
 
 
 
 
 
 
 
 
 
 

Summary:  The purpose of “Use same alignment as last import” is to take advantage of 
assemblies and multiple models that are created and aligned or merged together when created 
in Cad.  If the parts are not aligned when created, it does not matter because FeatureCAM 
provides all of the necessary tools to align the parts.  So you use the Import wizard to Align 
completely or as close as possible and finish off with these tools.   
 
 
 
The PART model is now ready to apply the Features using FeatureRECOGNITION. 
 
• You first must change the Stock.  Double-Click on the wire frame of the 

stock in the graphics window.  Click on “User defined” and check the box 
for the solid of the STOCK model.  Click OK and Apply. 
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• From the Part View Click Solid in the list and Right Click on the STOCK 

model and Hide Selected.  This is necessary to see the PART model and 
even with the STOCK model hidden it will still be visible when running 3D 
Simulation. 

 
• Switch to Isometric view. Click New Feature Wizard and Select Side 

From Curve and check Extract with FeatureRECOGNITION.    Next. 
 

 
 

 
 

• Select Around the index 
axis and Specify angles.   

 
• Click on the “Blue” words 

“Index Angle”.     
 

 
 
 
 
 
 
 
 

• Click on any vertical surface 
edge, starting low on the line 
with the first click and above 
the first with the second Click.    
Next. 
 

The second click is pointing in the 
direction that you want the spindle to 
come from and at the same time you 
are establish the index angle for setting 
the features. 
 
• Select side surfaces.    Next. 
• Check the arrow direction for 

Machining side.    Next. 
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When selecting vertical surfaces, the Top and 
Bottom are already established but if you 
desire to change either the arrows can be used 
by clicking on a surface edge or you may 
enter the dimensions 
 
• Click Finish and OK.  Run 3D 

Simulation. 
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There are the same side features opposite the side features just completed.  You can repeat 
the same steps for them.  Remember when selecting the index angle the second click is 
always pointing to the spindle so if you select the surfaces when upside down the second 
click has to be lower because when the part indexes the vertical surfaces rotate and must be 
aligned with the spindle. 
The other choice is making a pattern from the previous feature but should only be used 
when you are absolutely certain they are identical and symmetrical. 
 
 
• To make a pattern first Select the existing feature and then the New 

Feature Wizard and select Pattern From Feature.    Next.     
• The previous Side feature must be selected.    Next. 

 
 
 
 
 
 
 

 
• Select Radial around index 

axis.    Next. 
 
.  
 
 
 
 
 
 

 
 
 
• Select Number 2 and Spacing 

Angle 180.    Finish and OK. 
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When milling cylindrical parts the side feature has to extend outside of the Stock far enough 
to satisfy the bottom of the feature but at the top, because of the shape of the material the tool 
is cutting air on some passes.   
• To eliminate this, under the strategy tab in the milling feature select 

Individual levels, Apply and OK.  
This creates control at each Z increment depth of cut and follows more closely to the shape of 
the material on each level.  Higher passes start their passes closer to the material and move 
out as the tool descends.  FeatureCAM has also selected three tools now, the first pass is the 
shortest tool and each pass changes to a longer tool.  You may override this by selecting the 
same tool for all three cuts.   
This will also make the part index on each level but can be eliminated by selecting “Cut 
higher operations first” from the results window (right side of graphics window), click on 
Automatic ordering options button at top.  This works only if the features are individual 
not a pattern. 

   
 
 
 
 
 
 
 
 
 
 
 

• Rotate the View so you can see the horizontal surface of the feature 
between the previous features just completed.  Continue with Side Feature 
using Recognition and select the arrow “Normal to surface”.  Click on 
the horizontal surface that you rotated to.  The vertical surfaces that 
FeatureCAM is looking for are Normal to this horizontal surface.  
FeatureCAM uses the horizontal to index to and looks for any vertical 
surfaces with Recognition at this angle.  
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• Select Automatic 

recognition.   Next. 
 
 
 
 
 
 
 
 
 
 
 
 
• Uncheck “Exclude features smaller than’ and Click only on the vertical 

surface (red preview in graphics window as shown below) connected to the 
horizontal surface you selected.    Finish and OK. 

  
You can extend the lead on the feature if it fails to remove all the material on the short end of 
the feature. 
 
• In the feature Click on the finish operation and the Stepovers Tab and in 

the “Lead moves for cuts with open ends” Enter .250 in the Extension 
dist: box. Apply and OK. 
 

You will do the Pockets for the inserts next. 
 

This Feature 
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• Isometric view back to 0 or the first feature. 
 

• Open New Feature Wizard and Select Side and Recognition.    Next. 
 
 
 
 
 
  Follow the same 
procedure for finding the 
angle of index using the 
edge of a vertical face. It 
will be the area where the 
inserts will sit.  These will 
be side features.  
 
 
 
 
 

 
 
 
 
 
• Select Use horizontal section.  

Click on the “Blue Word” 
Elevation and Click on the Top 
edge of the vertical face for the 
feature, this sets the top of the 
feature.    Next.   

 
 
 
 

 
 
• Click on Slice location arrow and 

Click on the bottom of the same 
vertical face and this sets the 
Bottom of the feature.    Next. 

 
 
 
 
 
 
 

Side Features 
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• Click on Switch to Top View 
and the part moves to a top view.  
The geometry is readily visible 
and must be chained with an 
open curve.  Chain them with two 
open curves, not connected.  
Click on Create at the bottom in 
the geometry dialog area after 
each open curve.     Next. 

   
Remember this geometry goes all the way 
around the part; be sure the curve doesn’t 

go there.  
 
 
• Check the Machining Side arrows, they must point in.  Use the reverse 

button to the right if necessary.    Next. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
• Confirm the Top and Bottom and change using the Top and Bottom 

arrows if necessary and extend the leads as before if necessary.    Click 
Finish. 
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Complete all of the remaining side features. 
o For hole features, if Automatic is used, FeatureCAM recognizes ALL of the holes at 

All of the angles.  When the holes have a bottom (blind) FeatureCAM knows from 
what direction to come with the spindle.   

o When the holes are around the indexing axis and are on the centerline, whether they 
are blind or through like in tubing it also knows from what direction to drill the holes. 

o When the holes are not on the centerline and are through like this model, Feature 
CAM basically has to guess from what direction.  To avoid this you will use the 
isoline in one hole to give the indexing angle and remembering the second click on 
the line tells FeatureCAM the direction you want the drill to come from.  It does ALL 
holes in Recognition but only at that angle and will not drill any of the others from the 
wrong direction.  You will have to do the various indexing angles for the holes for 
Recognition until all of the holes are complete. 

• Open New Feature Wizard and Select Hole and Extract with 
Recognition.    Next. 

• Select Specify angles and click on the “Blue Words” Index Angle and 
Zoom in on the hole you choose.  If you un-shade it temporarily it exposes 

the line very clearly for easy picking.     
Next. 
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• Select Recognize and construct 
multiple holes.    Next. 

 
 
 
 
 
 
 
 
 
 
All holes have been selected at your chosen 
angle, even those on the other side that you don’t want and that is because they are an open 
cylinder and could be drilled from this Z direction.   
 
• You simple choose only the ones you want.  Click on them and they then 

turn red as selected.  The others remain blue and are not selected.      
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
Continue repeating these steps 
until all holes are completed then 
your PART is finished.  
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Part Library 
Introduction 
 
The Part Library is a function of FeatureCAM that enables users to save items that they use 
repeatedly.  Rather than having to recreate the same entities, the user can just recall them 
from the Part Library.  In addition to saving specific features, the Part Library can store 
processes.  For example, if a user machines pockets the same way all the time, one pocket can 
be stored, and then it’s parameters and attributes can be applied to future pockets, saving the 
user from having to change the same settings over and over. 

Creating a Part Library Feature 
Any feature can be stored in the Part Library to be recalled later.  This exercise will 
demonstrate how to save a feature to the Part Library, and it will offer some tips on how to do 
this most effectively. 
 
• Open a New milling file 
 
• Fill out the Dimensions page 

of the Stock Wizard as shown 
• Click Next 4 times to get to 

the first Setup – Part 
Program Zero page 

• Select Align to Stock face 
and click Next 

 
 
 
 
 
• Designate the setup location as 

the center of the part 
• Click Finish 
• Click OK to exit the Stock 

Properties 
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In this next step, we are going to create a ½-
13 tapped hole to be stored in the Part 
Library. 
 
• Launch the New Feature wizard, 

and select Hole 
• Click Next 
• Fill out the Dimensions page as 

shown 
• Click Next, and verify that the hole 

will be located at 0,0,0 
• Click Finish 
• Click OK to exit the Hole 

Properties 
 
 

 
 
Hint: If possible, it is best to locate Part Library features at the origin.  This makes it easier to 
locate the features accurately when they are loaded into another file.  If a Part Library feature 
is not located at the origin, its original location has to be known and compensated for in the 
new document. 
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Next, we are going to rename the feature so that it has a more descriptive name. 
 
• Right-click the hole feature in the 

Part View 
• Select Rename 
• Rename tapped hole as shown 
• Click OK to accept the new name 
• Select the tapped_hole_500_13 

from the Part View 
 
• Open Part Library by selecting Part 

Library under the Construct pull-down 
menu 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• Save the tapped hole by 

clicking Add selected 
 
This will save the tapped hole to the 
“root” of the Part Library.  In future 
examples, we will create sub folders so 
that the Part Library stays neat and 
organized. 
 
• Click OK to close the Part 

Library 
• Close the file without saving 
 
Now that the hole is in the Part Library, 
we do not need to save the file that 
defined it.  Its definition is contained 
entirely in the Part Library directory. 
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Using Part Library Features 
Now that a feature has been saved away, it can easily be installed in another part. 
 
• Start a new milling file 
• Use the Stock wizard to create a 4 x 6 x 1 block 
• Locate setup on lower left-hand corner 
• Finish the Stock Wizard and exit the Stock Properties by clicking OK 
 
• Start a new feature by clicking 

the New Feature wizard icon 
• Select a User defined feature 
 
 
 
This is one way to access existing features 
in the Part Library.  We will explore other 
methods later in this chapter.  User-defined 
features include features that can be created 
by macros and features that are stored in 
the Part Library.   
 
 
 
 
 
 
 
 
• Select the tapped_hole_500_13 

from the dialog box and click 
Next 

 
 
 
 
 
To complete this process, we have to 
determine the location of the Part Library 
feature.  Since we created our original 
feature at 0,0,0, we will be able to enter the 
coordinates without having to adjust for 
any offset. 
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• Enter the value 1 for both X and Y 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You will notice that our tapped hole is now located in the proper position and is now ready to 
complete. 
 
• Click Finish to complete the feature wizard. 
 
If you open the new feature, you will see that it came in exactly as it was originally defined.  
This feature can now be edited, if desired, without affecting the Part Library feature - the 
installed feature is no longer associated to the original. 
 
• Close the file without saving 

 
 

Saving Patterns and Groups to the Part Library 
Oftentimes it is not a single feature, but a combination of features that needs to be saved for 
future use.  This exercise will show you how to combine multiple features into groups and 
then save the group into the Part Library. 
 
• Open Gauge Mount.fm from the Data folder 
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• Run a Simulation

 
• Clear Simulation results 
 
As you can see from the simulation and from the Part View, we have a pocket feature and a 
hole pattern that we want to always machine as a set.  We would like to be able to store them 
together so that they could be brought in as a single Part Library item.  In order for these two 
features to be stored together as a set in the Part Library, they have to be combined into a 
Group first. 
 
• Start the New Feature wizard 
• Select Group from the From 

Features section 
• Add both features them to the 

Group Members list 
• Click Finish 
• Exit the group properties by 

clicking OK 
 
As with the original tapped hole we created 
in this chapter, we are going to rename our 
group to a more descriptive name.  This is 
especially useful if we are going to have 
several similar features stored in the Part 
Library. 
 
• Right-click on the group in the Part 

View 
• Select Rename 
• Rename the group as shown 
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From here, the process is exactly the same.  For this part, though, we will create a new folder 
in the Part Library.  You can create folders to organize your features and keep the Part 
Library from getting too cluttered. 
 
• Highlight the Group in 

the Part View 
• Open Part Library 
• Click Add Folder 
• Select the folder and click 

Rename 
• Rename folder to 

instrument-mounts 
• Click Add Selected to 

save group to new folder 
 
You will see that gauge_mount_1 
is added to the Part Library as a 
child of the instrument_mounts 
folder. 
 
• Exit the Part Library by 

clicking OK 
• Close the file without 

saving 
 
 

Patterning Part Library Features 
If a user wants to install multiple instances of a Part Library item into a file, this can be done 
by utilizing Patterns.  All of the pattern types such as Linear, Radial, and Rectangular are 
available.  If the positions of the Library features are laid out in advance, the process can be 
made very quick and easy by creating a Points Pattern. 
 
• Open Instrument Panel.fm from the Data folder 
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This file simply contains the locations at which we will locate our Library features.  If the 
features are created correctly, they will come in perfectly positioned at each one of these 
points. 
 
• Start by selecting all of the points 

by dragging a selection box around 
the entire part. 

• Start a New Feature 
• Select User 
• Make a pattern from this feature 

should already be checked since 
we preselected more than one 
point 

• Click Next 
 
 
 
 
 
 
 
• Select the gauge_mount_1  group 

from Part Library 
• Click Next 
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The Points Pattern is the style of pattern already selected because of our collection of points. 
 
• Click Next 
• On the Dimensions tab, you can alter the sorting order, if desired 
• Click Finish to complete the wizard 
• Click OK to close the Feature Properties 
• Run a simulation to see the results

 
• Close the file 
 

Saving Solids to the Part Library 
Solid models that are brought into FeatureCAM can also be stored in the Part Library for later 
use.  This capability is especially handy for using solids as fixtures and clamps.  The 
following example will demonstrate saving a solid to the Part Library and then loading it into 
a FeatureCAM document. 
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• Open a new Milling file 
• Cancel the Stock Wizard 
• Import Toe Clamp.sldprt from 

the Data folder 
• When the Import Results 

screen appears, choose to 
Accept the imported data 
“as is” and exit the wizard 

• Click Finish 
 
The clamp comes in located at 0,0,0.  
Now we will save it to the Part Library 
so that it can be easily loaded – and even 
patterned – in future files. 
 
 
• Expand the Solids folder in 

the Part View and right-click 
the solid 

• Rename the solid toe_clamp_1  
 
Again, it is good practice to rename entities that are going to be used at a later date with 
descriptive names. 
 
• Make sure the solid is still selected and open the Part Library 
• Click Add Folder 
• Rename the new folder clamps_and_fixtures 
• Highlight the clamps_and_fixtures folder and click Add Selected to add 

the toe clamp to the Part Library 
• Click OK 
• Exit the file without saving 
 
Now that the toe clamp is stored and ready to use, we will bring it into a finished version of 
the Instrument Panel that we worked on earlier.  Since the clamp is not a feature, we will not 
do this through the New Feature wizard.  Instead, we will copy the toe clamp directly from 
the Part Library. 
 
• Open Instrument Panel – Finished.fm from the Data folder 
• Click Construct > Part Library 
• Select toe_clamp_1 from the clamps_and_fixtures folder 
• Click Paste 
 
This exercise will introduce us briefly to the Paste Special function.  We will study Paste 
Special in further detail later in the chapter. 
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We want to paste the toe clamp 
into our part, but we want to be 
able to designate where it is 
located.  For this, we need to 
use the second choice of the 
Paste Special options. 
 
• Select the second 

option as shown 
 
 
 
 
 
 
 
 
 
 
Before we give our feature 
location dimensions, we need to 
define a reference point.  This is 
a nice tool because you do not 
have to locate the entity relative 
to an origin.  If you would 
rather locate the clamp 3 inches 
from a specific point, you could 
select that point as your 
reference point.  In this 
example, however, we will use 
the origin as our reference. 
 
• Make sure the 

reference point is 0,0,0 
and click Next 

 
 
Now that the reference point is defined, enter the position of the clamp. 
 
• Enter position for clamp as shown below 
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• Click Preview to confirm the location

 
 
 
 
• Click Finish to place the solid 
• Click OK to close the Part Library 
 
Solids that are brought into FeatureCAM files can be used to represent fixturing during 
simulation.  However, this requires a few more steps.  If you were to run a 3D simulation 
now, the clamp would not appear. 
 
• Right-click on the 

toe_clamp_1 solid in the 
part view 

• Select Use Solid As 
Clamp 

 
Now that the solid has been 
designated as a clamp, it will 
show up in our simulation.  It will 
even detect gouges if a tool or tool 
holder contacts it. 
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• Run a 3D simulation

 
 
• Close the file without saving. 

Paste Special 
We have already seen how Paste Special can be used to position a Part Library item in a 
FeatureCAM file.  Paste Special has a couple other functions that help to load a feature or its 
parameters into a file. 
 
• Open the file Paste Special.fm from the Data folder 
• Make sure the basic tool crib is active 
 
This file contains two pocket features that have different settings, depths, and parameters.  
We will use Paste Special to create and modify features based on the settings of a Part 
Library feature.  First, we will save Pocket1 to the Part Library. 
 
• Click on pocket1 to highlight it 
• Open the Part Library 
• Add a New Folder 
• Rename the folder pockets 
• Select the pockets folder and click Add Selected to save the pocket to the 

Part Library 
 
We will use this pocket as the templates for other pockets in the part file.  First, we will 
create an entirely new pocket with all the parameters of pocket1.  This strategy is very useful 
if you want to apply dimensions and attributes of one feature to different curves. 
 
• Click on pocket1 in the Part Library to highlight it 
• Click Paste 
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The Paste Special dialog box appears.  We will paste the feature “as-is” into our part file. 
 

 
 
• Select “Paste the selected objects into the current setup” 
• Click Finish 
• Click OK to exit the Part Library 
 
You will notice that there is a new feature in the Part View, but it is not visible in the 
graphics.  This is because we have two identical features in the part file.  Next, we will 
modify the new feature be selecting a different boundary curve. 
 
• Double-click pocket1_1 to access its properties 
• Click on the Boundaries button 
• Clear the current curve selection and select Curve2 
• Click OK and Apply 
• Click OK to exit the Feature Properties 

 
We now have a new feature attached to Curve2.  This feature has the exact same parameters 
and dimensions as the original feature. 
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Hint:  When you create a feature to be stored in the Part Library, avoid overriding any tools 
unless you want to designate specific tools to the feature.  By keeping default tools in place, 
you allow FeatureCAM to change the tool selection based on the geometric conditions, and 
you create a more flexible Part Library feature.  If you compare pocket1 and pocket1_1, you 
see different tools are selected because of the different radius values of the corners. 
 
Another way to use Paste Special is to apply the Machining Attributes of the library feature to 
another feature.  In this example, we will apply the attributes of pocket1 to pocket2.  First, 
open the properties of pocket2 and examine the Strategy tab. 
 

 
 

Pay attention to which attributes are checked, and exit the properties. 
 
• Open the Part Library 
• Click on pocket1 in the Part Library to highlight it 
• Click Paste 
• Select “Copy the machining attributes from the selected feature to another 

feature” 
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• Click Next 
• Check the Machining Attributes 
 
 
You have a choice of applying all of 
the machining attributes of the 
library feature, or only the attributes 
that were overridden in the library 
feature. 
 
 
 
 
• Choose to copy all of the attributes as shown 
• Click Apply and Finish 
• Close the Part Library 
 
Now take a look at the Strategy tab of pocket2. 
 

 
 

Options such as Individual Levels and Cutter Comp, which were characteristics of pocket1 
are now installed in pocket2.  This strategy is useful when you want to machine features of 
different dimensions in a very consistent manner.  All of the attributes get applied without 
altering the geometry of the feature. 
 
Another note about Paste Special: Paste Special is not limited to being used in conjunction 
with the part library.  You can use Paste Special more “locally” by copying a feature from the 
part view and then using Paste Special.  The Paste Special can occur within the same part, or 
in a different part. 
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Streams 
Entities other than features and solids can also be stored in the Part Library.  Curves, 
geometry, and machine functions can also be saved and recalled.  These items show up as 
Streams in the Part Library. 
  
Oftentimes, geometry is reused from one part to another.  For example, there might be a 
fixture that has specific layout geometry.  In that case, the layout geometry can be stored 
away in the Part Library and used repeatedly as a template. 
 
• Open the file Layout.fm from the Data folder 
 
The lines and circles in this file represent a bolt hole pattern in a fixture.  We would like to 
save this pattern to the Part Library so that it can be transferred to a new document. 
 
• Select the geometry by dragging a selection box around the entire part 
• Open the Part Library 
• Add a new folder 
• Rename the folder layout_geometry 
• Select the layout_geometry folder and click Add Selected 

 
 

• Exit the Part Library 
• Close the part 
 
Each geometry entity is stored under the Stream1 heading.  The Stream1 heading can now be 
renamed to something more descriptive.  This new geometry stream can now be added to new 
files using the Paste Special function. 
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Streams can also be used to store other types of features.  This sample will construct a stream 
of lathe functions that will be very similar to the Grouping method that we have already seen. 
 
• Open the file Turn Part Transfer.fm from the Data folder 
 
This file contains Subspindle features that carry out a part transfer on a lathe.  It would be 
quite time consuming to create each one of these steps manually for every turning file, so the 
entire set of steps can be stored in the Part Library as a Stream. 
 
• Select all of the features by dragging a selection box around the entire part 
• Open the Part Library  
• Add a new folder 
• Rename the folder transfers 
• Select the transfers folder and click Add Selected 

 
 
Each subspindle feature is stored under the Stream1 heading.  The Stream1 heading can now 
be renamed to something more descriptive.  This new feature stream can now be added to 
new files using the Paste Special function. 
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Creating Machining Set-Ups 
 

Introduction 
Before starting any machining operation, it is necessary to set a Datum position 
from which to work from. In FeatureCAM these positions are called Set ups and 
these can be defined using a number of techniques. 

 

Creating SetUps from the Stock 
The Stock represents the material which is to be machined. The most common 
places that are used when defining the Set Up on a standard Block are the Centre 
of a Face or one of the Corners as shown below. 

 

  
 

When FeatureCAM opens a new part a Stock is automatically displayed on 
the screen. 

• Double click on the stock either in the Part View Toolbox or in the main 
Graphics area. 

• Fill in the Form as shown below, Length=200, Width= 200 and 
Thickness=100 
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The X, Y, Z input fields at the bottom of the form are the position of the top 
face bottom left corner in the World Co Ordinate System as shown in the 
image below 

 

 
 

Change the figures in the input fields and watch how the Stock moves around. 
 

• Reset the figures to X0 Y0 Z0. 
 

To place the Set Up in the centre of the Block, it is simply a case of moving 
the Set UP to the centre of a Stock face and this is achieved by changing the 
position, using the Part View Toolbox 

 
• At the left of the screen are the Toolboxes and depending upon which 

Toolbox is selected, it will either show the Part View or the Steps 
Toolbox, 

 
 
 
 

If you can only see the Part View Toolbox and not 
the Steps options as shown....Try looking at the 
bottom of the screen. (When it is not in use, the Steps 
Toolbox drops down to the bottom, just click on the 
tab to reactivate the toolbox.) 
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• Right click on the 
Setup in the Part 
View and then select 
Properties from the 
menu that appears as 
shown. 

 
 
 
 
 
 
 
 

• This will open the 
Set- Ups form, 

 
On this form, the user can 
choose whether to create a 
New Setup or to Edit / 
Change an existing one. 

 
 
 
 
 
 
 

• Click on Edit, followed by Next 
 
 
 
 
 
 
 
 
 

• Select Align to Stock Face 
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The form is divided into two areas and these are Stock Face and XYZ location 
 
 
 
 

Stock Face is used to 
tell FeatureCAM on 
which Face to place the 
Setup. 

 
 
 

XYZ Location is 
used to position the 
Setup on that Face 

 
 
 
 
 
 
 

• Select Top followed by Centre. Click Finish and then Close. 
 

The screen should now look as shown below. 
 

 
 
 

Using the same method, create a new set up on the Front Face at the Upper 
Right Corner. 
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Creating Setups Using Geometry 
 

 
 

• Go to the Setups icon on the Advanced Toolbar at the top of the screen. 
 

 
 

If it’s not there, then the advanced toolbar needs to be switched on. To do this, 
right click on the grey area around the edge of the graphics area, and choose 
Advanced from the drop down list. 

 

It is also possible to create Setups which are aligned to existing Geometry.  Draw the 
 
wireframe shown below, using the Geometry Step. 
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After selecting the Setups Icon, Select Setup1 from the drop down menu and click on 
Edit 

 
 
 

This will open the Setup Definitions form 
 

Here it is possible to change / set key details of the 

Setup. To rename the setups so that they are easier to 

manage, 

• Enter the name Datum Point into the Setup Name field. This name 
will appear in the Part View Toolbox. 

 
 

The Fixture ID field is 
where the user tells 
FeatureCAM which 
machine offset to use. 

 
For example: If the 
machine uses G54, G55 
then enter 54. If the 
machine tool uses P1, P2 
etc then enter 1. 
FeatureCAM will 
automatically insert the 
correct Fixture ID for 
the next new Setup. 

 
It can be useful for the 
Part / Product name to 
appear in the NC output 
file, This can be inserted 
in the Part Name field. 
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• Click Next and on the following page, select the Align to Part Geometry 

option. 
 

 
By selecting the Align to Part Geometry option, FeatureCAM now knows 
that it has to provide the user with some tools to help them set up or align the 
Setup. 
There are five options on the following page and depending on the geometry 
available; the user can choose one of these to align the Z axis . 
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• Select Pick two points to define initial Z direction. 
The form will shrink to one side of the screen to allow access to the geometry. 

Two mouse clicks are used to define the Z Axis direction. To define the Z Axis, 

• Select the 1st point as shown, followed by the 2nd point. The position of 
the second click in relation to the first is what controls the direction of 
the axis. 

 
 
 
 

 
 
 
 

• When the form returns, click Next 
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• Set the X Axis in exactly the same way as the B. Choose the left 
baseline as shown. 

 

 
 

• This has aligned the X Axis along the short edge. Click Next. 
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• To reposition the Setup. Use one of the two pick buttons or enter the exact 

co- ordinates into the X,Y,Z fields on the form. 
 

The two pick buttons 
are suited to different 
applications. 

 
Pick Location allows 
the user to define 
positions, by picking 
points, directly from 
the screen. 

 
Centre of revolved 
surface is used when 
there are surfaces that 
might represent a 
dowel hole for 
example 

 
 
 
 
 

• Using any one of the methods, move the Setup until it is in the middle of 
the top line. 
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To create a new setup aligned to the angled face 
 

• Create a new Setup by going to the Advanced Toolbar again 
 

 

• Select New followed by Next and then Align to part geometry. 
 

• This time on the Initial Setup Z direction form, select the option to 
Align Z perpendicular to a plane defined by two lines as shown. 

 

 
 
 
 
 
 
 
 

• Select two 
lines that 
are 
perpendicu
lar to one 
another. 
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• If the Z axis is pointing the wrong way, then use the Reverse Z 

button to correct. 
 

 
 

• Click Next twice and reposition the setup as shown below by using the 
Pick Location button. 
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Creating Tool Libraries (Cribs) 
Introduction 
 
It is possible to create Tool libraries or Cribs in FeatureCAM.  The main reason for 
creating Tool Cribs is because in any machine shop there is normally a finite amount of 
tooling available and by creating a custom Tool Crib, FeatureCAM will know what 
tooling is available to choose from. 

• Open a new FeatureCAM part by selecting File, New. 

The following will appear. Select Turn/Mill Set-up and click OK 

 
 

• Go up to the 
Manufacturing Menu and 
down to Tool Manager. 
This will open the 
following form. 

 
• There are three tool Cribs 

loaded as standard. (Basic, 
Basicmetric and Tools) 
and these can be used as a 
starting point when the user 
first starts to look at setting 
up their own Cribs 
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• The window is divided into separate areas and at first glance can 
look a little intimidating, but by applying some simple rules it 
becomes much easier to work with. 

 
 

If the user divides the form in two down the middle of the form. The left side is 
used to select which Crib to copy from whereas the right hand side of the Form 
relates to the Crib that is current or the working Crib 

 
 
 
 

Tool Group …..The tools can be grouped together 
depending upon their type or use. 
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• Also listed down the right hand side of the form are a 
number of options. Among these options are New 
Tool, New Crib, Delete Crib and Copy Crib. 

 
These options do exactly what they say on the tin. 

 
New tool is used to create a new tool type. 

 
New Crib will create a new crib, ready for the user to insert their own 
selection of tools. 

 
Delete Crib will delete an existing crib and Copy Crib will 
produce a copy of an existing Crib 

 
 
 

Tool Grades is used to apply scaling to feeds/speeds to similar tool types that 
use different speeds/feeds 

 
Import / Export allows the user, to either import or export tool cribs from one 
computer to another computer containing a copy of FeatureCAM. 

 
 

• By selecting the New Tool Crib 
option, the following form will 
appear. Enter the name as 
Training, and then click OK. 

 
 
 

• The New Tool Crib will now be listed in the Tool Manager on the 
left hand side 

 

 
• The new Crib is empty so it is possible to copy tools from existing Cribs, 

 
• Select the Basicmetric Crib in the From Crib Menu and the 

Training Crib from the Current Crib Menu. In the Tool Group 
select End Mill 
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• Click on the Select All Button and then on the Add button to transfer the 
selected tools over to Training Crib. 

 
• Repeat this procedure for the different tool groups and add some 4, 5, 8, 10 

& 12mm Twist Drills and some Spotting and Centre Drills. 
• Click on the OK button and the following will appear. 

 

 

 
• Select Yes and the Crib is complete for now. More tools can be added at a 

later date just by selecting them from the Tools Crib or defining New Tools 
based on Catalogue data and adding the tools as needed. 

• To set the Tool Crib so that it is used when calculating the tool path, go to 
Manufacturing, Set tool crib and select the crib from the list. Alternatively go 
to the bottom left of the screen and click on the area indicated 

 

 
 

• Select the Crib required as shown. 
 

 
                  FeatureCam will now use the selected crib for any future operations 

If the wrong tool is being selected, for example using a finishing tool to 
rough out, it could be that the tool needs to be set for a particular operation 
type. 
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Setting a Tools Operation type 
 

1. Open the Tool Manager as described above. 
2. Double click the Tool that the user needs to edit as shown 

 

 
 
 
 

3.  This will open the 
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4. Click on the Overrides tab and then go to the Operations drop 
down menu and select the operation type as shown. 

 

 
 
 

5. Check that the Finishing tools are set to Finishing by following the 
same procedure. 

6. Click OK and then re-simulate the toolpath, the correct tool should 
now be used. 
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Machining 
Configurations / Attributes 

Introduction 
     This module will provide the user with an understanding of what attributes are, 
(characteristics and features) and where they reside Also covering when an attribute is 
chosen, where it shows up in FeatureCAM, and how it affects the feature.    
      By the end of the module the user will be able to select, prior to creating the program, the 
machining configuration of attributes, as the defaults for the material and/or machine to be 
used.  This saves time in programming by not having to make the same repetitive entries for 
the choices you wish to be defaults when that particular material, or machine, is chosen.  It 
also eliminates having to remember the different settings. 

          Machining Configurations 
 

• The Machining Configurations can be 
accessed from the Manufacturing 
drop down menu. 
 

• Machining Configurations are 
predetermined default functions that 
are selected, and used in all features 
that are created in the document. 
  

• A Machining Configuration contains 
approximately 150 settings. 

 
• An unlimited number of Machining 

Configurations may be created. 
 

The user can name a Configuration to 
reference the material and/or machine to be 
used. 

 
 
 
 

• “Initial Configuration for 
new documents”, is in the 
drop down menu at bottom. 
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When a Machining Configuration is selected prior to programming, the attributes, so to 
speak, rain down into the new document just opened. These are used as the default settings. 
They are divorced from the Machining Configurations and become Machining Attributes, 
assigned to, and a permanent part of the new document.   
 
These settings may be changed in the 
document. You can click 
Manufacturing and Machining 
Attributes at any time. Changing any 
attributes will assign them to this 
document only, but does not affect the 
original, or default, Machining 
Configuration. 
 
In other words, these changes do not 
become the defaults and when a new 
document is opened the old defaults are 
active.  These settings stay with the 
document and are active anytime this 
same .fm document is opened.  
  
 
 

What are Machining Attributes? 
 

When an option in the Machining 
Attribute is selected, a box is checked 
or a value is entered, it becomes a 
default. This means that FeatureCAM 
uses this setting every time a feature 
requiring that particular setting is 
selected in a program. There is no 
input required from the user during 
programming, as it is now 
automatically set. However, it may be 
overridden and changed in the feature 
as needed. 
 
Tabs are used to categorize the 
different operation types and 
necessary attribute settings. 
 
Some selections are check boxes, some are numerical values, and some are specific functions.  
The majority of these show up in the feature that they affect, but some settings do not. These 
settings may only be changed in the attributes. This is the reason it is so important to know 
where these settings reside, what their function is, and where they are located in the features.  
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To apply the changes you have made, in the Attributes for the document, to become the 
defaults for any new documents they must also be changed in the Machining Configuration 
that opened with the file. Once set, and the next time a new document is opened, those 
changes will then take effect as the default settings. 
 
 
 
 
 
 
 
 
• Open a New Document and click Manufacturing on the top menu and 
select Machining Configurations. 

 
• Select the document you just opened. Usually there is only one 
document open but multiple documents may be opened. In this case, you 
would see multiple documents in the list. 

 
• Click Copy and select the desired configuration from drop down menu. 
These defaults load into the new document.  

                      
To copy the changes from the document’s configuration into another configuration to be set 
as the defaults: 
 
• Select the desired 
Configuration in the window. 
This is the configuration you 
want to copy the attributes 
to. 

 
• Click Copy and select the 
document from drop down 
menu in the Copy 
Configuration dialog. 

 
• OK. 

 
This reverses the copy and places the changes from the document 
Attributes into the configuration selected in the window of the Machining 
Configurations dialog.      
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Creating Machining Configurations 
 
• Open a New Milling Document. Click Manufacturing on Menu bar then 
Machining Configurations. 

 
• Click on New and type the word Aluminum in the field. OK 

 
• Repeat these steps to create a Stainless configuration. OK. 

 
 
 

• Double click on Stainless in the 
window. Select the Stepover Tab in 
the Machining Attributes dialog. 
Change the Rough Pass depth to 
25%. 
 
The Rough pass depth for milling was 
100% of the .500 diameter of the cutter. It 
is now 25%, so for a 1 inch endmill the 
rough pass depth is set to take cuts at a 
depth of .250. 
 
 
Note: You now have three separate Machining Configurations.  Each has 
approximately 150 settings.    
 
 
• Select the Document you have open in the Machining Configurations 
dialog at the top of the window.  

 
• Copy and select 
Aluminum from the Copy 
Configuration dialog. 
 
•  OK twice. These 
settings will be used in the 
new document. 
 
 
 
 

Open an existing file named Milling Attributes.fm, from the 2.5D 
Advanced Data folder, and run a 3D simulation.   
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The .500 diameter milling cutter cuts to the bottom of the .500 deep pocket in 
one pass because the default attribute specifies the depth of roughing passes 
is to be 100% of the diameter of the cutter.  
 
• Click Manufacturing then Machining Configurations.  Select the 
document in the window on the left named Milling Attributes.fm. 
 
• Press the Copy button. Select Stainless from the drop down list in the 
Copy Configuration dialog. Press OK twice. 

 
Using the same feature and by 
only changing the Machining 
Configuration the Attributes 
automatically change to the 
Stainless settings.  

       
• Run a 3D simulation. 
 
The setting for Stainless is 25% 
of the diameter of the cutter so 
now the tool makes four passes 
at .125 depth of cut instead of 
one at .500 with no further input 
from the user. 
 

 
Machining Attributes Explained 

The rest of this document will be used to explain the attributes found in each 
of the tabs inside the Machining Attributes dialog. To follow along and 
compare, click Manufacturing then Machining Attributes to open the dialog. 

Drilling Tab 
 
Spot drill:   All holes that are drilled will receive a spot or center drill operation before the 
hole is drilled. 
 
Attempt chamfer w/spot:  When a chamfer is entered in a hole feature, a spot drilling tool is 
selected that is large enough to cut the chamfer as it center drills for the hole feature.  If the 
hole is too large, it will still be spot drilled but will give a warning that it was not able to 
achieve the chamfer and use a chamfer tool in addition to the center drill. 
 
Use L/D Compensation:  As a hole is drilled deeper the feed and speed is adjusted to 
compensate for the additional depth.  This is true for holes that have a ratio of hole depth (L) 
to hole diameter (D) of greater than 2.5. The greater this ratio, the greater the speed/feed 
reduction becomes. 
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Combine with similar holes into canned cycle: This Attribute serves two functions. First it 
creates more efficient NC code by entering canned cycle mode only once. It also causes the 
tool to retract to the lower Plunge Clearance plane after drilling each hole, typically .100 
above the hole instead of the Z Rapid Plane which is usually set much higher to clear clamps, 
etc.  Retracting to the higher plane when necessary is possible on a per hole bases in the 
Results Window Op List by clicking on the green arrow of the selected hole. 

Drill large counterdrill first:  A counter drill hole has a second, larger hole drilled on top of 
a smaller hole.  You may select to drill the larger hole first to avoid drilling the same material 
with the smaller tool that will be removed with the larger tool.  The smaller tool will then 
rapid to the plunge clearance above where the first drill stopped drilling. 

Ream before Chamfer:  Allows you to ream a hole before the chamfer to avoid pushing any 
kind of a burr or edge back up onto the chamfer in the event the chamfer is a sealing surface. 

Pilot drill diameter: Set the diameter for a frequently used pilot drill size as a default. 

Spot drill edge break:  If 0 chamfer is entered in a hole feature, this setting will cause the 
center drill to break the edge by this amount, typically .005. 

Spot drill diameter: This percentage is used to select a spot drilling tool. A value of 100 
specifies that the spotdrill should be the same diameter as the hole. A smaller value will 
create only a starter hole. 

Dwell:  The spot drill will dwell for this many seconds. 

Max tap spindle RPM:  Sets the maximum spindle speed that FeatureCAM will select when 
tapping regardless of the size of the tap. 

(Cycles) 

 Drill cycle:  Deep hole will peck and retract to the plunge clearance and return to previous 
depth and chip break only stops feeding in order to break the chip, both perform their 
function until hole is to depth.  

Tap Cycle:  Floating (floating & tension-compression holders), Rigid which is most 
commonly available on today’s machine tools being sold, Deep hole and Chip break is the 
same as drilling.     

Ream Cycle:  Ream cycle affects how a ream operation is performed. The choices are Ream 
FDF (feed-dwell-feed), Ream FF (feed-feed), and Ream FSR (feed-stop spindle-retract). 

If you select Ream FF, the cycle is posted using the Bore (F-F) format in XBUILD. Ream 
FDF will use the Bore (F-D-F) format, and Ream FSR uses the Bore (F-S-R) format. 

FDF, feed down-dwell-feed up, FF, feed down-feed up, FSR, feed-stop-retract. 

Bore cycle:    FDF, feed down-dwell-feed up, FF, feed down-feed up, FSR, feed-stop-retract 
and No Drag shifts a designated amount in No drag X and Y shift so as not to touch the 
finished wall upon retract. 
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Pecking Tab 
 
Drilling: Depth of the First, Second and Minimum peck may be entered by the % of the drill 
diameter. 
 
Tapping:  Depth of the First, Second and Minimum peck may be entered by the % of the tap 
diameter. 

Milling Tab 
 
Climb mill: With the milling cutter rotating clockwise if you follow behind the cutter in the 
direction of the travel of the tool and the cutter is on the left side of the curve it is climb 
milling and if it is on the right side it is conventional milling. 
 
Bi-directional rough:  The rough passes alternate between climb milling and conventional 
milling.  When cutting a Boss feature on a square block, the cutter cuts across the corners 
first. When climb milling is selected in the strategies, the first pass is a climb cut, and then 
the tool alternates with conventional milling until the corners are finished. The cutter finishes 
the roughing cuts using climb milling. 
 
Use finish tool:  When rough and finish milling, FeatureCAM uses the same cutter to rough 
and finish.  When Use finish tool is checked FeatureCAM will always add a second tool to do 
the finish operation. 
 
Cutter Comp:  Whether cutter comp is selected or not FeatureCAM offsets the tool by the 
radius of the tool.  By selecting Cutter comp, it adds the necessary G40, G41and G42 to the 
NC code so the tool size for holding tolerances may be adjusted with the tool offset in the 
control by the user. 
 
Part line program:  Instead of the cutter center being offset by FeatureCAM the program 
aligns the center of the tool on the curve. The NC code reflects this with the print dimensions.  
All of the offsetting is done by the machine control. 
 
Minimize tool retract:  For use when it is more desirable to feed the tool to another region 
of a feature instead of retracting and plunging. For example: in a pocket with islands, 
minimize tool retract will keep the tool from retracting and plunging. 
 
Individual rough levels: Many roughing cuts are performed at multiple Z levels due to the 
depth of the feature. If you select Individual levels on the Strategy page, you will be able to 
customize the manufacturing attributes of each level. If you have a feature that is roughed in 
four levels there will be four z-levels listed in the feature instead of one. Note that each pass 
is listed underneath the rough operation. By clicking any of the passes, you can set attributes 
in the Milling tab.  If Individual level is not selected, then only the rough pass is listed in the 
tree view and you can only make changes to Milling tab attributes that will apply to all 
levels.  Individual levels also controls clipping of boss and side features against the stock 
model including both STL and solid stock models. With this attribute selected, the toolpaths 
are clipped against the stock boundary at each Z level. 
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Depth-first machining:   Selecting the Depth first option will cut each region of the feature 
completely before moving on to another region. The toolpaths descend in Z. If this option is 
deselected, then all regions of a feature are cut at one Z level before descending to a deeper 
Z-level.  If you are using multiple roughing tools or multiple finishing tools, to efficiently 
rough out tight corners, Depth first is also useful.  The second tool that roughs the corners 
only will cut each corner to depth before retracting and moving to the next corner. 

Reorder:  (Surface Milling) The Reorder attribute tells FeatureCAM to re-sequence the 
toolpaths to minimize retractions while trying to avoid full width cuts. Use Reorder when 
you have a part where several separate regions are cut. If you want the toolpaths to move 
directly across a surface without worrying about retractions, deselect Reorder. 

For Z-level operations (rough or finish), the Reorder attribute enables zone machining where 
the toolpaths descends in the Z (or -Z) direction. Use this if it is more efficient than cutting 
the entire part in complete Z levels. The phone handset example below shows that the 
toolpaths cut the top of the part in complete Z levels and then cut one side and the other. 

 

 

 

 

 

 

 
     
 
Side roughing bottom up:  A 2.5D feature with a Draft Angle may be roughed from the 
bottom up instead of the normal top down.  
 
Side finishing bottom up:  A 2.5D feature with a Draft Angle may be finished from the 
bottom up instead of the normal top down. 
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Toolpath corner (%):  This attribute rounds the corners of milled roughing passes. It is 
specified as a percentage of the tool diameter. Rounding the sharp corners of the toolpaths 
provides a more constant tool velocity and reduces the tool load. 

It applies to all 2.5D milling features. The left figure shows a pocket without Toolpath 
corner % set and the right is set with Toolpath corner set to 98%: 

 

 

 

 

 

 

 

 

 

 
 

 
 
 
 
Hi speed machining technique.  The first rough Tool path corner at 500% flattens the tool 
path, usually faster feeds and speeds.  The second rough Tool path corner at 25%, cleans up 
only what the first rougher left. The 25% value helps smooth out some of the sharp corners, 
but must not be too large, or there might be an excessive amount for the finishing tool.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 

First rough passes 500% 

Second rough passes 25% 
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(Trochoidal slotting) 
Trochoidal cut:  Simple grooves have an option of using a trochoidal toolpath. Instead of a 
simple slotting cut, the tool uses a series of circles to clear away the metal, as shown. This 
toolpath has the advantage of maintaining a constant radial depth of cut which produces the 
same load on the tool at all times. 
 

 

Stepover Tab 
 
(Rough Pass) 
Do rough pass creates a rough operation for ALL milling features. 
 
Depth in the Z direction is a % of the diameter of the cutting tool for each pass.  
 
Spiral is the Tool motion offset from the curve shape and the tool steps over as it moves 
radially toward the curve, this step over is a % of the tool diameter. (33% or less is 
recommended) 
 
Zig-zag is how the tool travels parallel to X or Y or at an angle, the radial step over is a % of 
the diameter of cutter.  (Up to 55% is recommended) 
 
(Semi-finish Pass) 
Do semi-finish pass is selected if an additional finish pass is needed before the final finish 
pass and will be applied to all milling features. 
 
Allowance is the amount of material left for the finish pass. 
 
Bottom Allowance, if required, is the amount left on the bottom for the finisher to remove. 
 
(Finish Pass) 
Do finish pass is selected if a finish pass is desired and will be applied to all milling features. 
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Allowance is the amount left by the rougher for finishing. 
 
No. of Passes made by the finish tool, additional passes may be added, they are considered 
spring passes the tool does not move in any further then the finish curve. 
 
Overlap is the amount from where the tool ramps on for the finish cut and where it ramps off 
when complete.   
Finish bottom is selected if fishing the bottom of the feature is desired and Wall pass is 
checked if it is to be included. 
 
Spiral is the type of finish toolpath with a % of the tool diameter, radial step over.  
 
Zig-zag is the type of finish toolpath with a % of the tool diameter, radial step over.  
 
Bottom allowance is the amount of material left by the rougher when finish bottom is 
selected.  
 

Lead/Ramp Tab 
 
(Horizontal lead/ramp) 
Extension distance pertains to Lead moves for cuts with open ends.  In the milling feature on 
the stepover tab,  there are settings to extend the lead onto the feature without having to 
extend or change the feature.  An arc ramp may be added and a 90 degree approach that is  
perpendicular to the arc may also be included. 
 
Lead distance is the distance the tool plunges from the end of the curve and is measured in a 
% of the tool diameter. 
 
Lead in angle is the angle to the curve that the tool approaches the feature after plunging.  A 
90 degree Lead in is perpendicular to the curve. 
 
Lead out angle is the angle to the curve when the tool exits the feature before retracting.  A 
90 degree Lead out would be perpendicular to the curve. 
 
All Stepover applies the Lead in and Lead out to every step over. 
 
Ramp type is the shape of the transition move when the tool steps over radially.  They 
include Direct (90 degrees) Arc, Line and S-shape.  S-shape provides very smooth transition, 
good for hi-speed machining. 
 
Ramp diameter is measured as % of tool diameter and determines the arc size for the radial 
step over. 
 
Minimum ramp distance controls the length of the ramp. 
 
Wind fan finish plunges and retracts the finish tool in the same place and ramps on and off 
the finish curve in the same place with no overlap.   The arc size for ramping may be entered 
along with the angle move to the arc.  To watch this in centerline simulation, it looks like a 
fan you would hold in your hand.  
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 (Vertical ramp) 
Minimum Z ramp dist is the allowable minimum distance (radially) when ramping has been 
selected.  It may be 0 and if the tool doesn’t fit when ramping FeatureCAM will plunge 
straight down with no ramping to attempt to make it fit. 
 
 Max ramp angle is the maximum vertical angle the tool is allowed to plunge (rough op) 
 
Max finish ramp angle is the maximum vertical angle the tool plunges (finish op) 
 
Helical Ramping is a technique that plunges the tool into the material in a helical (circular, 
like a screw) motion and may be CW or CCW.   
 
Linear Approx may be used when helical is not applicable.  It uses short linear moves for 
the helical motions instead of arcs. (also thd milling) 
 
Ramp diameter is the radial size of the helical arc that is used. (thd. milling) 
 
(Arc lead)  
Arc lead, Use 90-deg Comp on/off and Distance are associated with Extension distance and 
pertains to Lead moves for cuts with open ends. 

Misc. Tab 
 
Z rapid plane is the distance measured in the Z positive direction that the tool retracts to 
when either moving to the next hole for drilling or moving to another region to continue 
milling and usually considered a safe height for clearance of clamps, etc. 
 
Plunge clearance is the distance in the Z direction above the part that a tool will rapid to and 
then go into feed rate to plunge or drill to depth. 
 
Tap plunge clearance has the same purpose in a tap operation as for drilling and milling. 
 
Z ramp clearance is the distance above the part in the Z direction that a milling tool feeds 
straight down to after plunging to the plunge clearance when ramping is being used so it 
doesn’t ramp above the part. 
  
 Spline Tolerance parameter controls the maximum deviation of the generated tool path from 
the theoretical spline contour. 
 
Z index clearance is applicable on 4 axis indexing parts.  When for example a square part is 
indexed on a 4th axis table FeatureCAM takes into account the corners being higher than the 
flats during index and retracts the tool to the Z index clearance height above the corners 
which is safe for the corner to index under any tool. 
 
Wrap tolerance also applicable to 4th axis parts.  Certain features can be created flat as 
normal and then wrapped around a cylinder on a 4 axis rotary table and this tolerance setting 
determines how close. 
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Chamfer depth is how far the point of the chamfer tool goes past the bottom of the chamfer 
on the part.  This is to make sure the point of the tool uses the full length of the cutting edge 
and not give a burr along the bottom edge because the point of the tool is possibly not sharp 
to the end. 
 
Deburr radius is automatically applied to a sharp outside corner to remove the burr, for 
example on a boss feature where there is no radius on the corner.  It can be any size and if 
there is any radius whatsoever on the curve of the feature then FeatureCAM ignores the 
Deburr radius and the curve radius is applied instead. 
Minimize corner radius is used to restrict the maximum size tool that FeatureCAM will pick 
when there is a square inside corner with no radius.  
 
Minimum rapid distance is the distance determined by a percentage of the tool diameter as 
to whether the tool will feed or retract and rapid to the next region to machined.  The smaller 
the setting the more retracting, the greater the number the it will feed to the next area to be 
machined.  
 
Speed is the percentage of programmed spindle speed that the spindle will run in the 
program.  
 
Feed is the percentage of programmed feed rate the tool will feed in the program. 
 
Plunge feed is the percentage of the programmed feed rate that the tool will feed when 
plunging. 
 
Use IPR/IPT will use inches per revolution or per tooth instead of inches per minute (IPM). 
 
Proportional plunge feed when selected determines the milling plunge feed rate according 
to the angle of ramping while plunging.  The steeper the angle the slower the feed rate and 
the more shallow the angle the higher the feed rate.  
 
Peripheral Feed has various settings for inside and outside corners during milling to slow or 
increase the feed rates to help maintain a more consistent tool load and obtaining the 
optimum feed rate. 
 
Post Variables provides the opportunity to pass data directly to the NC code in designated 
locations as laid out by the post variables built into the post processor. 
 

Operations Tab 
 
(Ordering) 
 Automatic Options has four functions: 

1) Minimize tool changes attempts to optimize tooling to do all the work for that tool on 
the entire part before changing tools, especially helpful when one tool can be used on 
several functions or features including 4th axis, more indexing and less tool changes. 

2) Do finish cuts last allows all of the roughing of milling features to be completed first 
and then does the finish cuts to avoid any possible movement of the part after a finish 
cut has been completed. 
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3) Cut higher operations first completes for example a pocket with drilled holes in the 
bottom, pocket first then the drilled holes. 

4) Minimize rapid distance helps to find the most efficient path for the tooling by 
examining the distance of each move and then picking the shortest distance.   
 

Base Priority is when you want to ensure that an individual feature is cut before anything 
else, you can set its Priority attribute in the Misc. tab. All features have a Priority 
manufacturing attribute. By default, the value is 10. To make sure that a feature is 
manufactured first, set its priority to a lower value and to make a feature last, set its priority 
to a higher value. For example, if you set the Priority of a pocket to 8, its roughing pass is 
the first operation performed, its finish pass is second, and the rest of the operations are 
ordered according to the scheme described above. 

• While you can specify the exact order of every feature by priority, you shouldn't do so 
casually because you lose the automatic optimization sequences built into 
FeatureMILL. It's harder to maintain or change the part too. 

Time estimation has six settings including indexing speed of the 4th axis rotary table.  If care 
is taken to enter accurate figures, a very close estimation of the actual time it will take to run 
your part, excluding any operator intervention can be achieved.  A stop watch may have to be 
used instead of accepting speeds from manuals. 

Facing 
 
Do rough pass when roughing passes are desired. 
 
Do finish pass when a finish pass is desired.  May be used without rougher. 
 
Finish allowance is the amount of  material left by the roughing operation. 
 
Facing stepover is the radial step over perpendicular to the cut direction measured by a % of 
the cutter diameter. 
 
Lateral overcut is how far, measured by a % of the cutter diameter, that  the tool goes off the 
end of the part parallel to the direction of the cut. 
 
Last pass overcut is how far by a % of the cutter diameter, that the tool goes off the part 
radially perpendicular to the cut direction on the final pass. 
 
Max depth of cut is the maximum Z increment depth the cutter will take in one pass. 
 
Connect stepovers with arc provides a very smooth transition by changing the direct 90 
degree stepover to an arc or loop.  This is also a high speed machining technique.  
 
Zigzag angle is the angle that FeatureCAM uses to cut Face features. 

Tool Selection 
 
(Counter bore) 
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Use counter bore will select a specific diameter counter bore tool.  An inventory of various 
sizes of counter bores is usually maintained. 
 
Use endmill will select a milling cutter to cut the counter bore.  Eliminates an inventory of 
counter bore tools and can cut any size. 
 
Automatic selects and endmill when counter bore tools are being used and the desired 
counter bore size is not available. 
 
(Spot drill) 
Prefer spot drill is used to cover a wider variety of hole sizes because it has one diameter 
and comes to a point. 
 
Prefer center drill is usually selected for spotting a hole to be drilled, short and makes the 
initial plunge into the material with no wandering or movement. 
 
Preferred spot drill diameter allows a specific size spot drill to be selected on ALL holes.  
Size may be changed when needed. 
 
Optimize spot drill tool selection will attempt to use a tool that will satisfy All holes when 
there is a variety of sizes to be drilled.  If attempting to chamfer holes when spot drilling one 
tool may not satisfy and an additional tool may be selected.   
 
Optimize chamfer tool selection will attempt to use a chamfer tool that will satisfy All holes 
when there is a variety of sizes to be chamfered.  
Tool diameter tolerance is a value not to exceed when selecting tools, for example, if the 
tolerance is set to .002 then if FeatureCAM doesn’t find a tool plus or minus .002 of the 
needed size it will show a red flag next to the operation indicating it doesn’t have a tool 
within the tolerance. 
 
Drill % of ream/bore determines the size of the drill to be used for a ream or bore operation. 
 
Thread % for tap drill (cut) determines the size of the drill to be used for the tapping 
operation to obtain a specific % of thread (example 77%) 
 
Thread % for tap drill (rolled) determines the size of the drill to be used for the tapping 
operation to obtain a specific % of thread (example 65%).  Rolled threads drilled hole size is 
very important because the thread is formed and material is pushed down into the root of the 
tap and if the hole is to small it will break the tap and if too large there is not enough to form 
an accurate thread.   
 
Tap type lets you select the type of tapping you do most.  

Tool % of arc radius (also Toolpath corner % in milling tab) is set to 100 then a tool 
equal to the smallest corner radius is selected for a feature such as a pocket.  With Toolpath 
corner% set to 100 the tool dwells in the corners as it changes direction. This can sometimes 
nick the part. To avoid this problem, set Toolpath corner % to a slightly smaller number, 
such as 98. 
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Multiple Roughing Tools gives you the opportunity to allow FeatureCAM to select 
additional roughing tools when, for example, you have a pocket with small radius corners and 
FeatureCAM chooses to rough the entire pocket with the small cutter.  When selecting Use 
multiple roughing tools from largest to smallest, stopping when the material is gone, you 
enter tools that you want FeatureCAM to select from when multiple cutters are necessary to 
make the operation efficient.  Starting with the largest tool and adding smaller tools separated 
by a comma, FeatureCAM will start with the largest tool that will fit.  It will also select a 
rougher that fits the corner so there will be the same amount of leave allowance in the corners 
as there is along the straights.  You may also restrict the minimum size tool to use as a 
rougher.  Remember though that if you are running small parts with small tools you may have 
a tool needed in your tool crib for a specific operation but it will never select it for roughing 
if it is smaller than the minimum tool diameter.    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Surface Leadin 
 
Stepover type is the transition move the tool makes radially to make the next pass (usually 
bi-directional)  this is perpendicular to the tool path direction. 

1) Direct is two 90 degree turns, stopping twice to 
change direction of 180 degrees. 
 
 
 
 
 
 
 

2) Loop is a smooth rounding transition which does not 
stop to change direction.  Good hi-speed technique. 
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(Lead-in/out parameters) 
Use lead-in/out:  
Never provides no leads, it uses plunge clearance and 
plunges to depth. 
 
 
 
 
 
 
 
On all plunges/retracts or On first plunge/last retract 
applies the lead type, line or arc, to every plunge and 
retract or the first and last only.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
On all stepovers, plunges & retracts applies the lead type 
to every transition move the tool makes. 
 
 
 
 
 
 
 
 
 
 
 
Surface normal applies the leads normal to the surface whether horizontal or vertical. 
 
Use arc ramp-in/out allows you to choose the ramp diameter and the ramp in/out 
angle. 
 
Use linear lead-in/out allows you to choose the lead-in/out angle and the lead-in/out 
length.  
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Surface Mill Tab 
 
Tolerance (Rough .005) ( Finish .001) sets how close the milling will be to the 
mathematically ideal surface. This does not guarantee that your feature is machined to this 
tolerance in all locations if the tool you select is incapable of cutting within that tolerance in 
constrained areas. If your part shows a faceted appearance, set the tolerance to a lower value. 

Scallop height stepovers is the height between passes of a 
Ball End Mill for isoline milling, projection milling finishing 
passes and Z-level finishing. This distance is measured along 
the surface and represents the maximum cusp height between 
neighboring passes as shown here.  The scallop height and 
stepover default values may also be entered but can be entered 
or changed in individual features also. 

Parallel angle refers to parallel tool path strategies.  The value of 0 causes the tool to travel 
parallel to the X or to the Y axis. 

Tool diameter allows a default tool diameter to be selected for Surface Milling 

Tool end radius provides the opportunity to select the default for the cutter end, Ball, Flat or 
Bull Nose and also the diameter. 

Finish allowance is the amount of material left by the rougher for the finisher to remove. 

Check allowance is how far away you wish the tool to stay away from selected surfaces or 
faces. 

(Slope limitation angles) 

Horizontal only cuts horizontal surfaces up to a desired slope angle. 

Vertical only cuts vertical surfaces above a desired slope angle. 

Swarf axial tolerance is for a relatively rare number of geometries where the tool axis can 
waver slightly as it positions accurately on the surfaces to be machined. This can be due to 
small but significant changes in the geometry as the tool moves from one position to another. 
To allow a degree of latitude for the command, this tolerance can be set to a value larger than 
the machining tolerance to allow the tool axis to be stabilized as it moves across this 
geometrically varying region. As a result excess material may be left on the surface involved 
but the load on the tool may be reduced. 

Edges contains four choices as to how you want the tool to react when it comes to the edge of 
a surface or face at the stock.   

1) Automatic, depending on the toolpath strategy being used, does much like Don’t roll 
over the edges at all and therefore calculates a boundary but if a different boundary is 
used such as a curve, FeatureCAM won’t calculate for both. 

2) Don’t roll over the edge at all cuts 100 percent cleanly to the edge but does not roll 
over the edge. 

3) Cut top edge: Just roll over the top edge allows the ball only to roll over the edge.  
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4) Cut to bottom:  Roll over the top edge and cut to bottom of stock/part basically 
turning off all boundaries and letting the tool cut until it runs out of part or stock. 

 

Thread Mill 
 
(Wind Fan)  
Wind fan is the same as a milling feature, it can plunge and retract and feed on and off in 
same location plus the angle of approach and the ramping radius. 
 
Linear ramping may also be applied using ramp distance, diameter and angle offset. 
 
Feed direction can be either Negative Z or Positive Z. 
 
Feed overrides for ramp in and ramp out. 
 
Passes for Rough and Finish with Rough Stepover, Finish allowance and Spring passes.  

Starts may be multiple if desired. 

Start angle can be entered if necessary. 

Tooth overlap attribute controls the amount that one revolution of a multi-thread tool will 
overlap the previous revolution. It is an integer that represents the number of threads. We 
recommend that you overlap at least one thread. 

Tooth outside is the number of teeth that will be above (if feeding in negative Z) or below (if 
feeding in positive Z) the thread mill feature for the first pass. 

Taper approx. angle is for tapered threads.   The toolpath is increasing in diameter as well 
as moving in Z. These moves are approximated with 3D arcs. The Taper approx angle is the 
angle around the thread that will be approximated by a single arc. A 360 must be evenly 
divisible by the Taper approx angle. For example, if set to 90, a single revolution of the tool 
will be broken into 4 arcs. 

Feed to depth override may be set to a desired feed rate. 

Linear Approx. attribute is associated with Helical ramping and Thread mill features. If 
Linear approx is selected, then the arc moves are approximated by linear moves. Helix linear 
approx tolerance controls how accurate the approximation is relative to the theoretical spiral. 
Set this tolerance to a smaller number to more accurately approximate the spiral. 

Cutter comp to apply G40, G41 and G42 to the NC code so the control can adjust size with 
tool offset. 

Part line program puts the center of the tool on the finish curve and the NC code reads to 
print dimensions and all offsetting is done by the control. 

Through for thread milling is set if there is no material on the bottom of the thread. If 
Through is not set, the toolpaths will be generated to ensure that the tool will not cut past the 
end of the thread. 
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Use Finish Tool  allows a separate tool to be used as a finisher. 

Plunge to center plunges the tool on the center of the hole to assure clearance. 

 

 
This concludes Machining Configuration/Attributes. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 





FeatureCAM

Powering your productivity

Delcam Headquarters | Small Heath Business Park | Birmingham | B10 0HJ | UK 
+44 (0)121 766 5544 | marketing@delcam.com | www.delcam.com

To contact your local reseller, visit www.delcam.com/resellers

© Copyright Delcam plc 2011. All other trademarks are the property of their respective owners.

FeatureCAM 2012

new features

www.delcam.tv/lz

www.delcam.tv

www.featurecam.com

FeatureCAM Learning Zone

Delcam TV

FeatureCAM Website


	010 - Content
	Training Course
	Acknowledgements

	FeatureCAM overview
	Why creating toolpaths is so fast


	100 - Introduction to FeatureCAM
	Introduction to FeatureCAM
	Introduction
	What is a Feature?
	How are Features Created?
	CAM Software Strategies
	Built in intelligence



	101 - Beginning FeatureCAM
	Beginning FeatureCAM
	Introduction
	User Interface
	UYour First part exercise
	UStock Types
	Stock Exercise
	UUser interface exercise



	102 - Snapping and Geometry
	Snapping and Geometry
	Introduction
	User Interface
	Snapping
	Snapping Exercise
	Line Constructors
	Line Constructor Exercise
	Circle Constructors
	Circle Constructor Exercise
	Fillet Constructors
	Fillet and Chamfer Constructor Exercise
	Arc Constructors
	Dimensioning
	Dimensioning Constructor Exercise
	Clipping



	103 - Curves
	Curve Creation
	Introduction
	What is a Curve?
	Chaining
	Closed Curves
	Open Curves
	User Interface curve chaining
	Curve Wizard
	Curve Constructors

	Curve from Curve
	Curve from Curve Exercise #3

	Curve from Surface
	Curve From Surface Example #1
	Curve From Surface Example #2
	Curve From Other Methods
	Other methods Example #1 functions
	Other methods example #2
	Other methods example #3



	104 - Basic 2.5D Features
	Basic 2.5D Features
	Introduction
	What is a Feature?
	User Interface

	Feature Representation
	Features from Dimensions
	Holes
	Feature From Dimensions Exercise #2
	Features from Curves Exercise #1
	Features From Curves Exercise #2
	Feature from Feature Exercise #2
	Feature from Feature Exercise #3



	105 - 2.5D Advanced Milling
	2.5D Advanced Milling
	Introduction
	In 2.5D Milling there are more advanced features than milling and drilling, such as 4axis, multiple fixtures, cross section, multiple islands, bosses and side features, etc.  The user will learn how tapered walls and other shapes can be machined to em...
	Multiple Curves in One Feature
	UMultiple Bosses
	UPocket with Islands
	UMultiple side features

	Multiple Plunge Point Curve
	Cross Section (X section); Side, Pocket and Boss Features.
	UCross Section (X section)

	2.5D Plunge Milling
	Grooving
	Simple checked                            Simple unchecked
	Inside/Outside groove

	4th Axis Indexing and Wrapping:
	Introduction

	Round Stock
	UWrapping a Groove

	Wrapping a Pocket
	UWrapping a drilled hole pattern
	UWrapped Engraving


	Form Tools
	Introduction
	UCreate a Dovetail Milling Form Tool
	UCreate a Side Milling Form Tool
	UCreate a Drilling Form Tool



	106 - Multiple Fixture Documents
	Multiple Fixture Documents
	Introduction
	UGetting Started
	UMultiple Fixture Interface
	USteps
	UFixture ID
	UParts
	UExample 1 - Multiple Parts as Separate Blocks
	UExample 2 - Multiple Parts out of a Single Block of Material
	UExample 3 - Multiple Parts Located on Predefined Fixture IDs
	UExample 4 – Making Changes



	107 - FeatureRECOGNITION - Milling
	FeatureRECOGNITION for Milling
	Introduction
	What is a Feature?
	What is Feature Recognition. Why is it necessary?
	How does FeatureRECOGNITION Work?
	URequirements for FR
	UImport Wizard

	AFR Example #1
	Types of FR Available
	UAFR U   (Automatic Feature Recognition)

	AFR Example #2
	AFR Example #3    (Feature Re-recognition)
	IFR      (Interactive Feature Recognition)
	IFR Example #1
	IFR Example #2
	IFR Example #3 (4 Axis)


	108 - Part Library
	Part Library
	Introduction
	UCreating a Part Library Feature
	UUsing Part Library Features
	USaving Patterns and Groups to the Part Library
	UPatterning Part Library Features
	USaving Solids to the Part Library
	UPaste Special
	UStreams



	109 - Creating Machining Set-Ups
	Thickness=100
	Edit
	 Select Pick two points to define initial Z direction.

	110 - Creating Tool Libraries (Cribs)
	Creating Tool Libraries (Cribs)
	Introduction

	Setting a Tools Operation type

	111 - Machining Configurations-Attributes
	Introduction
	UMachining Configurations
	What are Machining Attributes?
	The rest of this document will be used to explain the attributes found in each of the tabs inside the Machining Attributes dialog. To follow along and compare, click Manufacturing then Machining Attributes to open the dialog.
	UDrilling Tab
	UPecking Tab
	UMilling Tab
	UStepover Tab
	ULead/Ramp Tab
	UMisc. Tab
	UOperations Tab
	UFacing
	UTool Selection
	USurface Leadin
	USurface Mill Tab
	UThread Mill


	Пустая страница
	Content.pdf
	Страницы из Training Course - FeatureMILL 2.5D


